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This chapter shows you how to get started using SB+. It contains the 
following sections:

Logging On for the First Time details the steps you need to take to log on to 
SB+ for the first time, including licensing SB+ for your site.

Updating License Information details how to amend your license details and 
run a cleanup process to release unused licenses.

Creating a User Account shows you how to set up an SB+ user account, in 
which applications can be developed.

The System Administration Account describes the system administration 
account, which contains additional options not available in a user account.

Logging On and Off describes how to log on to and log off from SB+.

Navigation shows you how to find your way around the SB+ development 
environment. 

Help describes the various types of help provided by SB+.

Text Editor shows you how to use the SB+ full-screen text editor.

Using a Mouse describes the use of a mouse in SBClient in character 
emulation mode. 
  1-3
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Logging On for the First Time
When you have installed SB+ for the first time, you need to log on to the 
system administration account so your copy of SB+ can be configured for use. 
Refer to the documentation you received with the supplied media for 
installation instructions.

To log on to SB+ for the first time:

1. Log to the system administration account (SB or SB+, depending on 
whether you are using UniData or UniVerse). The Logon screen 
appears, and you are prompted to enter a user ID.

2. Enter the user ID SB. SB is the default user ID supplied with SB+ to 
allow you to access the system. It has no security restrictions initially; 
however, this can be modified later.

3. You are prompted to enter a password for user SB. There is no 
password initially defined for the user SB, so press the ENTER key. 

4. You are prompted to enter or select the type of terminal you are using 
so information displayed on the terminal is formatted correctly and 
function keys are properly identified.

Enter the terminal ID (DEFAULT.TERM). Otherwise, press ∗ for a list 
of all terminal types recognized by SB+. If the desired terminal type 
is not shown in the first part of the list, press ∗ and ENTER to continue 
the list until the terminal type is shown.

5. Enter the name from the list that matches your terminal (or the 
terminal it is emulating), in full. For instance: W60.PCKEY

If you cannot find a suitable definition, press the ENTER key to accept the 
default terminal shown in brackets. The default terminal in a new 
installation, DEFAULT.TERM is a minimal definition compatible with most 
terminal types. With this definition you can simulate function keys by 
pressing CTRL + F n, where n is the number of the key required.

If you are unsure of the type of terminal you have, or if you have problems 
with what appears to be the correct terminal type, see your system 
administrator or refer to the reference manual for your terminal.

After you have successfully logged on, the License Details Entry screen 
appears.
1-4 SB+ Server Administration Manual
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License Details Entry Screen

The License Details Entry screen allows you to enter details required for 
licensing SB+ on the current hardware. This license is not transferable to another 
machine without relicensing.

A description of each prompt follows. Prompts marked with an asterisk are 
used in generating your license number, so be sure you enter the correct 
information for these. If you make a mistake in any field, press the ESC key to 
go back to the previous field. Press the ? key to get help on a specific field. 
  1-5
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Prompts

Company/User Name

The name of the company or individual user to be licensed to use SB+. This 
name appears when logging on to SB+, in various SB+ Office Automation 
and Tools reports, and as the default company name for new applications.

Postal Address Line 1, 2, and 3

The full postal address of your organization.

Post/Zip Code

The postal code or ZIP Code.

Contact Title, First Name, and Surname

Normally the person whom the SB+ distributor would contact in your 
organization.

Telephone Number: Area & Number

The area code and telephone number of the contact person. Include extension 
number if applicable.

*SB+ Serial Number

The SB+ serial number supplied with your SB+ documentation.

American/International

Sets the date format to either A for American (mm/dd/yy) or I for 
International (dd/mm/yy). This prompt appears only on the License Details 
Entry screen.
1-6 SB+ Server Administration Manual
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*SB+ Runtime Code

If you have purchased a run-time–only copy of SB+, enter the SB+ run-time 
code supplied with your copy of SB+.

Otherwise, if you have purchased a development license, enter NONE.

Hardware Manufacturer

The type of hardware on which SB+ is being installed, such as Lenovo PC.

Model Number

The model number of the hardware, such as RS6000 or 486/50.

Computer Serial #

The serial number of the hardware device.

Operating Environment

The operating environment (OE) type such as AIX or Windows; otherwise, 
you can use this box for the database, UniData or UniVerse.

O/E Release

The version and release number of the OE, such as 2.3 or 10.1.

Dealer Name

The name of your SB+ distributor.

Upgrade (Y/N)

If this is a new installation of SB+, enter N. Otherwise, if this is an upgrade to 
an existing SB+ site, enter Y.
  1-7
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Product Description

The descriptions of the various System Builder products for which you may 
have a license. (Display only.)

*Users

The number of users licensed to use each of the products listed at the 
previous prompt, as stated on your License Agreement.

Media Type

The media type; for example, CD.

Media Density

The media density.

Completing Your License

1. When you have entered your details at the prompts, check them 
carefully. If they are correct, select the Accept option. If not, select the 
Change option, modify the entries you want to change, and select 
Accept to save the license details. The following message appears:
1-8 SB+ Server Administration Manual
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Press the ENTER key to print the license letter. After checking that it is correct, 
sign the printed copy and mail or fax it, together with the signed license 
agreement, to your SB+ distributor, who will then supply you with a license 
number authorizing SB+ for the described configuration. You need not do 
this immediately, but you must enter the license number within 31 days of 
installation, otherwise SB+ will become inoperative. Any details you have 
entered are preserved until the license is correctly re-entered.

Until you enter a license number, each time you log on a screen appears with 
the number of days remaining before the temporary license expires.

From this screen you can press:

When you have completed the licensing procedure, the SB+ System 
Administration main menu appears:

A to accept this message and continue the SB+ logon process.

D to view your license details again.

L to enter your license number when it is received. After you 
have entered your license number, SB+ will be correctly 
licensed for that machine.

P to reprint your license details. 
  1-9



E:\SVN\SB55\doc_set\sbplus\administration\1getstart.fm
5/13/14 
We recommend that you make backups of the SB+ and SB+.DEFN accounts 
as soon as possible. (For further information, see Chapter 2, “Backup Menu 
Options.”) It is important to back up the SB+ account on a regular basis 
because it contains essential user and system data.
1-10 SB+ Server Administration Manual
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Updating License Information

Changing Your License Details

To change your license details, invoke the LICENCE.AMEND process by 
entering /LICENCE.AMEND. (The / character allows you to enter a process at 
most prompts or menus.) The Amend Licence Details screen appears.

The prompts on this screen are the same as those on the Licence Details 
Entry screen, except that this screen does not have an American/ 
International prompt.
  1-11
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Note: If you modify license details, you must reprint the details and send them to 
your SB+ distributor who will update your license number if necessary.

Running a Cleanup Process to Release Licenses

When a user closes a session without logging off SB+, the user remains 
logged on to SB+ and the defunct session is still included in the count of 
licenses in use.

As of version 5.4, SB+ Server provides a cleanup process to release licenses 
for defunct sessions while SB+ Server is running.

To run the cleanup process to release licenses:

1. In an open SB+ Server session, log to any account.

2. Enter /RELEASE.LICENSES (or /RELEASE.LICENCES) at any 
prompt. A message dialog box appears. 

3. You are given the option of releasing invalid licenses or viewing a 
report only.

■ If you want to print a report of invalid licenses to your screen 
without releasing the licenses, click No.

■ Otherwise, if you want to release invalid licenses and print a 
report of invalid licenses to your screen, click Yes. 
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Creating a User Account
This section explains how to create an SB+ user account. The account created 
is a full SB+ development environment, and will contain one or more systems. 
Each system is a separate entity, with its own control parameters and 
standard files.

Note: This option is not available with run-time (nondevelopment) licenses.

Steps for Creating an Account

The steps for creating an SB+ user account are detailed for each platform: 
UNIX or Windows.

To create an SB+ account (UNIX):

1. Select Admin from the main menu (press the A key or use the arrow 
keys). The Admin submenu appears.

2. Select Accounts. The Accounts submenu appears.
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3. Select Create An Account. The Create An Account dialog box 
appears.

The account name and system IDs you select should reflect the 
purpose for which the account and its systems are used.

4. Complete these details and press the F2 key to accept them. The 
account and systems are created and you are prompted for your user 
ID, password, and terminal type (if these are not specified for your 
port in Admin > Printers & Terminals > Printer Management > Port 
Configure).
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5. Enter your user ID, password, and terminal type. The default user 
account main menu (SBMENU) appears.

Each system has its own copy of the default menu, which you can 
modify to suit the application being developed using the Tools > 
Menu Definitions tool. For a full discussion of the SB+ development 
environment, see the SB+ Server Reference Manual.

To create an SB+ account (UniData on Windows):

1. Create a directory in which you want the account to reside.

2. Execute newacct from the DOS shell to make it a UniData account.

3. Use the Update Account option in the SB+ Admin account to convert 
the account for use by SB+ Server.

To create an SB+ account (UniVerse on Windows):

1. Create a UniVerse account using UV Admin.

2. Use the Update Account option in the SB+ Admin account to convert 
the account for use by SB+ Server.

Note: If the Create Account option is unavailable on either UniData or UniVerse, 
SB+ can be activated in a non-SB+ account by creating a VOC pointer to the DM 
file (in the SB+.DEFN account) and then running the SB.INITIATE program.
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Default User Account Main Menu Options

Tools

Opens a menu of tools for creating and maintaining applications. Tools is the 
primary menu used by an application developer, and is described in the SB+ 
Server Reference.

Note: These tools are not available in a run-time–only environment.

Runtime

This provides a skeleton menu that developers can use as a basis for an 
application structure. The menu can be amended as required.

Admin

This provides a menu of account administration options. The Admin menu 
in a user account is similar to that in the system administration account. For 
further information, see Appendix A,  “Appendix A: Admin Within a User 
Account.”

Office

This provides a menu of standard office automation facilities.

Shell

This invokes the SB+ shell command line. User access to the shell can be 
controlled by the system administrator.

Logto

This provides an option to log to another account, or to log off.
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The System Administration Account
SB+ provides a system administration account (called SB or SB+, depending 
on whether you are using UniData or UniVerse) specifically for the use of 
system administrators. This account would not normally be available in a 
run-time–only version of SB+. A subset of the options provided by the system 
administration account are available in the default development account 
environment. For details of the options available in user accounts, see 
Appendix A, “Appendix A: Admin Within a User Account.”

System Administration Account Main Menu Options

The options on the system administration account main menu are 
summarized in this section. They are then described in detail in the 
remaining chapters of this manual.

Backup

This allows you to back up and restore accounts, and to control media. On 
some platforms, additional system management commands are provided.

Note: This menu option is not available on Windows-based installations.

Security

This allows you to define users and groups of users.

Admin

This provides an interface to the OE. Users can perform many of the more 
common administrative options without accessing the OE.

Note: This menu option is not available on Windows-based installations.

Shell

This invokes the SB+ shell command line prompt, allowing you to enter any 
OE command or SB+ process (subject to security restrictions).
  1-17



E:\SVN\SB55\doc_set\sbplus\administration\1getstart.fm
5/13/14 
Logto

This allows you to log on to other accounts without having to re-enter your 
user ID and password for each account accessed.
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Logging On and Off
In order to access SB+ you must have a unique user ID and password.

Your user ID (for instance JS) is associated with a user group (for instance, 
CLERKS). This user group determines your level of access within the SB+ 
environment and to SB+ applications. Your password is associated with your 
user ID, and you must enter both correctly to gain access to SB+. You are 
responsible for your own password.

To log on to SB+:

1. At the Log On prompt, enter an SB+ account name.

2. Enter your user ID and your password. 

If your user ID and password are valid, the SB+ main menu (or 
process defined for you) appears. If your user ID or password is 
invalid, an error message appears and you are prompted to enter 
your user ID and password again. If you do not enter a valid user ID 
and password after three attempts, you are logged off. (Instead of 
entering your user ID and password, you can enter HELP to access 
SB+ help). 

To log off from SB+:

You can use any of the following methods to log off SB+:

■ Select the Logto option from the main menu (if available), and enter 
OFF.

■ Select the Shell option from the main menu (if available), and enter 
OFF at the shell command line.

■ Enter /OFF anywhere that accepts process calls. Ensure you first save 
(using the F2 key) any unsaved data in input screens or tools, 
otherwise the data is lost.

■ Press the ESC key repeatedly to move back through the menu 
hierarchy. When you press the ESC key at the main menu (the first 
menu to appear after you log on), the Logon screen appears. Press 
ESC at the Logon screen to log off SB+.
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Navigation

Menus

You can use any of the following methods to select a menu option:

■ Type the highlighted letter of the option.

■ Move the selection highlight bar, using the up arrow key and down 
arrow keys (or Page Down and Page Up keys, where applicable) to 
the required option and press ENTER or Spacebar.

■ Click on the option if you are using a mouse.

To exit a menu, press ESC key. This returns you to the previous menu or, if you 
are at the main menu, to the SB+ Logon screen. Pressing the ESC key at this 
screen logs you off.

Entering 0 (zero) at any menu takes you (depending on your security level) 
to a command line shell. This is either the OE shell or SB+ shell (also depends 
on your security level).

Screens

Screens are made up of input fields and prompts (a prompt being a label for 
a field). Generally in this manual we refer to entering data at a prompt rather 
than in a field. 

When you are prompted for input, enter the required response or press the 
ENTER key to accept the displayed default value. Edit your input using the 
edit keys defined for your terminal. Use uppercase letters for process names. 
You can use lowercase for straight text (descriptions for instance).

The following edit keys cause the contents of a field to be accepted (after any 
validation) before the edit key itself is processed:

■ function keys other than the F1 key and the defined intuitive help key

■ up arrow or down arrow keys

■ TAB key or SHIFT key – TAB key

■ a mouse event
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For example, pressing the F2 key after entering text responds the same as if 
the ENTER key was pressed to accept the field, and then the F2 key was 
pressed. 

Screen Navigation Keys

Use the following keys to navigate through a screen (you can customize these 
keys in your terminal definition):

ESC Key

The action of the ESC key depends on the edit key movement mode set at the 
Admin > SB+ Setup > SB+ Control Parameters > CUA Arrow Movement 
prompt. This prompt can be set to either of the following values:

Value Description

Y The Common User Access (CUA) standard. ESC clears the 
current screen and returns the cursor to the key field. If 
there is no key field on the screen, or the key field is 
currently empty, the screen closes. The up arrow key takes 
you back one input step. 

N The default SB+ action. The ESC key takes you back one 
input step.

ESC Key Values 
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Up/Down Keys

These move the cursor to the next or previous prompts. The top-of-text and 
bottom-of-text keys (defined for your terminal) move the cursor directly to 
the first or last prompt on the screen. 

You can move the cursor to a value within the current multivalued field 
without knowing the field number. Instead of specifying a field number for 
n, use 0 (zero). For example, /0.999 jumps to the last value plus one in the 
window, with the cursor positioned in the controlling multivalued field. /0.5 
jumps to the fifth value in the current multivalued field, with the cursor 
positioned in the controlling multivalued field.

Keyboard Problems

If your keyboard does not function as expected (for example, edit keys or 
function keys do not perform as required) then either:

Value Description

/ Allows you to call a process, such as /WHO (if permitted by 
your security level). A / (slash) must be the first character 
entered in the field. If the process is a number, it is treated 
as a jump within the current screen.

/n Moves the cursor directly to field n (in the tab order 
specified for the screen) where n is the number of that field 
on the screen. (For further information, see “Screen 
Definitions” in the SB+ Server Reference Manual.) For 
example, /5 moves the cursor to the fifth field in tab order 
in the current screen. (/ must be the first character entered 
into the field.)

/n.m Moves the cursor directly to a value m within a 
multivalued field n on a screen. For example, /5.7 moves 
the cursor to the seventh value in the fifth field in tab order 
in the current screen, with the cursor positioned in the 
controlling multivalued field. (/ must be the first character 
entered into the field.)

\ clears a field (makes it null). You can also use the DELETE 
key repeatedly, or the clear-to-end-of-line key (defined for 
your terminal). (\ must be the first character entered in the 
field.)

Up/Down Key Values 
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■ your terminal has lost its internal setup and needs to be reinitialized. 
Turning the terminal off and on is usually sufficient if the current 
setup has been saved as the default power-on configuration.

■ the SB+ terminal definition for your port does not match the device 
actually connected, or the definition is incorrect.

A list of predefined terminal types is provided by SB+, and these should 
work in most cases. You can copy and modify one of the existing terminal 
definitions if you need to customize keys for your terminal or terminal 
emulation, or you can create your own.

For information on setting up or modifying SB+ terminal definitions, see 
“Terminal Definitions” on page 4-126.

/KEYS displays a list of current edit keys. The keys included in this list 
depend on the terminal definition currently in use for the terminal. Use the 
PAGE UP and PAGE DOWN keys defined for your terminal to view the whole 
list.

Screen Display

In character mode, SB+ uses a screen stacking system for screen display and 
refresh. When you invoke a process that displays a screen or menu 
overlaying the previous screen, the previous screen is saved onto a stack 
before the new screen or menu is displayed. On return from the process that 
opened the new screen or menu, the previous screen is restored from the 
stack and redisplayed.

Note: Because of memory constraints on some systems, the number of levels of 
stacking may be limited.

SB+ uses three screen refresh modes:

■ Refresh the original screen. Redraws only the screen stacked prior to 
the current screen.

■ Full screen refresh. Redraws all saved screens in the order in which 
they were stacked.

■ Smart refresh. Saves and restores only that part of the original screen 
that was overlaid by the current screen.
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The screen refresh mode is defined in a user’s security definition, or via the 
/USER.FLAGS process. (For more information, see “Full Refresh Of Screen” 
on page 3-28.)

Function Keys

SB+ makes extensive use of the function keys available on most terminals. 
Function keys are usually assigned the most frequently used functions, such 
as saving a record, deleting a record, getting help, and invoking related 
processes. Available function keys are shown on the function key status line 
of each screen.
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SB+ Function Key Default Configuration

Key Description

F1 The F1 key displays textual help related to the current input 
prompt. The F1 key may not appear on the status line, but 
it is always available. For further information, see “Help” 
on page 1-28.

F2 In general, pressing the F2 key accepts the current data in 
the screen and exits the screen. In most cases, the data is 
saved; however, some screens do not physically save data 
on disk, but return the data to the calling process.

You can press the F2 key to accept a screen after you have 
completed all mandatory fields. If you press F2 and a 
mandatory field has not been completed, the cursor is 
positioned at each uncompleted field in turn, where you 
are prompted for input.

The availability of the F2 key is indicated on the status line 
of the screen. If F2 does not appear on the status line, it may 
not be available.

F3 This calls intuitive help, if available for the current prompt. 
Intuitive help provides intelligent assistance in completing 
screen prompts. The F3 key may not appear on the status 
line. Its availability may be indicated in F1 textual help by 
the notation of (F3) at the end of the help message. For 
further information, see “Help” on page 1-28.

The key that invokes intuitive help is specified in the 
terminal definition. The default key for intuitive help is F3. 
All subsequent references to the F3 key in this guide and 
within F1 textual help refer to the intuitive help key. You 
can, however, define a different key (not necessarily a 
function key) to invoke intuitive help.

F4 This key deletes records. You are usually prompted to 
confirm deletions, but sometimes not in user applications. 
If F4 does not appear on the status line, it is not available.

F10 Displays the action bar, where available. The action bar 
shows additional commands you can invoke for a screen. 
You can access the action bar from most SB+ tools and 
define an action bar for any application screen. Function 
keys are available while the action bar is active.

SB+ Function Key Default Configuration
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Note: All other function keys and all action bar options are defined on a per-screen 
basis. For information on defining function keys and action bars in your input 
screens, see “Screen Definitions” in your SB+ Server Reference Manual.

Process Calls

SB+ is built from, and is used to build, functional units called processes. A 
process performs a function of a predefined process type, with the specific 
action defined by the developer. A process may use data passed to it from 
other processes, and return data either to the calling process or to another 
process called by the current process. For further information on processes, 
see the SB+ Server Reference Manual.

In the SB+ environment, you can call a process from any system prompt 
(including the SB+ shell prompt), menu, or action bar defined for an input 
screen by entering /processname, where processname is the name of a process. 
For example, /FD invokes the Field Definitions tool.

Alternatively, entering / at a menu or action bar displays the Process Id 
prompt, where you can enter the name of the process (F3 is available here).

/T? displays a selection list of all processes supplied with SB+ (depending on 
security).

Escape Sequences

You can enter escape sequence characters either as the printable character 
(where the character is printable) or as the ASCII equivalent of the character 
(where the character is not printable), enclosed in parentheses. For example, 
the following sequences both represent ESC A:

(27)A

(27)(65)

System Prompts and Messages

System Prompts

SB+ may prompt you for a choice of actions. For example, when printing 
reports, you are prompted for the destination of the output:
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Output to Screen,Printer,AuX (S/P/X) S

A prompt can alternatively require a Yes or No answer:

Do you want to continue (Y/N) Y

In most cases a default value is supplied (S and Y in the examples above). The 
F1 textual help and F3 intuitive help keys are generally available if you need 
help answering a prompt. A prompt may be in the form of a multi-option 
dialog box. In this case, you select an option by moving the highlight cursor 
to the option using the DOWN ARROW, UP ARROW, LEFT ARROW, RIGHT ARROW, 
PAGE DOWN, and PAGE UP keys, or by pressing the highlighted letter for the 
option.

Error Messages

SB+ validates your input wherever possible. If your input is invalid, an error 
message appears. Press the ENTER key to clear the message and return to the 
prompt. Error messages are self-explanatory and specific to the type of error 
encountered. They are displayed either on the prompt line, or as a dialog box 
with a Continue option.

Note: Error messages displayed elsewhere on the screen or in a different format from 
SB+ error messages (perhaps prefixed with a number) are probably issued by the 
underlying OE and not SB+. Refer to your OE documentation for a description of 
the error and the action to be taken.

Informational Messages

SB+ displays informational messages indicating the current state of the 
system or of a process. Informational messages do not usually require you to 
do anything. Messages may be displayed on the prompt line, in a cleared 
space in the lower third of the screen, full screen, or in a dialog box (which 
requires you to click OK or press the ENTER key to proceed). 
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Help
SB+ provides two types of help:

■ Textual

■ Intuitive

Textual Help

Up to five levels of context-sensitive textual help are available using the F1 
key.

Note: One or two levels of help are usually sufficient.
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Level 1

(Reminder) In character mode, press the F1 key to display a short one- or two-
line help message at the bottom of the screen:

In this example, the mouse was pointing to the Default Value prompt.

If additional textual help is available, it is indicated by <F1-More> at the end of 
the message. <F3> means that F3 intuitive help is also available for this prompt. 
The message remains on the screen until the data in the current field is 
accepted or until you move the cursor to another field.

In GUI mode, SB+ Server uses the status line of the MainWin to display first-
level help. However, if the status line is part of the form, first-level help is 
displayed in ToolTip style when the mouse rolls over the active field or the 
status line. Otherwise, SB+ Server treats F1 help as though the Disable 1st 
level help user flag has been set to Y, so when you press the F1 key for the first 
time, second-level help is displayed.
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Level 2

Press the F1 key again to access a window containing additional help (if 
available).

The help window remains on the screen until the data in the current field is 
accepted or until you move the cursor to another field.
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Level 3

Press the F1 key again to access a full page of help (if available).

The presence of more than one page of help text is indicated by the current 
page number and total page count in the bottom right corner. To print a page 
of help text, press the P key and the ENTER key.

Level 4

Press the F1 key again to access a help menu specific to the current screen:

Options on this menu display help on SB+ topics depending on context.
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Level 5

The General Help menu provides help on various general SB+ topics.
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Intuitive Help

Intuitive help provides intelligent, structured assistance when you are 
entering information in a field. Intuitive help is available throughout the SB+ 
toolset and may be included in applications developed using SB+. For 
information on building intuitive help into your applications, see the SB+ 
Server Reference Manual. An intuitive help process can be any valid SB+ 
process, including user subroutines.

The availability of intuitive help is indicated by an (F3) notation in the F1 help 
message. Intuitive help is normally invoked using the F3 key; however, this 
key can be redefined for a particular terminal type. For more information 
about redefining keys, see “Terminal Definitions” on page 4-126.

The example screen above shows intuitive help called from the Conversion 
prompt (selecting an appropriate conversion from the list of valid responses 
returns it to the Conversion field).
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Text Editor
SB+ provides a full-screen modeless text editor.

To invoke the editor, enter either of the following:

■ SE at the SB+ shell prompt or at the OE command line prompt, if 
accessed from a current SB+ session

■ /SE anywhere that accepts process calls

SE uses a general subroutine, called SB.TEXT.EDITOR, which also provides 
modeless editing within multiline text fields in SB+ input screens. The 
SB.TEXT.EDITOR subroutine can be called from user OE language 
subroutines to provide similar multiline text field editing. For further 
information, see Appendix F, “Appendix F: General Subroutines” in the SB+ 
Server Reference Manual.
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Editor Function Keys

F2 - Save

Saves the record currently in the editor window.

F4 - Delete

Deletes the record currently in the editor window.

F5 - Block

Marks a block of text for moving, copying, or deletion. You can mark only 
whole lines.

To mark a block, first move the cursor to the line in which the block starts and 
press the F5 key. Next move the cursor to the line where the block ends and 
press the F5 key again. The block is now marked.

To move the marked block, press the M key or the ENTER key (M is the default), 
and move the cursor to the line on which you want the text to start. Press the 
F5 key. The block is moved to start at this line, before the line that was at the 
destination line number.

To copy the block, press the C key and move the cursor to the line on which 
you want the text to start. Press the F5 key. The block is copied to start at this 
line, before the line that was at the destination line number.To delete the block, 
press the D key. To unmark the block, press the ESC key.

F6 - Find

Find is a case-sensitive search and replace facility.

To perform only a search, enter the required search string, and at the Replace 
With prompt press the ENTER key without entering text. The cursor is 
positioned at the next instance of the string (if any). If the search string is not 
found, an error message appears. Press the ENTER key to resume editing.

Note: Pressing the extend length key (defined for your terminal) searches for the next 
occurrence of the string, without pressing the F6 key again.
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To perform a search and replace operation, enter the required search string 
and replace string. To confirm each replacement (this is advisable), enter Y at 
the Confirm prompt. To replace all occurrences without prompting, enter N. 
The ESC key quits replacement mode. If the search string is not found, an 
error message appears. Press the ENTER key to resume editing.

You can search for and/or replace text with real attribute-, value-, and 
subvalue-marks (such as ASCII characters 254, 253, and 252), and replace text 
with a null string. Use the following at the Search String and Replace With 
prompts: @@AM (attribute-mark), @@VM (value-mark), @@SVM (subvalue-
mark) and @@NULL (null string).

F7 - Goto Line Number

Positions the cursor on a specified line.

F8 - Compile

Attempts to compile any text in the editor window, and catalogs the text 
record if no compile errors are found.

F9 - Process

Allows you to run a process from within the editor session. Enter the process 
name at the prompt. The default is SHELL.

F10 - Action Bar

Displays the action bar.

Line Nos

Toggles the display of line numbers on and off.
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Merge

Displays the Merge Item screen, allowing you to merge a block of text from 
a specified file and record.

The prompts are as follows:

File Name

The name of the file from which the record is to be read.

Item Id

The record from which the block is to be merged.

Start Line, End Line

The start line and end line, comma-delimited. Pressing the F3 key displays 
the record as a selection window. Select the required start line in the selection 
window. Repeat for the end line.

Info

Displays the file and record name, the number of lines, and the size of the file 
in bytes. Press the ENTER key or ESC key to close the display.

Print

Allows you to print the record or a block from the record to a system or 
auxiliary printer. Enter the block as startline, endline. The entire record 
is the default.

Skeleton

When writing a subroutine to work with SB+, the code should:
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■ be written as a subroutine

■ use the SB+ COMMON block

■ have certain equate statements

■ have a documentation header

This option automatically loads a skeleton header (from DMCONT 
SKEL.SUB) that provides these basic requirements.

Note: The skeleton code is loaded only if the record is empty.

File

Saves the record without exiting from the editor (F2 exits from the editor).

Tabs

Allows you to set the tab value after the initial tab. The default is 3 spaces.

Compress

Toggles between compressed display mode (usually 132 columns) and 
normal display mode (usually 80 columns). This is valid only if supported by 
the current terminal device.

Help

Displays the Help Options menu.
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Using a Mouse
This section covers the use of a mouse in SBClient in character emulation 
mode.

Note: SBClient in GUI mode is also mouse-driven, but the behaviors of the mouse 
conform to Windows standards. In some cases, mouse behaviors are different in GUI 
mode from those in character emulation mode. We assume that users of the GUI-
based versions of SB+ Server are familiar with the standard behaviors of the mouse 
in Windows applications.

Menus

Left-Button

Selects the option on which the pointer is positioned; the cursor can be 
anywhere in the description text. If the pointer is not positioned on a menu 
option, the currently highlighted option is selected. If you drag the mouse 
with the left button pressed, the menu highlight follows the pointer; the 
option highlighted when you release the button is selected.

Right-Button

Exits the menu.

Input Screens

Left-Button

If the pointer is in a field other than the field currently prompted for, input is 
transferred to that field (as with /n goto field). Clicking either a controlling or 
dependent multivalued field activates that field. If the pointer is on position 
1 in the current field, it invokes ENTER. If the pointer is not on position 1, the 
cursor moves to the position of the pointer. If the pointer is on any function 
key or action bar description, it invokes that function.
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Right-Button

Invokes intuitive help (F3) for the current field. The pointer may be anywhere 
on the screen.

Screen/Report Definitions

Left-Button

Moves the cursor to the position of the pointer.

If the pointer is already at that position, it invokes ENTER Field F5. Double-
click to place a new field at a new position.

If the pointer is at the cursor and on the field, you can hold the left-button 
down and drag the cursor to a new position. When you release the button, 
the field is moved to that position.

In the Report Definition tool, if you drag the pointer outside the current 
display area, the next page in the direction of the mouse movement is 
displayed. For example, dragging the mouse to the right of the current 
display area displays the next horizontal page.

If you place the pointer on any function key or action bar description, it 
invokes that function.

Right-Button

Invokes intuitive help, displays fields in a file for selection, or selects a report 
line type if it is on column 0 of a report definition.
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Left-Button Within the Selection Window

Selects the option on which the pointer is placed. In a multi-select window, if 
the option is already selected, it is deselected. In a multi-select window you 
can hold the mouse button down and drag the pointer through all options to 
select or deselect. The action is determined by whether the option under the 
pointer was initially highlighted or tagged.

Left-Button Outside of the Selection Window or on the Window Border

If the pointer is positioned at the:

■ upper-left corner of the window border, the first page of selections is 
displayed with the highlight on the first option.

■ lower-right corner of the window, the last page of selections is 
displayed with the highlight on the last option.

■ left of center of the window, the previous page of selection options is 
displayed.

■ right side and above the center depth of window, the previous page 
of selection options is displayed. If it is below this point, the next 
page of selection options is displayed.

Right-Button

If pressed within the selection window, it invokes ENTER.

Running Report to Screen

Left-Button Below or on Highlighted Status/Prompt Line

Left of center of prompt, scrolls screen left.

Right of center of prompt, scrolls screen right.
  1-41



E:\SVN\SB55\doc_set\sbplus\administration\1getstart.fm
5/13/14 
Left-Button Above Status/Prompt Line

Above center of screen, scrolls back a report page.

Below center of screen, scrolls forward a report page.

Right-Button

Invokes ENTER.

Defining Window Coordinates

Left-Button

The first click is for the upper left corner; the second click is for the lower right 
corner. Alternatively, you can hold down the button at the upper left corner 
and drag the mouse to the lower right corner, and then release.

Right-Button

If amending existing coordinates, it moves the window to the pointer 
position. If there are no existing coordinates, it acts the same as the left-
button.

Dialog Boxes

Left-Button

Selects response.

Right-Button

Selects response.
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Calendar Lookup Box

Left-Button Within Calendar Days Display

Highlights the day, or the logical day of the previous or next month if the 
position is blank.

Double-click to accept the date.

Left of month text, decrements date by one month.

Right of month text, advances date by one month.

Right side of year text, advances one year.

Left of year text, decrements one year.

If the pointer is on any function key description, it invokes that function.

Right-Button

Selects the highlighted day.

Pop-up Calculator

Left-Button

Click numbers or functions on the calculator to use them. If the pointer is on 
any function key description, it invokes that function 

Right-Button

Invokes ENTER.
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Screen Editor

Left-Button

Moves the cursor to the selected point. If the cursor is on any function key or 
action bar description, it invokes that function. If you click the mouse on 
INS/REP on the function key description, the insert/replace state is toggled.
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About Backup Features
The Backup menu provides options for saving (backing up) and restoring 
accounts onto media (diskette or tape) on a selected media device (tape or 
disk drive). Additional system management commands are provided for 
some platforms.

Note: This menu is not available on Windows-based installations.

Backing up your system ensures that your programs and data can be 
recovered in the event of data corruption or hardware failure. You should 
keep a series of backups and rotate them on a periodic basis (for instance, 
daily, weekly, monthly, and year-end), depending on the type and size of 
your environment and system. The more frequently you back up, the less 
time it will take you to recover from loss of data.

Backup Menu Options

Menu Option Description

Select Media Allows you to specify the media to be used for the 
backup or restore.

Rewind Media Allows you rewind the selected media.

Backup Menu Options 
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Backup Account(s) Allows you to save nominated accounts to the 
selected media.

Backup UNIX File(s) Allows you to save nominated accounts on a UNIX 
system to the selected media.

Restore Account(s) Allows you to restore accounts previously saved on 
the selected media.

Detach Media Detaches the selected media, making it available to 
other users.

Menu Option Description

Backup Menu Options (Continued)
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Select Media
Select Media allows you to specify the media (diskette or tape) to be used for 
the backup or restore. You should run this before doing a backup or restore 
to ensure that the correct media is connected. Depending on the platform, the 
backup and restore options may prompt for a media selection if not already 
performed.

Note: Media options vary depending on operating environments and hardware 
configurations.

Select Media: UniData

Prompts

Device Number

The number of the media device defined in the Admin > Media Commands 
> Define Media Device screen. For further information, see “Media 
Commands” on page 4-157.

Device Description

(Display only.) The description of the media device as entered in the Define 
Media Device screen. 
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Block Size

(Display only.) The block size in bytes of the media device as entered in the 
Define Media Device screen.

Operation Mode

(Display only.) The conversion method (such as EBCDIC, ASCII, or swap 
bytes) as entered in the Define Media Device screen.

Correct Device (Y/N)

Options are:

Select Media: UniVerse

Prompts

Device Name

The name of a media device specified in the &DEVICE& file. Devices are 
defined in the Admin > Media Commands > Define Media Device screen. 
For further information, see “Media Commands” on page 4-157.

Value Description

Y Selects the media device specified at the Device Number 
prompt above.

N Closes this screen without selecting a media device.

Correct Device Options 
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Device Description

The description of the media device as entered in the Define Media Device 
screen. (Display only.)

Block size

The block size in bytes of the media device as entered in the Define Media 
Device screen. (Display only.)

Correct Device (Y/N)

Options are:

Value Description

Y Selects the media device specified at the Device Name 
prompt above.

N Closes this screen without selecting a media device.

Correct Device Options 
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Rewind Media
The Backup menu for both UniData and UniVerse provides a Rewind Media 
option. After you have specified the media through the Select Media option, 
choose this option to rewind the selected media.
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Backup Account(s)

This dialog box allows you to save one or several nominated accounts on the 
selected media. The media must be selected before running the backup.

Function Key

F5 - Attach Media

This allows you to specify the media to be used by this process.

Prompts

Account Names

The names of the accounts to be saved on the selected media, separated by 
spaces. The accounts are saved in the order in which you enter the account 
names.

Continue With Backup (Y/N)

Options are:

Value Description

Y Performs the backup. 

N Closes this screen without backing up selected files.

Continue Backup Options 
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Backup UNIX File(s)

Unix File(s) Save

This saves all files in the specified UNIX directories. The command used to 
back up the files is that specified in the Admin > Media Commands > Define 
Media Device screen for the selected media. See “Media Commands” on 
page 4-157. 

Function Keys

F2 - Accept

This accepts the screen details and initiates the file save process.

F5 - Attach Media

This allows you to specify the media to be used by this process.

Prompts

Directory

The full pathnames to the directories you want to back up. The first pathname 
should be preceded with a \ to prevent SB+ from treating the entered text as a process 
call.
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Restore Account(s)
This allows you to restore accounts from any backup. An account can be 
restored to a different name to that it was saved as. If the accounts being 
restored exist on the system, SB+ prompts for the deletion of these accounts 
before they are restored. On UNIX platforms, the command used to restore 
the files is that specified in the Admin > Media Commands > Define Media 
Device screen for the selected media. See “Media Commands” on page 4-157. 

Restore

Function Keys

F2 - Accept

This accepts the screen details and initiates the restore process.

F5 - Attach Media

This allows you to specify the media to be used by this process.

Prompts

Name(s) To Restore As

The names you want the saved accounts to be restored as, separated by 
spaces.
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Name(s) on Backup

The names of the accounts as they were saved on the backup, separated by 
spaces.
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Detach Media

This detaches the selected media, making it available to other users. If 
detaching other ports take care that the media is free to be used. When 
logging off the system, the media is automatically detached.

Prompts

Detach Unconditionally (Y/N)

Options are:

Value Description

Y Detaches any user currently attached to the selected media. 
On some platforms this is not allowed.

N Detaches the media from the current port. If the OE 
supports concurrent media, you are asked which media to 
detach.

Detach Options 
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About SB+ Security Features

The SB+ security system allows you to define users and groups of users as a 
hierarchy of parent-child relationships.

A group can have many child groups and users. A user must have a parent 
group and cannot have any child groups.

User security restrictions are determined by the restrictions specified for the 
user's group, as well as any restrictions inherited from the parent groups. 
Any given group inherits the restrictions from farther up the tree, and only 
farther restriction is possible. SB+ has one predefined group called Root, 
which has no restrictions. The system administrator builds the group 
structure beneath Root.

Every user who has access to an account must be assigned a user ID and an 
initial password. The initial password can be used only once. Thereafter, 
users set up and maintain their own passwords. A user (including a system 
administrator) cannot find out another user’s password. If a user forgets his 
or her password, the system administrator must assign a new password.

SB+ security allows the logon point to be tailored to individual users. A user 
may be assigned a specific account to which he or she will always be logged, 
and/or an initial menu and menu option within the account. If no account or 
menu is specified, the user is logged on to the account requested at the logon 
prompt (subject to account restrictions specified for the user's group) and the 
default main menu specified for the account is displayed.
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The following diagram shows part of a possible security hierarchy in a 
development environment:

Security Menu Options

The options of the Security menu are summarized below. The sections that 
follow explain these options in greater detail.

Menu Option Description

Group Security Setup Allows you to define and maintain a group. You are 
required to enter your password before you can proceed.

User Security Setup Allows you to specify and maintain security details for a 
user. Group details must be specified before user details 
are entered. You are required to enter your password 
before you can proceed.

Initialize User’s 
Password

Allows you to change the password of a user in a lower 
group. The new password grants initial access, and from 
then on the user maintains his or her own password.

List Users Logged On Provides a list of all users currently logged on.

Security Menu Options 

Root

Administrator

Group 1 Group 2 Group 3

Project Leader

Project 3A Project 3B

Programmer 2Programmer 1 Programmer 3
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Security Reports Provides a menu of security report options.

Inhibit Logons Allows you to inhibit logons on all ports except those 
specified as exclusions, and inform users why they 
cannot log on.

Note: This option inhibits logon to SB+ accounts only. 
Check your OS manuals for details of disabling logons at 
the system level.

Enable Logons Again Re-enables normal logon to SB+ accounts for all ports 
previously affected by the Inhibit Logons option.

Menu Option Description

Security Menu Options (Continued)
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Group Security Setup

Group Security Setup allows you to define and maintain user groups. All 
users are assigned a group, which controls various aspects of a user's access 
to SB+, including access to SB+ options, the SB+ shell, / processes, and logon 
times, as well as restrictions to printers and accounts.

The user must enter his or her password to access this screen. Users can 
maintain groups only beneath their own group in the security hierarchy, 
unless they belong to the Root group.
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Changes made to a group ripple down to all subgroups (children of the 
current group); the restrictions of all groups lower in the security hierarchy 
are changed to the same values as the parent group. Therefore, all users 
belonging to a particular group or its subgroups have the same restrictions 
applied to them automatically.

This option applies only to group setup in the SB+ environment; it does not 
allow you to set up groups at the OE or OS level.

Function Keys

F2 - Save

Saves the group security parameters.

F4 - Del

Deletes the current group record.

F5 - Restr Accounts

Allows you to enter specific system restrictions for each account entered at 
the Accounts With Restrictions prompt. (See “Account Restrictions (F5)” on 
page 3-15.)

F7 - Logon Times

This allows you to enter password rollover date details. You can also specify 
valid logon dates, days, and times for this group, if required. (See “Logon 
Times (F7)” on page 3-18.)
3-6 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\3Security.fm
F8 - Locs

This allows you to specify valid printer locations for this group, if required. 
These are used by the Printer Manager to restrict access to certain printers 
when printing from SB+. (See “Printer Management” on page 4-48.)
  3-7



E:\SVN\SB55\doc_set\sbplus\administration\3Security.fm
5/13/14 
F9 - Children

Displays details about the immediate children of this group.

F10 - Action

Displays the action bar:

Copy Group
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This subscreen allows you to copy a group with the same parent as the 
original. The new group is added to the parent group's child list. You must 
enter a description for the new group.

Print Defaults

This subscreen allows you to define specific print defaults for a group. These 
parameters are used in determining the user's print defaults at logon. See 
“Appendix B: Printer Management” for details of print defaults.

Aux Defaults

This subscreen allows you to define auxiliary printer defaults for a group. See 
Appendix B, “Appendix B: Printer Management,” for details.
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This subscreen provides the following function keys:

Prompts

Group Id Code

The group ID code to be created or amended. You can access groups only at 
a lower level (child groups) than your group, unless you belong to the Root 
group.

Group Parent Code

The ID of the parent group for the group ID being defined. This defaults to 
the group of the current user, and other groups at the same or higher level 
cannot be entered. Groups at a lower level than the current user's group can 
be entered as the parent group.

Group Description

A description for the group ID being defined.

Inhibit Break Key (Y/N)

Options are:

Function Key Description

F2 - Accept This accepts the Group Aux Defaults screen.

F4 - Clear Defaults This clears the screen details.

Group Aux Defaults Function Keys 

Value Description

Y Inhibits the Break key for this group. Users in this group 
are not able to use the Break key to access the operating 
environment (OE).

N Enables the Break key for this group. Users are able to 
access the OE.

Inhibit Break Key Options 
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Note that if Inhibit Break Key is set to N, pressing CTRL-C in a field copies the 
content of the field and puts it in the buffer as long as the content of the field 
is less than the maximum length of the field. If the content of the field exceeds 
the maximum length of the field, SB+ displays the character CEO screen, 
which lists the break options.

On UNIX platforms, if CTRL-C (^C) is defined in the stty as an interrupt or 
anything similar, SB+ either stops responding or attempts to perform the task 
specified by the stty setting for CTRL-C. To avoid this problem, we recommend 
that you not use CTRL-C in the stty or in the profile.

If Inhibit Break Key is set to Y, pressing CTRL-C in a field copies the content 
of the field and puts it in the buffer, the same as if the flag is set to N. If the 
content of the field exceeds the maximum length of the field, SB+ does not 
display the character CEO screen when the user presses CTRL-C. The content 
of the field disappears and is in the buffer ready to be pasted by pressing 
CTRL-V.

If the Auto Extend flag is not set to Y in the user flags and the buffer content 
exceed the field length, the user must first press CTRL-END to extend the field 
and then press CTRL-V to paste the content of the buffer.

Inhibit Supervisor (Y/N)

Options are:

Value Description

Y Prevents users in this group from maintaining subordinate 
groups. This entirely restricts a user's ability to add or 
modify groups.

N Allows users in this group to maintain subordinate groups.

Inhibit Supervisor Options 
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Inhibit Shell Access (Y/R/N)

Options are:

You can specify restricted verbs at the next prompt if you select N or R here.

Restrict Shell Verbs (Y/N)

Options are:

Inhibit Process Calls (A/C/N)

SB+ processes can be called in a number of ways:

■ The /processname method, where a process definition has been 
created for a process. The process can be invoked at an input prompt 
or at a menu; for example, /TM invokes the Tools menu. Option A 
prevents this type of process call for users in the current group.

■ The /processtype:processname method, where a process has been 
created, but a definition has not been created for it. For example, 
/M:MAINMENU invokes the main menu (where M is the process 
type for menus and MAINMENU is the menu name). Option C 
prevents this type of process call for users in the current group.

Value Description

Y Prevents all access to the SB+ shell and the OE shell.

R Inhibits access to the OE shell; the user can still access the 
SB+ shell.

N Allows access to the SB+ shell and the OE shell.

Inhibit Shell Access Options 

Value Description

Y Restricts shell verbs for this group. Displays the Shell Verb 
Security subscreen, allowing you to enter a list of allowed 
or disallowed shell verbs.

N Does not restrict shell verbs. Restricted verbs from parent 
groups apply to child groups.

Restrict Shell Verbs Options 
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Options are:

Keyboard Timeout Limit (Mins)

The group’s upper timeout limit (in minutes). The user must re-enter his or 
her password if the timeout limit has elapsed without pressing a key. 
Entering 0 disables the keyboard timeout.

Note: The initial value for the keyboard timeout is inherited from the parent group. 
If the parent group has a non-zero timeout value then the value entered here cannot 
exceed the parent limit, or be set to zero. If the parent timeout limit is zero, you can 
enter any value (including zero) here.

Accounts With No Restrictions

A list of SB+ accounts to which users of the current group have access, 
without further restrictions being imposed on menu and process options. Any 
menu and process restrictions from the parent groups are inherited by all 
accounts listed at this prompt. Users cannot access any SB+ accounts not 
listed at this or at the Accounts With Restrictions prompts.

Accounts With Restrictions

A list of SB+ accounts to which users of the current group have access, which 
may have further restrictions imposed on menu and process options available 
to the user. Note that accounts entered at this prompt may not actually be 
restricted further; restrictions must be specifically entered using the F5 - 
Restrict Accounts option.

Value Description

A Prevents process calls of both types, but allows either 
process type to be called as a menu option.

C Prevents /processtype:processname processes from being 
called except as menu options.

N Allows both types of process to be called within and 
outside menus. 

Inhibit Process Calls Options 
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Position the cursor on the required account and press F5 to specify the 
restrictions for the current SB+ account. Any menu and process restrictions 
from the parent groups are inherited by all accounts listed at this prompt. 
Users cannot access any SB+ accounts not listed at this or at the Accounts 
With Restrictions prompts.

Last Maintained

Displays a list of recent changes to this screen, and the ID of the person who 
changed it.

Diary Access Code

A diary access code for the current group. Use this option when you require 
a code for a large group of users where individual access codes are not 
required for all users.

Note: You can only change this for your own user ID. See “Diary” on page 5-4 for 
more information on diary access codes.
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Account Restrictions (F5)

Allows you to specify allowed (unrestricted) or disallowed (restricted) 
processes for the group being defined or modified.

Function Key

F2 - Save

Saves the data entered into this screen.
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Prompts

System Id

Restrictions are applied to processes and menu options on a per-system basis. 
The selected system ID must exist in the specified account. 

Account

The name of the account.

Allow/Disallow

Options are:

You can specify a list of allowed or disallowed processes at the next prompt 
(whichever is more convenient for you to enter). If you enter A and do not 
specify any processes at the next prompt, allow no processes is assumed and 
therefore the system ID is not available for this group when selecting from the 
System menu.

Processes

Process names to be either allowed (A entered at the previous prompt) or 
disallowed (D entered at the previous prompt).

Menus

The name of the name to have restricted options. The next prompt specifies 
whether options are allowed or disallowed. List all menus for which you 
want to specify restrictions. The user gains access to the menu but is 
allowed/denied access to options specified at the Option Letters prompt. 

Value Description

A Specifies a list of allowed processes at the next prompt. Only 
these processes are callable by the users in the current 
group.

D Specifies a list of disallowed processes at the next prompt. 
All except these processes are callable by users in the current 
group

Allow/Disallow Options 
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To restrict access to the menu completely, no options should be allowed; enter 
A at the next prompt and leave the Option Letters box blank. Restricting 
access to processes on a menu does not prevent a user from using 
/processname. To prevent this, you can globally restrict process calls at the 
Inhibit Process Calls prompt, or, if you want to restrict a limited number of 
processes, specify those processes at the prompts in the PROCESSES section of 
this subscreen.

If a restricted menu option happens to be a menu itself, that menu and the 
menus below it in the hierarchy are also automatically restricted.

Allow/Disallow

Options are:

If you enter A and no menu options are specified at the next prompt, no 
options are allowed and the menu is not accessible to this group.

Option Letters

The option selection letters for the menu specified as allowed or disallowed 
at the previous prompt.

Value Description

A Allows access to the menu options specified at the next 
prompt. Only these menu options are available to the users 
in the current group.

D Disallows access to the menu options specified at the next 
prompt. All except these menu options are available to the 
users in the current group.

Allow/Disallow Options 
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Logon Times (F7)

Function Key

F2 - Accept

Accepts the data entered in this screen.

Prompts

Password Rollover Expression

An expression determining when the passwords for users in this group are to 
be changed. If a password is to be changed on a regular basis, enter an 
expression that returns a date on which the password is to be re-entered.

Note: The initial value for this field is inherited from the parent group definition.

For example, @DATE + 60 prompts for a new password every 60 days.

If a password is to be changed once, on or after a specific date, enter the date 
required.
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From Day

(Optional.) The start day of the week (or date) on which the specified group 
can log on; for example, MONDAY.

Upto Day

(Optional.) The end day of the week (or date) on which the user can log on.

From

(Optional.) The time of day (24 hour clock) from which the specified group 
can log on, on the days or date entered previously.

To

The (optional) time of day (24-hour clock) up to which the group can log on, 
on the days or date entered previously.
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User Security Setup

User Security Setup allows you to define and maintain individual SB+ user 
security records. An SB+ user is able to log on to an SB+ account and use a 
selected subset of SB+ options, depending on the restrictions placed on the 
user through the group that the user is assigned to. All users are assigned a 
group, which controls various aspects of a user's access to SB+ functionality. 
See “Group Security Setup” on page 3-5 for details of restrictions that can be 
applied to users.
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The user must enter his or her password to access this screen. A user can 
maintain only users who belong to subordinate groups in the security 
hierarchy, unless the user belongs to the Root group. If a user's group inhibits 
the supervisor option, that user is unable to modify other users' details.

When a user ID is first defined, the system administrator allocates an initial 
password. When a user first logs on to SB+, he or she is prompted to enter 
and validate a new password. Thereafter, the user is responsible for 
maintaining his or her password.

This option applies only to user security setup in the SB+ environment; it 
does not allow you to set up users at the OE or OS level.

Function Keys

F2 - Save

Saves the current user record.

F4 - Del

Deletes the current user record.

F5 - User Menu

Allows you to define a specific user menu to be displayed when the user logs 
on. This invokes the Menu Definitions tool with a menu name the same as the 
user ID.

F6 - User Keys

Allows you to specify macro keys and the strings those keys invoke. (See 
“Define User Macro Keys (F6)” on page 3-32.)

F7 - Term/Print

Allows you to specify the default terminal to be used if not specified in the 
port configuration, and the default printer and auxiliary printer to be used to 
determine the user's print defaults at logon (in the absence of other print 
defaults being defined). See “Appendix B: Printer Management” for details 
of print defaults.
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F8 - GUI Prefs

Allows users to customize the GUI environment.

F10 - Action

Displays the action bar:

Copy User

This subscreen allows you to copy a user within the same group.

Print Defaults

This subscreen allows you to define specific print defaults for a user. For 
details of print defaults, see Appendix B, “Appendix B: Printer 
Management.”
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This subscreen has the following function keys:

Aux Defaults

This subscreen allows you to define auxiliary print defaults for a user. For 
details of print defaults, see “Appendix B: Printer Management.”

This subscreen has the following function keys:

Prompts

User Id Code

The user identification code. To create or amend this, the user must be in a 
subordinate group to your own, unless you are a Root group user. F3 displays 
users in the same group and lower groups.

Function Key Description

F2 - Accept Accepts the user print default parameters.

F4 - Clear Defaults Clears the screen details.

User Print Defaults Function Keys 

Function Key Description

F2 - Accept Accepts the User Aux Defaults screen.

F4 - Clear Defaults Clears the screen details.

User Aux Defaults Function Keys 
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Alternative Id Code

(Optional.) An alternative code that further uniquely identifies the user for 
applications beyond this system; for example, an employee number.

First Name

The first name of the user for whom you are setting up security.

Surname

The last name (surname) of the user for whom you are setting up security.

Short Name

A more common name used as an alternative means of identifying the user. 
This name is displayed when the user is logging on or when other users view 
mail sent by this user.

Status

The status code for the user being defined. Valid settings are: 

Value Description

A Active. The user is allowed to log on. No activity logging 
takes place.

D Developer. Activity is not logged.

L Active and logged. The user is allowed to log on. If the 
LOG.USER process is linked to the processes the user 
accesses, the user’s presence on the system is recorded. (For 
further information, see the section on LOG.USER in the 
SB+ Server Reference Manual.)

M Miscellaneous user ID for non-logon purposes.

R Resigned. The user is not allowed to log on.

N Network use only. Allows mailing across networks.

Status Codes 
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Users Group Code

The ID of the group to which the user belongs. The group ID determines the 
level of access the user has within the system. For further information, see 
“Group Security Setup” on page 3-5.

Start Account

(Optional.) An account name containing the initial menu for this user ID. If 
you specify an account name, that is the only account to which the user can 
log on.

You can enter an expression enclosed in round brackets, evaluating to an 
account name; for example, (@PASS.DEFN<14>:".ACC").

Start Sys, Menu, Opt

(Optional.) The system ID and start menu to appear after logon for this user 
ID. You can also specify an option on this menu by using the highlight letter 
of the option; for example, AR,MAINTMENU,R. In this example, the user is 
presented with the process accessed by option R in MAINTMENU in system 
AR in the account to which the user is logged. In the default menu system 
configuration, this option would present the run-time menu after the user 
has entered the user ID and password.

The start menu is the first menu to appear after the user logs on, in preference 
to the account’s main menu. The F5 key builds the start menu for the user. On 
closing this menu, the Logon screen reappears.

Password

The user’s initial password. After entering the initial password, the user 
specifies and uses his or her own password.

Pwd Rollover Date

A future date on which the user is required to change his or her password.

New Pwd Next Login

An option indicating whether the user is required to change his or her 
password at the next logon to SB+ Server, regardless of the password rollover 
date.
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Options are:

Autologin

An option indicating whether the user is allowed to auto log on to SB+ if the 
auto logon feature is enabled at the SB+ Server level. 

Options are:

Diary Access Code

A code used to encrypt/decrypt diary entries, if required. This code is used 
as a seed for the encryption routine. If you leave both the user’s Diary Access 
Code and the group’s Diary Access Code blank, the user cannot encrypt his or 
her private diary entries.

Warning: Use caution in changing this code. Any entries encrypted before you 
changed the diary access code cannot be decrypted correctly.

Value Description

Y Yes, the user is required to change passwords at the next 
logon to SB+ Server. Note that after the user changes the 
password, SB+ Server resets the value to N.

N or blank No, the user is not required to change passwords at the next 
logon to SB+ Server. This is the default setting.

New Pwd Next Login Options 

Value Description

0 or blank No, the user is not allowed to auto log on to SB+. This is the 
default setting.

1 Yes, if the auto logon feature is enabled at the SB+ Server 
level, the user is allowed to auto log on to SB+.

2 If the auto logon feature is enabled at the SB+ Server level, 
the user is allowed to auto log on to SB+ on the computer 
on which the user authenticated, and to manually log on to 
SB+ on other computers.

Autologin Options 
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Macro Leadin Character

The decimal ASCII value representing the keystroke that signals to SB+ that 
a macro follows. Macro keys and the strings they invoke are defined using 
the F6 key. If you define a macro lead-in character here, it overrides the macro 
lead-in character set in the current terminal definition, allowing you to use 
the same lead-in character on any terminal. Leave this prompt blank if you 
intend to use the macro key defined for the terminal.

Keyboard Timeout

The number of minutes of inactivity after which the user is required to re-
enter his or her password before resuming input. If you set the value to 0 
(zero), keyboard timeout is disabled. The timeout value specified here 
overrides the value for the user's group, with the following exception: if the 
user's group timeout is not zero, the user timeout cannot be set to zero or to 
a value greater than the group timeout.

Auto Extend Field Length

Options are:

Value Description

Y Enables the Extend Field Length option on field entry. This 
means the user does not have to press the extend-length 
key (as defined for the terminal being used) to continue 
entry in the field beyond its displayed end. If the user 
continues typing, the Extend Field Length option activates 
automatically.

D Disables the Extend Field Length option on field entry. The 
user cannot press the extend-length key to enable entry 
beyond the indicated field length or type past the indicated 
end of the field.

N Normal length option control. The user is not able to type 
past the indicated end of a field. Attempting to do so causes 
a warning beep. Pressing the extend-length key allows the 
user to enter text beyond the indicated field end.

Auto Extend Field Length Options 
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Auto Help Display

Determines whether help reminders are displayed automatically when a 
menu option is highlighted or a field entered. This is useful for new users. 
Options are:

Error Text in Dialog Box

Determines whether help error messages are displayed in a dialog box or on 
the prompt line. Options are:

Main Heading Justification

Full Refresh Of Screen

The screen refresh action to be taken whenever exiting a process that displays 
information on the screen.

Value Description

N No autodisplay. The user must press F1 for help.

Y Autodisplays help reminders that start with ?

M Autodisplays Menu reminders.

A Autodisplays All reminders.

Help Autodisplay Options 

Value Description

Y Displays all error messages in a dialog box.

N (Default.) Displays all error messages on the prompt line.

Error Text Options 

Value Description

C Center

L Left

R Right

Main Heading Justification 
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Screens are stored on a multilevel stack. The number of screens that can be 
stacked may be limited on some platforms. For further information, see “SB+ 
Control Parameters” on page 4-166.

Options are:

The value entered at this prompt has no effect if you are using SBClient or 
SBTerm for DOS, because all screen refreshing is handled by these programs.

Suppress Confirm On Screen Esc

Options are:

Value Description

Y Refreshes the complete screen (all levels). The process 
starts at the oldest stacked level, and repaints the screen 
completely with each subsequent level up to the new top 
level.

N Refreshes the new top-level screen only.

S Smart refresh; refreshes only the part of the screen that was 
overlaid by the previous screen. This is the preferred 
option; however, system limitations such as a slow 
processor can reduce performance.

Full Refresh Options 

Value Description

Y Suppresses the confirmation prompt when escaping from 
an input process without having saved changes. Selecting 
the mandatory [M] option at the Process On Escape prompt 
in the Screen Painter Parameters screen overrides this flag. 
For further information, see “Screen Definitions” in the SB+ 
Server Reference Manual.

N If the user presses the ESC key before saving changes, a 
dialog box asks the user to confirm that the changes should 
be discarded.

Suppress Confirm Options 
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Command Stack per Account

SB+ provides a command stacker in the SB+ shell that allows the user to 
recall, modify, and/or resubmit any commands entered at the shell command 
line. This flag determines whether a separate stack is kept in each account for 
this user, or if one stack is to be used across all accounts accessed by that user. 
For more information on stack usage and commands, see “Shell” on page 6-
3 and “Logto” on page 6-6. Options are:

Suppress Beep On Error

Options are:

Suppress Logon Message Delay

These options apply to the Logon message (last logged on, mail, 
appointments):

Value Description

Y Maintains a separate command stack for each account for 
this user. 

N Maintains one global command stack for this user.

Command Stack Options 

Value Description

Y Suppresses the beep preceding the display of SB+ error 
messages.

N Does not suppress the beep preceding the display of SB+ 
error messages.

Suppress Beep Options 

Value Description

Y Suppresses delay when displaying details. Normally, there 
is a three-second delay to read messages.

Suppress Logon Message Delay 
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Display Print Select Screen

Determines the display of the Printer Selection screen. Options are:

Display Aux Select Screen

N Always delays.

M Delays only if there is a message.

A Always solicits the Accept response.

Value Description

Y Always.

N Never.

RO Reports only.

Display Print Select Screen Options 

Default Description

Y Yes.

N Never.

W Windows Print Setup dialog box only.

Display Aux Select Screen Options 

Value Description

Suppress Logon Message Delay (Continued)
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Define User Macro Keys (F6)

This screen allows you to define macro keys for the user. With macro keys, 
the user can enter repetitive data strings by entering a macro lead-in 
character (for example, CTRL Z) and a keyboard switch character.

In the example above, pressing the macro key followed by the letter B is 
equivalent to typing PROC.BEFORE.

Function Key

F2 - Accept

Accepts the data entered in this screen.

Prompts

Sw

The switch character used to recall the string defined at the next prompt.

Macro String

The string of characters returned.
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If entering a process call, you must enter \ before the /. For example, \/FD 
accesses the Field Definitions tool.

To enter data to subsequent prompts, enter \DATA followed by the required 
input strings separated by commas. For example:

ORDERS \DATA ORDER FILE,10,20,210

If you enter a number from 0 to 254 enclosed in parentheses, SB+ converts the 
number to its equivalent ASCII character. For example, in the screen above, 
the letter V produces a value-mark (253). You can use this facility to enter 
nonstandard characters, such as ü.

Note: This feature is active in character mode only. In GUI mode, the normal 
Windows cut and paste functions (CTRL + X, CTRL + C, and CTRL + V) are available.
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Initialize User’s Password

This screen allows you to change the password of a user in a group that is 
lower than your own in the hierarchy. This password grants the user one-
time access. After gaining access, the user must establish and maintain his or 
her own password.

Function Key

F2 - Accept

Accepts the data entered in this screen.

Prompts

User Id

The user ID for which a new password is to be specified.

New Password

The new password that the user is to enter when first logging on. The user is 
prompted to establish a unique password after the initial access.
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List Users Logged On
This screen provides a list of all users currently logged on.
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Security Reports

This menu provides a selection of security reports:

Breach Report

This report shows details of all attempted breaches of security, including the 
date, time, port number, account, user ID, and type of security breach, 
indicated by a code.
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Security breach codes are as follows:

You can enter the selection criteria for this report. You are given the option of 
clearing breach entries in the log file.

User Activity Log

This report shows a history of all user logon activities, including details of 
users who have logged on and off the system, and when they used any 
process to which LOG.USER has been specified. You can enter selection 
criteria for this report. You are given the option of clearing user activity 
entries in the log file.

Clear User Log File

This allows you to clear all entries in the user log file, including breaches and 
logged activities. The report shows details of what types of entries were 
cleared (breaches, activities, or all), who cleared them, and the date and time 
cleared.

Group Summary Report

This report provides a summary listing of all groups existing on the system.

User Report

This report provides a summary listing of all users existing on the system.

System Access Summary

This report provides a summary of all account and process restrictions 
defined for all groups on the system.

Code Description

LPW Failed password check at logon

VPW Failed user verification at logon

Security Breach Codes 
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System Restrictions

This report provides a listing of all system-level restrictions.

User Summary Report

This report provides a summary of users on the system. You can specify 
sorting and selection criteria for this report.

User Details Report

This report provides a detailed listing of users on the system. It is possible to 
specify sorting and selection criteria for this report.

Group Summary Report

This report provides a summary of groups that have been created on the 
system. It is possible to specify sorting and selection criteria for this report.

Group Details Report

This report provides details on groups that have been created on the system. 
It is possible to specify sorting and selection criteria for this report.

Group Hierarchy Report

This report shows the hierarchy of groups that have been defined in the 
system. It is possible to specify a particular group that will be used as the 
starting point of the report. It is also possible to select whether to include 
additional details about each group on the report.

Audit Record of Users Added

This option of the Security Reports menu prints the New Users Added to 
User Security report to your screen. The report provides an audit trail 
detailing transactions in which a new user record was added in user security. 
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This report is produced from DMSECURITY.AUDIT log. The log is 
cumulative; it grows until you back up the file and clear the log. The report 
is available if at least one user security record has been added after this log 
was last cleared.

Audit Record of Users Deleted

This option of the Security Reports menu prints the Users Deleted From 
User Security report to your screen. The report provides an audit trail 
detailing transactions in which a user record was deleted from user security. 

This report is produced from DMSECURITY.AUDIT log. The log is 
cumulative; it grows until you back up the file and clear the log. The report 
is available if at least one user security record has been deleted after this log 
was last cleared.

Audit Record of Users Amended

This option of the Security Reports menu prints the Users Amended In User 
Security report to your screen. The report provides an audit trail detailing 
transactions in which a user record was changed in user security. 

This report is produced from DMSECURITY.AUDIT log. The log is 
cumulative; it grows until you back up the file and clear the log. The report 
is available if at least one user security record has been changed after this log 
was last cleared.

Audit Record of Groups Added

This option of the Security Reports menu prints the New Groups Added to 
User Security report to your screen. The report provides an audit trail 
detailing transactions in which a new group record was added in group 
security. 

This report is produced from DMSECURITY.GROUP.AUDIT log. The log is 
cumulative; it grows until you back up the file and clear the log. The report 
is available if at least one group security record has been added after this log 
was last cleared.
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Audit Record of Groups Deleted

This option of the Security Reports menu prints the Groups Deleted From 
User Security report to your screen. The report provides an audit trail 
detailing transactions in which a group record was deleted from group 
security. 

This report is produced from DMSECURITY.GROUP.AUDIT log. The log is 
cumulative; it grows until you back up the file and clear the log. The report 
is available if at least one group security record has been deleted after this log 
was last cleared.

Audit Record of Groups Amended

This option of the Security Reports menu prints the Groups Amended In 
User Security report to your screen. The report provides an audit trail 
detailing transactions in which a group record was changed in group 
security.

This report is produced from DMSECURITY.GROUP.AUDIT log. The log is 
cumulative; it grows until you back up the file and clear the log. The report 
is available if at least one group security record has been changed after this 
log was last cleared.
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Inhibit Logons

This screen allows you to inhibit logons by all SB+ Server users except those 
specified as exclusions, and to inform users why they cannot log on. This is 
useful when you are upgrading to a new version of SB+ or performing an 
application revision or general system maintenance.

Note: This option inhibits logon to SB+ accounts only. Check your OS manuals for 
details of disabling logons at the system level.

Function Keys

F2 - Accept

This accepts the screen parameters and initiates the inhibit logons process.
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F4 - Enable

Re-enables the normal logon routines.

Prompts

Non Inhibit Users

The users who are not prevented from logging on after this option has been 
executed.

Logon Inhibited Text Message for users

Text explaining why logons are being inhibited.
3-42 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\3Security.fm
Enable Logons Again
This option re-enables normal logon to SB+ Server accounts for all users 
previously affected by the Inhibit Logons function.
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About Administrative Features

The Admin menu provides an interface to the operating environment (OE). 
This menu allows you to perform many common administrative functions of 
the OE without accessing it directly. Options you would normally enter as 
command line parameters can be entered using an input screen or by 
selecting a menu option, neither of which requires you to know the command 
line syntax.

Admin Menu Options

The options of the Admin menu are summarized below. The sections that 
follow explain these options in greater detail.

Menu Option Description

Files Provides options for maintaining files, including options 
for viewing, modifying, resizing, and deleting file contents.

Printers and 
Terminals

Provides options for maintaining printers, terminal 
definitions, and port configurations. The options available 
vary between platforms.

Media Commands Provides options for creating (on some platforms), 
selecting, and assigning media devices and performing 
backup, restore, and other file operations using the selected 
media. The available options vary among platforms.

Admin Menu Options 
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SB+ Setup Provides options for maintaining SB+ control parameters. 
These parameters vary among platforms.

System House 
Keeping

Provides options for configuring ports, maintaining date 
and time parameters, and accessing system information. 
The options and information available vary among 
platforms.

Accounts Provides options for creating, updating, and deleting SB+ 
accounts.

Export SBClient 
Settings

Enables you to export session configurations, scripts, 
phone books, toolbars, and Smart Query definitions from 
SBClient 5.4.4 or earlier.

Menu Option Description

Admin Menu Options (Continued)
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Files

The Files menu provides options for maintaining files and records.

Update Processes

Update processes are those that allow you to edit, copy, and delete records in 
your files, to create non-SB+ files, to clear files, and to access and maintain 
files in other accounts. Take care in using these tools; indiscriminate use may lead 
to data integrity problems.

Note: These tools make direct use of quoting system commands and functions, and 
may bypass SB+/user update and revision control processes.
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Screen Edit A File

This screen is accessed by selecting Admin > Files > Update Processes > 
Screen Edit a File. It allows you to edit records in a file using the SB+ screen-
based text editor. For further information on the text editor, see “Text Editors” 
on page 1-21 in the SB+ Server Reference Manual. For details of file structure 
and usage, see your OE documentation.

Prompts

File Name To Edit

The name of the file containing the records to be edited.

Record(s) To Edit

The IDs of the records to be edited, separated by spaces.

Line Edit A File

This screen is accessed by selecting Admin > Files > Update Processes > Line 
Edit a File. It allows you to edit or create a record in a file using the OE editor. 
For details on the editor and on file structure and usage, see your operating 
environment documentation.
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Prompts

File Name

The name of the file containing the records to be edited.

Data/Dict (0/1)

Options are:

Record Name(s) (*all)

The IDs of the records to be edited. To edit all records on the specified file, 
enter ∗. Separate IDs by spaces.

Copy Records

This screen is accessed by selecting Admin > Files > Update Processes > 
Copy Records. It allows you to copy records from one file to another or to 
duplicate the record using a different ID in the same file.

Value Description

0 Edits a record in the data part of the specified file.

1 Edits a record in the dictionary part of the specified file.

Data/Dictionary Options 
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Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to copy records.

Prompts

Source File Name

The name of the source file from which the records to be copied are selected.

Data/Dict (0/1)

Options are:

Record(s) to Copy (*all)

The IDs of the records to be copied from the specified file. Enter ∗ to copy all 
records. Separate IDs by spaces.

Target File Name

The name of the file to which the copied records are written. The target file 
may be the same as the source file if records are to be duplicated.

Record Name(s) (null same)

New IDs must be entered if the records are to be duplicated in the source file. 
Leave blank if the IDs are to be copied with the same names to another file.

Value Description

0 Copies from the data part of the specified file.

1 Copies from the dictionary part of the specified file.

Data/Dictionary Options 
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Options: Overwrite, Delete (O, D)

Options can be combined. They are:

Clear File

This screen is accessed by selecting Admin > Files > Update Processes > 
Clear File. It allows you to clear the contents of either the dictionary part or 
the data part of a file. The file itself is not deleted. We advise backing up 
important files before clearing them. 

Note: All records are deleted unconditionally.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to clear a file.

Prompts

File Name

The name of the file to be cleared.

Value Description

O Overwrites records that exist on the target file. 

D Deletes records on the source file after copying. 

Overwrite/Delete Options 
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Data/Dict (0/1)

Options are:

Create A File - UniData

This screen is accessed by selecting Admin > Files > Update Processes > 
Create File. It allows you to create non-SB+ files. (The files created using this 
screen are not known to SB+. They do not appear in file lists in intuitive help, 
for example.) The Create File option on the Tools menu creates SB+ files, but 
is not available for run-time licenses. On some platforms, full file type 
specification is available only when creating files using this option.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to create a file.

Value Description

0 Clears records from the data part of the source file.

1 Clears records from the dictionary part of the source file.

Data/Dictionary Options 
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Prompts

File Name

A unique name for the file to be created.

Description

(Optional.) An appropriate description for the file.

Type (0/1/2)

The type of file to be created. Options are:

Dynamic

Allows you to create a dynamic file. Dynamic files are self-resizing. For 
further details, see your UniData documentation. Options are:

Modulo

The number of primary groups allocated to the file. For further details, see 
your UniData documentation.

Sep

The number of blocks allocated per group. For further details, see your 
UniData documentation.

Value Description

0 Creates the data part of the file only. 

1 Creates the dictionary part of the file only.

2 Creates both the data and dictionary parts of the file.

File Type Options 

Value Description

Y Creates a dynamic file.

N Creates a normal file.

Dynamic File Options 
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DIR Type

If the file is not a dynamic file (N is entered at the Dynamic prompt), and the 
file type is 0 or 2, you can specify the data part of the file to be created as a 
directory type file. If the file is a dynamic file (Y is entered at the Dynamic 
prompt), this field is blank. Options are:

Hash Type

The hash type determines the way data is stored on disk. For further details, 
see your UniData documentation. Options are:

Type Description

Y Creates a directory type data part of the file.

N Creates a normal data part of the file.

DIR Type Options 

Type Description

0 The default for non dynamic files.

1 The default for dynamic files.

Flash Type Options 
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Create A File - UniVerse

This screen is accessed by selecting Admin > Files > Update Processes > 
Create File. It allows you to create non-SB+ files. (The files created using this 
screen are not known to SB+. They do not appear in file lists in intuitive help, 
for example.) The Create File option on the Tools menu creates SB+ files, but 
is not available for run-time licenses. On some platforms, full file type 
specification is available only when creating files using this option.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to create a file.

Prompts

File Name

A unique name for the file to be created.

Description

(Optional.) An appropriate description for the file. 
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File Details – Dictionary Level Type

A number of different types of files can be created. The difference between 
most types relates to the different hashing algorithms used. You should select 
the type most suited to the nature of the records the file will contain.

Type 1 files are used for programs or large text records. Each record is stored 
as a separate UNIX file. For further details, see your UniVerse 
documentation.

Leave this field blank if you do not want to create the dictionary part of the 
file.

File Details – Dictionary Level Modulo

The number of primary groups allocated to the dictionary part of the file. For 
further details, see your UniVerse documentation.

File Details – Dictionary Level Separation

The number of blocks allocated per group to the dictionary part of the file. 
For further details, see your UniVerse documentation.

File Details – Data Level Type

A number of different types of files can be created. Most relate to the different 
hashing algorithms used. You should select the type most suited to the nature 
of the records the file will contain.

Type 1 files are used to contain programs or large text records. Each record is 
stored as a separate UNIX file. For further details, see your UniVerse 
documentation.

If you do not want to create the data part of the file, leave this field blank.

File Details – Data Level Modulo

The number of primary groups allocated to the data part of the file. For 
further details, see your UniVerse documentation.

File Details – Data Level Separation

The number of blocks allocated per group to the data part of the file. For 
further details, see your UniVerse documentation.
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Delete File

This screen is accessed by selecting Admin > Files > Update Processes > 
Delete File. It allows you to completely delete files created in the OE (or 
using the Create File tool described previously) from the system. 

If the file was created with the Tools > File Create/Delete > Create A New 
File option, it is an SB+ file and should be deleted using the Tools > File 
Create/Delete > Delete A File option. This ensures that SB+ is aware that the 
file has been deleted. If you use Admin > Delete File to delete an SB+ file, the 
file name continues to appear in intuitive help lookups, even though it has 
been deleted. (See “File Create/Delete” in the SB+ Server Reference Manual.)

Warning: Use caution when deleting a file. Be aware of the impact on other files in 
the system, as well as on data integrity. We recommend that you back up important 
files before deleting them. After a file has been deleted, the only way to recover it is 
from a backup. The more recent the backup is, the less data is lost.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to delete a file.

Prompts

File Name

The name of the file to be deleted. Be aware that data in the file is lost when 
the file is deleted. Data can be recovered only by restoring the file from a 
backup.
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Delete Record

This screen is accessed by selecting Admin > Files > Update Processes > 
Delete Record. It allows you to delete one or more records from a file. After 
requesting a record deletion, you are prompted to confirm it.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to delete a file.

Prompts

File Name

The name of the file containing the records to be deleted.

Data/Dict (0/1)

Options are:

Value Description

0 Deletes records from the data part of the file.

1 Deletes records from the dictionary part of the file.

Data/Dictionary Options 
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Record Name(s) (*all)

The IDs of the records to be deleted from the file. Enter ∗ if all records are to 
be deleted. Separate IDs by spaces.

Access File In Another Account

This screen is accessed by selecting Admin > Files > Update Processes > 
Access File Other Account. From the current account, you can reference 
records in a file in another account by using a remote file pointer. This option 
allows you to define a link to the remote file. The pointer name may be the 
same as that of the remote file name, or it may be different. A file in the 
current account may also have a synonym pointer; a pointer to it is created in 
the current account using a different name, and the file can be opened using 
the synonym or the original name. You can create multiple synonyms for 
local and remote files.

For example, although it may be part of a uniform file naming scheme, the 
file name BEV000-PARTA is rather cryptic. When writing user subroutines or 
paragraphs, clarity is improved by using a meaningful name for the file, such 
as CONTRACT-HEADER. You can achieve this by creating a synonym or 
remote file pointer to BEV000-PARTA called CONTRACT-HEADER, dependent 
on the location of BEV000-PARTA.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to access a file in 
another account.
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Prompts

Other Account Name

The name of the account containing the file to be accessed from the account 
in which you are currently working. If the file is in the current account and 
you want to create a synonym, leave this prompt blank.

File Name In Other Account

The name of the local or remote file you want to access.

Name For This Account

The name to be used in this account to access the file.
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Search and Replace

This screen is accessed by selecting Admin > Files > Update Processes > 
Search and Replace. It allows you to find records in a file that contains the 
given search strings and to optionally replace each instance of the search 
string with an alternative string. You can specify multiple search and replace 
string combinations. To specify search-only, leave the Replace String field 
blank.

The CLEAN.SYSTEM process clears all saved search and replace setups. (For 
further details, see the SB+ Server Reference Manual.) Copy the setups you 
want to keep to another file before running CLEAN.SYSTEM.

Function Keys

F2 - Accept

Accepts the screen parameters and initiates the process to search and replace 
a string.
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F5 - Recall a Setup

Recalls previously saved search details to be used with another file. Details 
are stored in the xxCONTROL file with a default ID of $SRportno. Recalled 
details do not overwrite any selection criteria or options you have already 
entered.

F6 - Save a Setup

Saves details of a search (apart from the file being searched). You can recall 
these details later for subsequent searches with different file names. Details 
are stored in xxCONTROL with an ID of $SRportno.

F7 - Delete a Setup

Deletes previously saved search details if required.

Prompts

File Name

The name of the file to be searched.

Selection

(Optional.) Selection criteria for this search. If you do not specify selection 
criteria, all records are searched. If you want to limit your search, enter 
selection criteria. Use standard Query syntax; for example:

AREA = "LON" AND BALANCE > "123"
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Options

Determine the manner in which the string is searched and what happens to 
the records found. Options can be combined. They are:

Search String

The string to be searched within the selected records.

Replace String

The string to replace the search string, if found. If you want to search for a 
string but not replace it, leave this field blank.

Value Description

C Confirm. Each time the string is found, you are prompted 
to confirm that you want to replace it.

Warning: To avoid possible data integrity problems, we 
recommend that you always specify this option.

L List. Produces a list of record IDs that contain the search 
string. The list is stored in xxCONTROL with an ID of 
$filename.port.

S Select list. Returns an active select list of the IDs containing 
the string.

U Unique. Specifies that the search string must be a whole 
word. 

Search Options 
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View File Data

Provides options for viewing data in a file.

List Records In File

This screen is accessed by selecting Admin > Files > View File Data > List 
Records In File. It allows you to list records held in a file. This is a simplified 
version of the Query Report Definitions tool and can be used when the Tools 
menu is not available. This tool uses standard dictionary definitions only.
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Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to list records in a file.

Prompts

File Name

The name of the file containing the records to be listed.

Sort Fields

The fields used to sort the records. Fields should be in descending order of 
importance and delimited by a single space.

Fields to Print

The names of the fields to be printed in the list, delimited by a single space.

Selection Criteria

Selection criteria (if required) for this report. All records are printed if no 
selection criteria is entered. You should use standard Query syntax; for 
instance:

AREA = "LON" AND BALANCE > "123"

Totals Only (Y/N)

Options are:

Heading

(Optional.) A heading for the listing. 

Value Description

Y Prints totals only; no detail lines are printed. 

N Prints detail and total lines.

Totals Options 
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Footing

(Optional.) A footer for the listing.

Screen/Printer (S/P)

Options are:

List All File Names

This option is accessed by selecting Admin > Files > Update Processes > List 
All File Names. It allows you to list the names of all files held in this account, 
and files that exist in other accounts that can be accessed from this account.

This tool is an interface to the OE command for listing files on your platform 
(for example, the UniData command LISTFILES or LISTF). For further 
information, see your OE documentation.

Value Description

S Sends report output to the screen. 

P Sends report output to the printer.

Screen/Printer Options 
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List Entire Record

This screen is accessed by selecting Admin > Files > View File Data > List 
Entire Record. It allows you to list the contents of a record to either the screen 
or a printer.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to list records in a 
record.

Prompts

File Name

The name of the file containing the records to be listed.
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Data/Dict (0/1)

Options are:

Record Id(s) (*all)

The IDs of records to be listed. Enter ∗ to list all records. Separate IDs by 
spaces.

Screen/Printer (S/P)

Options are:

Options (I,S,F) - UniVerse

Options (which can be combined) are:

Value Description

0 Lists record contents from the data part of the file. 

1 Lists record contents from the dictionary part of the file.

Data/Dictionary Options 

Value Description

S Displays records on the screen.

P Sends record listing to the printer.

Screen/Printer Options 

Value Description

I Suppresses display of the default ID in the list. Equivalent 
to the ID-SUPP Query modifier.

S Suppresses line numbering.

F Sends a form feed after each record. 

UniVerse Options 
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List Dictionary

This screen is accessed by selecting Admin > Files > View File Data > List 
Dictionary. It allows you to list records in the dictionary part of a file to the 
screen.

Prompts

File Name

The name of the dictionary file whose contents are to be listed.

Count Records In File

This screen is accessed by selecting Admin > Files > View File Data > Count 
Records In File. It allows you to count the number of dictionary or data 
records in a file. You can enter selection criteria specifying the records to be 
counted.
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Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to count records.

Prompts

File Name

The name of the file whose records are to be counted.

Data/Dict (0/1)

Options are:

Selection Criteria

Selection criteria (if required) specifying the records to be counted. Leave 
blank to count all records. Use standard Query syntax. For example:

AREA = "LON" AND BALANCE > "123"

Value Description

0 Counts the records in the data part of the specified file. 

1 Counts the records in the dictionary part of the file.

Data/Dictionary Options 
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Sum A Field

This screen is accessed by selecting Admin > Files > View File Data > Sum 
A Field. It allows you to total the values of a field in selected records from one 
file.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to sum a field.

Prompts

File Name

The name of the file containing the field whose contents are to be totalled.

Sum Field Name

The name of the field.

Selection Criteria

Selection criteria (if required) specifying the records. You should use 
standard Query syntax. For example:

AREA = "LON" AND BALANCE > "123"
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Compare Records

This screen is accessed by selecting Admin > Files > View File Data > 
Compare Records. It allows you to compare two records (or multiple pairs of 
records) held in a file or in different files.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to compare records.

Prompts

Reference File Name

The name of the file containing the initial records to be compared.

Record Name(s)

The ID of the records in the reference file to be compared. ∗ selects all records 
in the reference file.

Compared File Name

The name of the file containing the records to be compared against. The 
default file name is the reference file name entered above.
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Record Name(s)

The ID of the second records that are to be compared with records in the 
reference file entered. ∗ selects all records in the compared file. If the 
reference and compared files are the same, ∗ is not a valid response.

Output to (S/P/X/F/L)

Options are:

Resize Files

Provides options for resizing files.

Value Description

S Outputs the results of the comparison to the screen.

P Outputs the results of the comparison to the printer.

X Outputs the results of the comparison to the auxiliary 
printer.

F Outputs the results to xxWORK file, with an ID of 
COMPport.

L Outputs the results of the comparison to a record with the 
ID $filename:port in xxCONTROL.

Output Options 
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The amount of disk space allocated to a file should be matched to the actual 
volume of data in the file. Incorrectly sized files may have a serious effect on 
system performance; files that are too small may take too long to access, 
while files that are unnecessarily large waste disk space.

Note: This menu is not available on Windows-based installations.

You will need to resize files from time to time as the amount of data held 
changes. SB+ partially automates this procedure, using statistical 
information obtained by the system, together with parameters maintained by 
the user.

Determine File Sizes

This screen is accessed by selecting Admin > Files > Resize Files > 
Determine File Sizes. It provides file size statistics for the current file. A 
statistics file can be produced for the whole system or for individual 
accounts, as follows:

1. A statistics file is built for an account or the whole system by 
scanning every file within the accounts specified. This step can be 
skipped if the current statistics file is up to date.

2. The SB+ history file is updated with the current statistics. The 
process then calculates the suggested resizing parameters. File 
growth history can be used in the calculations.
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Function Key

F2 - Accept

Accepts the screen parameters and begins the process of generating file 
statistics.

Prompts

Account to do (*=All)

The account names delimited by a single space or ∗ (for all) for which resize 
parameters are to be calculated.

Last Valid Suggestions

(Display only.) The date on which the last valid file resizing suggestions were 
calculated. If no previous resizing calculations have been made, or the 
statistics file has been cleared, this field is blank.

Use History Growth Factor (Y/N)

Each time a file is resized, SB+ keeps a record of previous modulos for the file. 
After there are three or more previous sizes recorded for a file, SB+ can use 
this information to determine the percentage growth, taking this into account 
when working out the new file size. Options are:

Value Description

Y Includes growth history in resize calculations for specified 
accounts.

N Calculates resize parameters without reference to growth 
history.

History Growth Factor Options 
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File Size Reports

This option provides information generated from the most recent run of the 
Determine File Sizes process. This assists the system administrator in 
determining strategies for file resizing. The reports are:

All File Statistics by Account

This screen is accessed by selecting Admin > Files > Resize Files > File Size 
Reports > All File Statistics by Account. The report shows a complete listing 
of file statistics for all accounts nominated in the last run of the Determine 
File Sizes process. Information includes the current size, utilization and 
growth of the file, and the current and suggested modulo sizes.
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Files Suggested to Resize

This screen is accessed by selecting Admin > Files > Resize Files > File Size 
Reports > Files Suggested to Resize. The report is similar to the All File 
Statistics by Account report, but it lists only those files that Determine File 
Sizes has determined are in need of resizing.

Files Too Small by Account

This screen is accessed by selecting Admin > Files > Resize Files > File Size 
Reports > Files Too Small by Account. The report is similar to the All File 
Statistics by Account report, but it lists only those files that Determine File 
Sizes has found to be in need of resizing because the modulo is too small. 
(When a file’s modulo is very small, part of the contents of the file are stored 
in overflow.)
4-35 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\4Admin.fm
Files Too Big by Account

This screen is accessed by selecting Admin > Files > Resize Files > File Size 
Reports > Files Too Big by Account. The report is similar to the All File 
Statistics by Account report, but lists only those files that Determine File Sizes 
has found to be in need of resizing because the modulo is too large. (When a 
file’s modulo is overly large, too much disk space has been allocated for the 
file.

Prepare File Resizing 

This screen is accessed by selecting Admin > Files > Resize Files > Prepare 
File Resizing. It updates the file records with the suggested modulo and 
separation.

Note: The actual resize only takes place when an account-save or file-save is done, 
followed by an account-restore or file-restore.

This option updates all files selected by Determine File Sizes. You can 
manually adjust the suggested options in individual files if required before 
the account or file-save is performed.
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If you want to resize only a few files, this may not be the best option. The 
Manually Resize A File option allows you to manually resize a single file, and 
also allows you to resize the file immediately rather than at the next restore. 
See “Manually Resize a File” on page 4-38.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Account(s) to Resize (*=All)

The account names, delimited by a single space, whose files are to be updated 
with the resizing parameters. Enter ∗ for all accounts.

Maintain Resizing Parameters

Allows you to manage the size of your files.
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Manually Resize a File

This screen is accessed by selecting Admin > Files > Resize Files > Maintain 
Resizing Parameters > Manually Resize A File. Resizing parameters can be 
entered manually for files in the nominated account. You should run 
Determine File Sizes first to get the current file size statistics.

Note: The UniVerse screen is similar to the UniData screen shown here.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to resize a file.
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Prompts

Account Name

The account name containing the file to be resized.

File Dict Name

The name of the dictionary part of the file. Leave blank if the VOC is to be 
resized.

File Data Name

The name of the data file to be resized. Leave blank if only the dictionary part 
of the file is to be resized.

Resize History Shows Average Growth Is %

(Display only.) The calculated average growth of the file.

Growth % Over Period of days is %

The expected growth percentage (%) for the file over the period shown. This 
figure is used in calculating the resize parameters. 

No of Items

(Display only.) The number of records held in the file being resized.

Average Size

(Display only.) The average size of the records in the file being resized. 

Util %

(Display only.) The percentage of the total file size being utilized.

Growth %

(Display only.) The percentage growth allowed each time the file is resized. 
This is determined by the parameters specified in the Maintain Global 
Tuning screen.
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Since Date

(Display only.) The date of the last resize.

Present Modulo

(Display only.) The current modulo for this file.

Recommended Modulo

Press the ENTER key to accept the new recommend modulo, or enter a new 
value. The value should be a prime number.

Present Type - UniVerse only

(Display only.) The current file type for this file.

Present Separation UniVerse only

(Display only.) The current separation for this file.

Recommended Type - UniVerse only

An (optional) new file type, otherwise the current type is assumed.

Recommended Separation - UniVerse only

Press the ENTER key to accept the recommended separation, or enter a new 
value.

Resize File Immediately (Y/N) - UniVerse only

Options are:

Value Description

Y Resizes the file immediately. This is achieved by exercising 
the UniVerse RESIZE command. Ensure that other users are 
not accessing the file to be resized during this process.

N Resizes the file when the next account-restore or file-restore 
is performed.

Resize File Options 
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Fine Tune A File Resizing

This screen is accessed by selecting Admin > Files > Resize Files > Maintain 
Resizing Parameters > Fine Tune A File Resizing. It allows you to set 
defaults for files that may grow in a nonstandard manner.

Note: The UniVerse screen is similar to the UniData screen shown here.

Function Key

F2 - Accept

Accepts the screen parameters.
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Prompts

Account Name

The account name containing the file to be manually fine-tuned.

File Dict Name

The name of the dictionary part of the file if the dictionary or data part is to 
be fine-tuned. Leave blank if the VOC is to be fine-tuned.

File Data Name

The name of the data part of the file. Leave blank if only the dictionary part 
of the file is to be resized.

No. of Items

(Display only.) The number of records held in the file being resized.

Average Size

(Display only.) The average size of the records in the file being resized.

Util %

(Display only.) The percentage of the total file size being utilized.

Growth %

(Display only.) The percentage growth allowed each time the file is resized. 
This is determined by the parameters specified in the Maintain Global Tuning 
option.

Since Date

(Display only.) The date of the last resize.

Resize History Shows Average Growth is %

(Display only.) The calculated average growth of the file.
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Growth % Over Period of days is %

The expected growth percentage over a period of the number of days shown. 
This figure is used within the calculation determining file size.

Tolerance % Before Resizing is %

A tolerance level that determines whether to resize the file. The 
recommended new modulo is compared to the current modulo and if the 
percentage of difference is greater than the tolerance percentage, the resize 
suggestion is written to the file.

For example, if the tolerance figure is 0%, the file is always resized, assuming 
the new modulo is different from the current one. This figure overrides the 
default tolerance for this file, specified in the next menu option.

Minimum Modulo to accept is

A minimum modulo for the file, regardless of the number of existing records.

Present Type - UniVerse

(Display only.) The current file type for this file.

Present Modulo 

(Display only.) The current modulo for this file.

Present Separation - UniVerse

(Display only.) The current separation for this file. Separation is the number 
of blocks allocated per group to the dictionary part of the file. For further 
information about separation, see your UniVerse documentation.

Recommended Type - UniVerse

(Display only.) The new file type, if different from the current type; otherwise, 
the file type is assumed.

Recommended Modulo

(Display only.) The new recommended modulo, or enter a new value. The 
value should be a prime number.
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Recommended Separation - UniVerse

(Display only.) The recommended separation for this file.

Maintain Global Tuning

This screen is accessed by selecting Admin > Files > Resize Files > Maintain 
Resizing Parameters > Maintain Global Tuning. Allows you to specify the 
global parameters SB+ uses to calculate its resizing recommendations.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Default Tolerance before resizing %

The default tolerance value to be used for all files in all accounts when 
determining recommended file resize parameters. SB+ uses the default 
tolerance value to determine whether to suggest a new size for the file. If the 
percentage of difference between the recalculated modulo and the current 
modulo is less than the default tolerance percentage entered here, the new 
modulo is ignored.

If a specific file is to have an alternative tolerance value, you can specify one 
using the Fine Tune A File resizing option.
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Resize Growth Period Days

The default growth period (in days) within the resize calculation. This is used 
as a default for all files and all accounts.

For example, if the growth period is defined as 30 days, SB+ attempts to 
project what the file sizes will be 30 days in the future based on past growth.

Perform House Keeping

Provides options for removing redundant resize statistics and suggestions 
for an account or file.

Remove Resize Suggestions

This screen is accessed by selecting Admin > Files > Resize Files > Maintain 
Resizing Parameters > Perform House Keeping >Remove Resize 
Suggestions. It allows you to remove resize suggestions for one or more 
accounts.
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Function Key

F2 - Accept

Accepts the screen parameters and removes the resize suggestions.

Prompts

Account Name(s) (* = All)

The names of accounts, delimited by spaces, for which resize suggestions are 
to be removed. Enter ∗ for all accounts.

Clear Redundant History

This screen is accessed by selecting Admin > Files > Resize Files > Maintain 
Resizing Parameters > Perform House Keeping >Clear Redundant History. 
It allows you to clear a file resize history for an account no longer on the 
system. When an account is deleted from the system, its history statistics 
remain. We recommend removing the history for an account that is no longer 
required. However, if you think you might restore an account in the future, 
you should retain its history statistics.

Function Key

F2 - Accept

Accepts the screen parameters and removes the file resize history.
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Prompts

History Account Name (* = All Old)

The names of accounts to have their file resize history removed.

Purge Resize History

This screen is accessed by selecting Admin > Files > Resize Files > Maintain 
Resizing Parameters > Perform House Keeping >Purge Resize History. It 
allows you to clear the resize history for all accounts on the system. You are 
prompted for confirmation before proceeding.

Warning: Use the purge feature with caution.
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Printers and Terminals

The Printers and Terminals menu provides options for accessing all printer 
management functions and terminal definitions, and for mapping terminals 
and printers to your system ports.

Printer Management

The Printer Management option allows you to maintain the printers on your 
system and to control a report’s destination printer and stationery type. For 
a comparative overview of the previous and present printer management 
systems, and a discussion of features of the present system, see Appendix B, 
“Appendix B: Printer Management.”
  4-48



E:\SVN\SB55\doc_set\sbplus\administration\4Admin.fm
5/13/14 
Where the screen image is specific to the database on which you are running 
SB+, the screen is marked accordingly; otherwise the screens are common 
across databases. For more information, see “About Administrative 
Features” on page 4-3.

Notes on UniData Printer Management

Two versions of the SB+ Server Printer Manager are available for UniData: 
one for standard UniData printing, and one for sites with the UDT:Print 
package installed.

Note: USAM/UDT:Print (also known as SPrint) version 3.5d or later is required for 
correct operation with the SB+ Printer Manager. Earlier versions such as SCH:Print 
(also known as QPrint) are not guaranteed to work with SB+. The product is referred 
to as UDT:Print in this manual. This refers to all compatible versions under different 
names as described above.

Standard UniData printing uses the UNIX spooler directly. Consequently, all 
maintenance and control of printers and spool jobs is performed using the 
UNIX tools. 

Certain features of the SB+ Printer Manager are not available with standard 
UniData. These features are available with UDT:Print only:

■ Maintain Printers

■ Maintain Spooled Reports

■ Kill Current Job

■ Initialize Spooler

■ Access UDT:Print
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Physical Printer Definition – UniData

Process /PHYSICAL.PRINTER

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Physical Printer Definition.

The physical printer record describes the characteristics of the actual printer 
in use for a given system port or device. It is defined in SB+ with a 
meaningful name, which SB+ uses to refer to the printer. The name specified 
is independent of any system-specific number, name, or device. The physical 
printer can be regarded as an entity independent of the hardware it currently 
defines or the software that drives it.

The Physical Printer Definition screen allows you to define the physical 
printer entity, and specify the physical attributes relevant to the actual 
printer. These attributes are:

■ Printer description, class, and stationery type.

■ Device type and form names; for example, UDT:Print.

■ UNIX print device for each stationery type.
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■ Start and stop escape sequences. The start and stop escape sequences 
are usually used to set a printer to the emulation required for the 
associated printer class, and reset if required after completing a job.

Other parameters are maintained from subordinate screens:

■ Location

■ Real-time printer parameter defaults (UDT:Print)

■ Report types

If you are associating a printer class with the physical printer record, 
stationery types associated with a printer class must have either form names 
or UNIX print devices associated with them.

This screen is not used to start or stop printers. The records created are 
definitions, which remain constant regardless of actual started printers, until 
changed by the system administrator.

Note: Any user who has access to the Printer Management menu and/or processes 
can create and maintain a physical printer definition. Superuser permissions are not 
required.

Function Keys

F2 - Save

Saves the physical printer definition. If the physical printer edited is the 
current printer in the COMMON variable PRINT.DEFN, the PRINT.DEFN is 
automatically updated.

F4 - Del

Deletes the physical printer definition. If the definition is in use, deletion is 
prevented. The physical printer DEFAULT cannot be deleted.

F5 - Report Type

Displays the Report Type table. This table allows you to enter report types 
and optional stationery type to be used if a report with the appropriate report 
type is being printed using the current physical printer.
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F6 - Defaults (UDT:Print)

Displays one of the Default Printer Characteristics screens, where you can 
enter defaults for real-time printer parameters. See the Default Printer 
Characteristics F6 screens below.

F7 - Locations

Displays a screen that allows you to maintain the current physical printer's 
location.

Locations for all physical printers can be maintained in the Admin > Printers 
and Terminals > Printer Management > Maintain Locations screen.

F10 - Action

Displays the action bar:

Prompts

Printer Name

The name of an existing physical printer to edit, or a suitable name to define 
a new physical printer. The Printer Manager refers to all printers using names 
defined here.

Current Location

(Display only.) The physical location of this printer.

Description

A meaningful description; for example, Main System Printer (/dev/lp0).

Action Description

Print Prints a detailed physical printer definition report. Output 
may be redirected.

Copy Copies physical printer definitions.

Help Displays a menu of additional help options.

Action Bar
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Device Type (UDT:Print)

The type of UDT:Print device to be defined. The types are as follows:

For each type, a different Default Printer Characteristics screen is invoked 
from the F6 key. The device types are discussed in “Default Printer 
Characteristics F6 (UDT:Print)” on page 4-55.

Printer Class

The printer class is defined using the Printer Class Definition screen in the 
Admin > Printers and Terminals > Printer Management menu. The printer 
class contains control sequences relating to a class of printers. Associating a 
printer class with a physical printer means that the physical printer inherits 
the generic characteristics of the printer class, while it is associated with that 
particular printer class.

You can change the associated printer class at any time. This allows you to 
redefine a physical printer in terms of the actual printing hardware, but to 
retain the same identity.

Stationery Type

If this field is blank, the stationery types that were associated with the printer 
class specified at the Printer Class prompt are displayed. The field can then 
be edited. Stationery types not required for the current physical printer can 
be deleted. If you accidentally delete a stationery type or the stationery type 
list needs to be expanded, press the F3 key to select stationery types. You can 
select only the stationery types that have been defined for the printer class.

Value Description

S Serial printer.

P Parallel printer.

T Terminal server program.

N Non-UDT:Print printer on a network node.

U UDT:Print printer on a network node.

Device Types 
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Form Name (UDT:Print)

If you specify a stationery type, you must assign a form name to the 
stationery type. You can assign any form name any number of times.

To prevent confusion, we recommend assigning a form name that is the same 
as the stationery type name. For further details on form usage, see the 
UDT:Print section in Volume 2 of the U2 USAM manual.

The Printer Manager leaves form manipulation to the UDT:Print spooler as 
much as possible. For example, specifying a form name that is different from 
that used in the started printer, and printing using that stationery type 
produces a job that is held on the spooler, which can be manipulated as 
required.

Unix Printer (Standard UniData)

The name of a print device that has been created using the UNIX print 
administration tools. For example, if a printer called HPLJII has been created, 
you would use that name. Do not use device pathnames, such as /dev/lp0, 
here. If a printer is called lp0 and points to the device /dev/lp0, you can use 
the name lp0.

Start Sequence

An escape sequence to be sent at the start of a print job. This is usually used 
to set a printer to the emulation mode required by the printer class associated 
with the physical printer entity for that printer.

This sequence is sent at the start of every print job, if defined.

Stop Sequence

An escape sequence to be sent at the end of a print job. This would usually be 
used to reset a printer to native emulation mode or to another emulation 
mode if required.

This sequence is sent at the end of every print job, if defined.
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Default Printer Characteristics F6 (UDT:Print)

The following sections describe the Default Printer Characteristics screens, 
which you can access by pressing the F6 key in the Physical Printer 
Definition screen.

The subordinate screen displayed depends on the value specified at the 
Device Type prompt in the physical printer definition for the printer on the 
current line:

You can enter default parameters for the current physical printer. These 
defaults are used in the Maintain Printers screen. After a printer is started, 
you can modify the defaults in similar screens available from that screen.

It is not possible to modify the characteristics of a started printer from these 
screens. Only the default values are modified.

Any user who has access to the Printer Manager can enter or modify these 
defaults; superuser permissions are not required.

The Default Printer Characteristics screens are described in the sections that 
follow.

Value Description

S Serial printer.

P Parallel printer.

T Terminal server program.

N Non UDT:Print printer on a network node.

U UDT:Print printer on a network node.

Device Types 
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Serial Printer Characteristics (S)

This screen is displayed when you enter S at the Device Type prompt in the 
Physical Printer Definition screen and press the F6 key.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Unix Device Name

The UNIX device name for this printer. The input is validated; parallel 
devices such as /dev/lp0 do not pass validation. If the device name begins 
with a / character, you must enter a \ character preceding the name.

Port Setup Program

The name of a UNIX program used to initialize the serial device entered at 
the Unix Device Name prompt, if applicable.

Filter Program

The name of a UNIX program that will filter the output from the UDT:Print 
spooler. An example of this is a Postscript filter program.
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Form Name

The default form name to be used at start-up. It can be any of the form names 
defined for this physical printer. The default is the first form entered.

Row

The method of flow control for this printer.

Baud

The speed at which the computer is to communicate with the printer.

Parity

The type of error checking the computer is to perform when communicating 
with the printer.

WordLn

The number of bits that comprise one word of data for this printer.

Open Tmout

The length of time allowed for attempting to open the printer device before 
timing out.

Off Tmout

The length of time allowed for attempting to establish an online connection 
to the printer device before timing out.

Buffer Sz

The size of the printer buffer in bytes.
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Parallel Printer Characteristics (P)

This screen is displayed when you enter P at the Device Type prompt in the 
Physical Printer Definition screen and press the F6 key.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Unix Device Name

The UNIX device name for this printer. The input is validated; serial devices 
such as /dev/tty0 or /dev/tty1a do not pass validation. If the device name 
begins with a / character, you must enter a \ character preceding the name.

Filter Program

The name of a UNIX program that will filter the output from the UDT:Print 
spooler. An example of this is a Postscript filter program.
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Form Name

The default form name to be used at start up. It can be any of the form names 
defined for this physical printer. The default is the first form entered.

Open Timeout

The length of time allowed for attempting to open the printer device before 
timing out.

Offline Timeout

The length of time allowed for attempting to establish an online connection 
to the printer device before timing out.

Buffer Size

The printer buffer size in bytes.

Terminal Server Printer Characteristics (T)

This screen is displayed when you enter T at the Device Type prompt in the 
Physical Printer Definition screen and press the F6 key.

Function Key

F2 - Accept

Accepts the screen parameters.
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Prompts

Server Transfer Command

The full pathname of a UNIX Terminal Server program that will print the 
current job to a printer attached to a terminal server on the UNIX host.

Network Printer Characteristics (N)

This screen is displayed when you enter N at the Device Type prompt in the 
Physical Printer Definition screen and press the F6 key. It allows jobs to be 
printed to any printer on a remote machine defined using the UNIX printer 
administration tools.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Node Name

The name of the node or its Internet address (for example, 192.0.0.10). If a 
name is entered, the name must exist in your local /etc/hosts file. The F3 key 
displays the /etc/hosts file.
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Local Remote Shell Command

The remote shell command that resides on your local machine. This is usually 
/bin/rsh or /bin/remsh.

Remote Print Command

The command to print jobs to the spooler on the remote machine. This is 
usually lp or lpr.

Remote User Id

The user ID to be used to log on to the remote machine. The user ID spooler 
is the default.

Remote UDT:Print Printer (U)

This screen is displayed when you enter U at the Device Type prompt in the 
Physical Printer Definition screen and press the F6 key. It allows jobs to be 
printed to printers on a remote machine defined using UDT:Print on that 
machine.

Function Key

F2 - Accept

Accepts the screen parameters.
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Prompts

Node Name

The name of the node or its Internet address (for example, 192.0.0.10). If a 
name is entered, the name must exist in your local /etc/hosts file. The F3 key 
displays the /etc/hosts file.

Alias

An alias used for the node if specified.

Auto Start

Options are:

Value Description

Y Invokes UDT:Print on the remote machine if it is not 
already started, and tests for the requested printer's 
existence.

N UDT:Print must be started on the remote machine before 
the test for the requested printer's existence can be carried 
out.

Auto Start Options 
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Physical Printer Definition – UniVerse

Process /PHYSICAL.PRINTER

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Physical Printer Definition. It allows you to define 
the physical printer entity, and specify the physical attributes relevant to the 
actual printer. These attributes are:

■ Printer class and stationery type/form names.

■ UNIX device, UniVerse print driver, and lock files.

■ Start and stop escape sequences.

The start and stop escape sequences are usually used to set a printer to the 
emulation required for the associated printer class, and reset if required after 
completion of a job.
4-63 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\4Admin.fm
The physical printer entity describes the characteristics of the actual printer 
in use for a given system port or device. It is defined in SB+ with a 
meaningful name, which SB+ uses to refer to the printer. The name specified 
is independent of any system-specific number, name, or device, but can be 
any of these if desired (any alphanumeric name is acceptable). The physical 
printer can be regarded as an entity independent of the hardware it currently 
defines or the software that drives it.

For example, the physical printer SYSTEM describes the entity that is the 
main SB+ printer. The device defined by SYSTEM can be one of several 
different types of printers running under different emulations on different 
ports or devices.

Other parameters are maintained from subordinate screens:

■ Location

■ Real-time printer parameters

■ Report types

If you are associating a printer class with the physical printer record, 
stationery types associated with a printer class must have UniVerse form 
names associated with them. This is not required if you do not need forms for 
your printing requirements. This can be specified using a parameter screen, 
discussed later.

This screen is not used to start or stop printers. The records created are 
definitions, which remain constant regardless of actual started printers, until 
changed by the system administrator. Note that any user who has access to 
the Printer Management menu and/or processes can create and maintain a 
physical printer definition. Superuser or print group permissions are not 
required.

The physical printer definition is used, with printer class and stationery type 
definitions, to create the PRINT.DEFN COMMON variable and associated run-
time items in DMSECURITY.PRINT.DEFN are used in conjunction with the 
Printer Manager throughout SB+.
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Function Keys

F2 - Save

Saves the physical printer definition. If the physical printer edited is the 
current printer in PRINT.DEFN, the PRINT.DEFN is automatically updated.

F4 - Del

Deletes the physical printer definition. If the definition is in use, deletion is 
prevented. The physical printer DEFAULT.PRINTER cannot be deleted.

F5 - Report Type

Displays the Report Type table. This table allows you to enter report types 
defined by the system administrator in the System Administration account 
(SB or SB+), and optional stationery types to be used if a report with the 
appropriate report type is being printed using the current physical printer.

F6 - Defaults

Displays the Default Printer Characteristics screen. This is where you can 
enter defaults for real-time printer parameters. For details, see “Default 
Printer Characteristics F6” on page 4-68.

F7 - Location

Allows you to maintain the current physical printer's location.

You can maintain locations for all physical printers from the Maintain 
Locations screen in the Admin > Printers and Terminals > Printer 
Management menu.
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F10 - Action

Displays the action bar:

Prompts

Printer Name

The name of an existing physical printer to edit, or a suitable name to define 
a new physical printer. The Printer Manager always refers to the printer 
using names defined here.

Current Location

(Display only.) The physical location of this printer.

Description

A meaningful description; for example, Main System Printer (/dev/lp0).

Unix Device

The full UNIX pathname to the device to which this printer will be attached. 
To avoid the first / of the path being interpreted as a process call, you must 
precede the pathname with a \ character.

Driver Path

The full UNIX pathname to the shell script used by UniVerse as the printer 
device driver. The pathname must be preceded with a \ character.

Option Description

Print Prints a detailed Physical Printer Definition report. Output 
can be redirected.

Copy Copies physical printer definitions.

Help Displays a menu of help options.

Action Bar Options 
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Printer Class

The printer class is defined using the Printer Class Definition screen in the 
Admin > Printers and Terminals > Printer Management menu. The printer 
class contains control sequences relating to a class of printers. Associating a 
printer class with a physical printer means that the physical printer inherits 
the generic characteristics of the printer class, while it is associated with that 
particular printer class.

You can change the associated printer class at any time. This allows you to 
redefine a physical printer in terms of the actual printing hardware, while 
retaining the same identity.

Stationery Types

If this field is blank, the stationery types associated with the printer class 
specified at the Printer Class prompt are displayed. The field can then be 
edited. Stationery types that are not required for the current physical printer 
can be deleted. If an accidental deletion occurs or the stationery type list 
needs to be expanded, an F3 lookup is available. Only stationery types 
defined for the printer class specified can be selected.

Form Names

If you specify a stationery type, you must assign a UniVerse form name to the 
stationery type, and have specified that the form name be included in 
SETPTR and/or sp.config in the Physical Printer Definition > Default 
Printer Characteristics > Environment Defaults screen. You can assign any 
form name any number of times.

In general, to prevent confusion you should assign a form name that is the 
same as the stationery type name. For further details on form name usage, see 
the UniVerse Spooler Administration section of the UniVerse System 
Administration manual.

The Printer Manager leaves form name manipulation to the operating system 
as much as possible. For example, specifying a form name that is different 
from that used in the started printer (see “Maintain Printers – UniVerse” on 
page 4-99) and printing using that stationery type produces a job that is held 
on the spooler, which can be manipulated as required.
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Lock File Path(s) 1 & 2

The full UNIX pathname of the file that will be used when sharing this 
printer with other UNIX Processes. See the UniVerse Spooler Administration 
section of the UniVerse System Administration manual. The pathname must be 
preceded with a \ character. You can enter up to two paths.

Start Sequence

An escape sequence to be sent at the start of a print job. This is usually used 
to set a printer to the emulation mode required by the printer class associated 
with the physical printer entity for that printer.

This sequence is sent at the start of every print job, if defined.

Stop Sequence

An escape sequence to be sent at the end of a print job. This would usually be 
used to reset a printer to native or another emulation mode if required. If 
defined, this sequence is sent at the end of every print job.

Default Printer Characteristics F6

This screen is accessed by pressing the F6 key in the Physical Printer 
Definition screen. It allows you to define default characteristics for the 
printer that will be started using this physical printer definition. These 
defaults will be used at start time, unless modified using the F7-Modify 
Printer Parameters screen from the Maintain Printers screen. Any user who 
has access to the Printer Manager can enter or modify these defaults; 
superuser and/or print group permissions are not required.
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Many of the parameters in this screen refer to serial printers. Any value 
entered for those parameters; for example, Baud and Parity are ignored for 
parallel devices.

Function Keys

F2 - Accept

Accepts the screen parameters.

F6 - Environment Defaults

Displays the Environment Defaults screen. This is where the inclusion of 
printer and form names in the UniVerse print environment is specified. For 
further information, see “Environment Defaults F6” on page 4-71.

Prompts

Flow

The method of flow control for this printer.

Baud

The speed at which the computer is to communicate with the printer.

Parity

The type of error checking that will be used by the computer when 
communicating with the printer.

Print

If printing is to be enabled on this printer when the spooler is initialized 
(which will occur when the printer is started in Maintain Printers), enter Y. If 
not, enter N.

Queue

If queuing to this printer is to be enabled when the spooler is initialized 
(which will occur when the printer is started in Maintain Printers), enter Y. If 
not, enter N.
4-69 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\4Admin.fm
CR Cnv

The UniVerse term for the type of conversion carried out on a carriage return 
on output. Null means no conversion.

Tabs

If embedded tabs are to be expanded to eight spaces in the output, enter Y. If 
not, enter N.

FF

The form feed delay factor to be used. One of three values can be entered. For 
further information, see your UniVerse documentation or press the F3 key.

LF

The line feed delay factor to be used. One of nine values can be entered. For 
further information, see your UniVerse documentation or press the F3 key.

Wrdln

The number of bits that comprise one word of data for this printer.

Other Opts

Enter other UniVerse spooler options, such as PTERM settings. For further 
information, see your UniVerse documentation.
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Environment Defaults F6

This screen is accessed by pressing the F6 key in the Default Printer 
Characteristics screen. It allows you to include or exclude printer and form 
names in the environment.

Function Key

F2 - Accept

Accepts the environment defaults.

Prompts

Include Printer Name in SETPTR

If the printer name is to be included in SETPTR when a user logs on or uses 
a different printer/stationery type when printing, enter Y. This ensures that 
output goes to the specified printer, rather than the UniVerse default printer. 
You should always enter Y to correctly use printers defined in SB+, unless 
you use only one printer. To prevent inclusion of the printer name, enter N.
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Include Form Name in SETPTR

If the form name is to be included in SETPTR when a user logs on or uses a 
different printer/stationery type when printing, enter Y. This ensures that 
output is printed when a stationery type/form name combination is 
specified, and the actual form name on the started printer is set to the form 
name associated with the stationery type. You should always enter Y when 
stationery types are associated with a physical printer that has been started. 
If no stationery types are specified in the current physical printer, the 
response is forced to N. To prevent inclusion of the form name, enter N.

Create Form Name in sp.config

If the form name is to be added as an attribute in the sp.config item in the 
spooler directory, enter Y. This ensures that UniVerse knows about a form 
when it is specified in the SETPTR verb. If the Include Form Name in 
SETPTR prompt has a value of Y, this field is forced to Y, or N if the prior 
value is N. This ensures that printers set up in SB+ work correctly, and 
unnecessary information is not entered in sp.config.
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Printer Class Definition: Screen 1 – UniData

Process /PRINTER.CLASS

This screen is accessed by selecting the Admin > Printers and Terminals > 
Printer Management > Printer Class Definition.

The printer class specifies the table of graphic, color, and other miscellaneous 
escape sequences used by a family or class of printers. Additionally, the 
stationery types for this class are specified in this screen.
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For example, you can define the printer class EPSON.CLASS to contain the 
sequences for the Epson family of dot matrix printers. You can associate this 
printer class with any physical printer whose current device is an Epson dot 
matrix printer (or any one of the many printers that have an emulation for 
this printer). You can switch the emulating printer to the Epson emulation by 
entering the switching sequence at the Start Sequence prompt in the 
Physical Printer Definition screen.

You can associate an unlimited number of stationery types with a printer 
class. For each stationery type, you can define margins, auto spooler 
formatting, inter-job page advance, banner print state, Report Writer form 
feed behavior, and stationery type-specific set, reset, and page orientation 
sequences for printers requiring these sequences (such as laser printers).

The printer class, physical printer, and stationery type definitions are used to 
create the PRINT.DEFN COMMON variable, and associated run-time items in 
DMSECURITY. PRINT.DEFN is used in conjunction with the Printer Manager 
throughout SB+.

Function Keys

F2 - Save

Saves the printer class definition. If the printer class edited is the current 
printer class in the COMMON variable PRINT.DEFN, the PRINT.DEFN is 
automatically updated.

F4 - Del

Deletes the printer class definitions. If the definition is in use, deletion is 
prevented. The class DEFAULT.CLASS cannot be deleted.

F5 - Color

The Printer Class Colors screen is displayed if the Color prompt is set to Y. 
This screen allows you to define foreground and background colors for a 
color printer. At present, the Printer Manager does not support color 
printing; however, the table is stored in PRINT.DEFN, and can be referenced in 
reports or user subroutines.
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F8 - Stationery

Allows you to maintain stationery type definitions.

F9 - Seq+

The Additional Print Sequences screen allows you to define additional 
escape sequences for physical printers and stationery types in the same 
manner as the Additional Terminal Sequences in Terminal Definitions. SB+ 
does not use these sequences, but they are available for user subroutines. 
Physical printer sequences can be accessed in PRINT.DEFN<25,x>, and 
stationery type sequences in PRINT.DEFN<26,x>, where x is the position 
based on the order of entry in the screen.

F10 - Action

Displays the action bar:

Prompts

Printer Class

The name of an existing printer class to edit, or a suitable name to define a 
new printer class. 

Description

A meaningful description; for example, Epson LQ printers.

Graphics Description

(Display only.) The description of the character displayed in Graphics mode. 

Action Description

Print Prints a detailed physical printer definition report. Output 
may be redirected.

Copy Copies physical printer definitions.

Help Displays a menu of additional help options.

Action Bar
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Characters

Characters can be entered either as the printable character (where the 
character is printable) or as the decimal ASCII equivalent of the character, 
enclosed in parentheses.

Graphics Mode On

An escape sequence to turn on Graphics mode for the printer. Check the 
manual for your printer to find the correct sequence.

Graphics Mode Off

An escape sequence to turn off Graphics mode for the printer. Check the 
manual for your printer to find the correct sequence.

Stationery Type

A stationery type from the list of stationery types defined for the printer. A 
stationery type can be associated with as many printer classes as desired, but 
can be specified only once within the same printer class.

TM

The number of blank lines that will be printed at the top of a page before the 
text is printed. The default is 3. If no value is entered, this default is used.

BM

The number of blank lines that will be printed at the bottom of a page after 
the text is printed. The default is 3. If no value is entered, this default is used.

Fmt

If you want the printed output to be formatted automatically by the UniData 
spooler, enter Y. If the application is to control all formatting and pagination, 
enter N.

Ban

If you want a banner to be printed before each job, enter Y. If not, enter N. If 
Y, you will be prompted for a banner name.
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IJA

If you want to suppress the eject between each completed print job, enter Y. 
If not, enter N.

FF

If the Report Writer should send a form feed to advance to the next page of a 
job, enter Y. If not, enter N.

Set

An escape sequence to switch the printer to the stationery type setting. Check 
the manual for your printer to find the correct sequence.

Reset

An escape sequence to reset the printer's stationery type setting. Check the 
manual for your printer to find the correct sequence.

Orient

An escape sequence to set the printer's page orientation mode. Check the 
manual for your printer to find the correct sequence.

Color

Enter Y to allow color printer escape sequences to be defined.

Standard Columns

Where a printer class has no stationery type defined (which is a valid 
condition), the value entered at this prompt is used to set the page width for 
printing.

Rows

Where a printer class has no stationery type defined (which is a valid 
condition), the value entered at this prompt is used to set the page depth for 
printing.
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Condensed Columns

The Report Writer will use this value for its condensed mode width instead 
of the automatic calculation, if a value is entered at this prompt.

This parameter is not otherwise used by SB+, but is available for user 
processes. The parameter is located in the COMMON variable 
PRINT.DEFN<5,4>.

Rows

This parameter is not used by SB+, but is available for user processes. The 
parameter is located in the COMMON variable PRINT.DEFN<5,5>.
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Printer Class Definition: Screen 2 – UniData

This page of the screen can be accessed by pressing the PAGE DOWN key from 
Printer Class Definition: Screen 1. Function keys are the same Screen 1, 
except that there is no F9-Seq+.

Prompts

Print Attributes

(Display only.) The printer class.
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Description

A description for the print attribute escape sequence. SB+ is shipped with 
predefined escape sequence descriptions, which the Printer Manager uses 
when printing Report Writer reports. You can enter new attribute 
descriptions and sequences, and refer to them in processes or subroutines. 
The on-sequences are stored value-delimited in attribute 3 and the off-
sequences are stored value-delimited in attribute 4 of the COMMON variable 
PRINT.DEFN.

On Sequence

An escape sequence to select the attribute for the printer. Check the manual 
for your printer to find the correct sequence.

Off Sequence

An escape sequence to deselect the attribute for the printer. Check the manual 
for your printer to find the correct sequence.
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Printer Class Definition: Screen 1 – UniVerse

Process /PRINTER.CLASS

This screen is accessed by selecting the Admin > Printers and Terminals > 
Printer Management > Printer Class Definition.

The printer class specifies the table of graphic, color, and other miscellaneous 
escape sequences used by a family or class of printers. Additionally, the 
stationery types for this class are specified in this screen.
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For example, you may define the printer class EPSON.CLASS to contain the 
sequences for the Epson family of dot matrix printers. You can associate this 
printer class with any physical printer whose current device is an Epson dot 
matrix printer (or any one of the many printers that have an emulation for 
this printer). You can switch the emulating printer to the Epson emulation by 
entering the switching sequence at the Start Sequence prompt in the 
Physical Printer Definition screen.

You can associate an unlimited number of stationery types with a printer 
class. For each stationery type, you can define margins, auto-spooler 
formatting, interjob page advance, banner print state, Report Writer form 
feed behavior, and stationery type-specific set, reset, and page orientation 
sequences for printers requiring these sequences (such as laser printers).

The printer class, physical printer, and stationery type definitions are used to 
create the PRINT.DEFN COMMON variable, and associated run-time items in 
DMSECURITY. PRINT.DEFN are used in conjunction with the Printer Manager 
throughout SB+.

Function Keys

F2 - Save

Saves the printer class definition. If the printer class edited is the current 
printer class in PRINT.DEFN, the PRINT.DEFN is automatically updated.

F4 - Del

Deletes the printer class definition. If the definition is in use, deletion is 
prevented. The class DEFAULT.CLASS cannot be deleted.

F5 - Color

If the Color prompt is set to Y, the Printer Class Colors screen is displayed. 
This screen allows you to define foreground and background colors for a 
color printer. At present, the Printer Manager does not support color 
printing; however, the table is stored in PRINT.DEFN, and can be referenced in 
reports or user subroutines. For further information, see Appendix B, 
“Printer Management.”
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F8 - Stationery

Allows you to maintain stationery type definitions. For further information, 
see Appendix B, “Printer Management.”

F9 - Seq+

The Additional Print Sequences screen allows you to define additional 
escape sequences for physical printers and stationery types, in the same 
manner as the Additional Terminal Sequences in Terminal Definitions. SB+ 
does not use these sequences, but they are available for user subroutines. 
Physical printer sequences can be accessed in PRINT.DEFN<25,x>, and 
stationery type sequences in PRINT.DEFN<26,x>, where x is the value number 
based on the order of entry in the screen. For further information, see 
Appendix B, “Printer Management.”

F10 - Action

Displays the action bar:

Prompts

Printer Class

The name of an existing printer class to edit, or a new printer class definition.

Description

A meaningful description; for example, Epson LQ Printers.

Description (graphics)

Displays the description of the character displayed in Graphics mode.

Option Description

Print Prints a detailed Printer Class Definition report. Output can 
be redirected.

Copy Copies printer class definitions.

Help Displays a menu of help options.

Printer Class Definition Action Bar 
4-83 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\4Admin.fm
Characters

Characters can be entered either as the printable character (where the 
character is printable) or as the decimal ASCII equivalent of the character, 
enclosed in parentheses.

Graphics Mode On

An escape sequence to turn on graphics mode for the printer. To obtain the 
correct sequence, check your printer documentation.

Graphics Mode Off

An escape sequence to switch off graphics mode for the printer. To obtain the 
correct sequence, check your printer documentation.

Stationery Type

A stationery type from the defined stationery type list. A stationery type can 
be associated with as many printer classes as desired, but you can specify it 
only once within the same printer class.

TM

The number of blank lines to be printed at the top of a page before the text is 
printed. The default value is 3. If you do not enter a value, the default is used.

BM

The number of blank lines that will be printed at the bottom of a page after 
the text is printed. The default value is 3. If you do not enter a value, the 
default is used.

Fmt

If you want the UniVerse spooler to format the printed output automatically, 
enter Y. If the application is to control all formatting and pagination, enter N.

Ban

If you want a banner to be printed before each job, enter Y. If not, enter N. If 
Y, you will be prompted for a banner name.
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IJA

If you want to suppress the eject between each completed print job, enter Y. 
If not, enter N.

FF

If the Report Writer should send a form feed to advance to the next page of a 
job, enter Y. If not, enter N.

Set

An escape sequence to switch the printer to the stationery type setting. This 
is usually required for memory mapped printers such as laser or inkjet 
devices. To obtain the correct sequence, check your printer documentation. 
You can enter the characters either as the printable character (if the character 
is printable) or as the decimal ASCII equivalent of the character, enclosed in 
parentheses.

Reset

An escape sequence to reset the printer's stationery type setting. To obtain the 
correct sequence, check your printer documentation.

Orient

An escape sequence to set the printer's Page Orientation mode. To obtain the 
correct sequence, check your printer documentation.

Color

To allow color printer escape sequences to be defined, enter Y.

Standard Columns

Where a printer class has no stationery type defined (which is a valid 
condition), the value entered at this prompt is used to set the page width for 
printing.
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Rows

Where a printer class has no stationery type defined (which is a valid 
condition), the value entered at this prompt is used to set the page depth for 
printing.

Condensed Columns

If you enter a value at this prompt, the Report Writer uses the value for its 
condensed mode width instead of the automatic calculation.

SB+ does not otherwise use this parameter, but it is available for user 
processes. The parameter is located in the common variable 
PRINT.DEFN<5,4>.

Rows

SB+ does not otherwise use this parameter, but it is available for user 
processes. The parameter is located in the common variable 
PRINT.DEFN<5,5>.
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Printer Class Definition: Screen 2 – UniVerse

This page is accessed by pressing the PAGE DOWN key from Printer Class 
Definition: Screen 1. Function keys are the same as those on Screen 1, except 
that there is no F9-Seq+ function key. 

Prompts

Print Attributes

(Display only.) The printer class.
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Description

A description for the print attribute escape sequence. SB+ is shipped with 
predefined escape sequence descriptions, which the Printer Manager uses 
when printing Report Writer reports. You can enter new attribute 
descriptions and sequences, and refer to them in processes or subroutines. 
The on-sequences are stored value-delimited in attribute 3 and the off-
sequences are stored value-delimited in attribute 4 of the COMMON variable 
PRINT.DEFN.

On Sequence

An escape sequence to select the attribute for the printer. Check your printer's 
manual to ascertain the correct sequence. The characters can be entered either 
as the printable character (where the character is printable) or as the decimal 
ASCII equivalent of the character, enclosed in parentheses.

Off Sequence

An escape sequence to deselect the attribute for the printer. To obtain the 
correct sequence, check your printer documentation.
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Maintain Printers (UDT:Print) – UniData

Process /LISTPTRS

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Maintain Printers or by pressing the F9 key in the 
Maintain Spooled Reports screen. Use it to start and stop all printers, and to 
modify parameters for starting the printer as entered in the physical printer 
definition.

To start a printer

1. On the current cursor line, enter the physical printer name required. 
The current location will be displayed, if defined.

2. Modify the UNIX path if required.

3. Enter a form name. The form name should be one of the names 
associated with a stationery type associated with the physical 
printer. You can enter any form name; however, a warning is 
displayed if the form name is not associated with the physical 
printer.
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If you want to modify the default printer characteristics for the current 
physical printer, move back to the line containing the required printer, and 
press the F7 key. The Modify Print Parameters screen allows you to modify 
these parameters. The screen displayed depends on the device type specified 
in the physical printer definition used to start the printer.

To stop a printer, move the cursor to the line listing the printer you want to 
stop, and delete the line using the line delete key.

You can enter as many printers to start, or remove as many printers as 
required. To start and/or stop printers, press the F2 key. When the changes 
are performed, the screen will be redisplayed, allowing you to check the 
result of your action.

You can only start and stop printers or modify the parameters and the current 
form if you are logged on as superuser. Otherwise, you can view all printer 
information, but you cannot modify it.

Function Keys

F2 - Accept

Accepts the screen parameters and performs any changes made to the screen.

F5 - Start Printer

This function key attempts to restart a stopped printer. Attempting to restart 
from another state, such as error or offline, can possibly result in a printer 
being restarted.

F6 - Stop Printer

This function key attempts to stop a printer. Attempting to stop from other 
than the idle state, such as error, offline or printing, may or may not result in 
a printer being stopped.

F7 - Mod Pr Params

Displays a screen depending on the device type of the physical printer used 
to start the current printer. The defaults entered in the Physical Printer 
Definition > Default Printer Characteristics screen can be amended here. 
See “Modify Print Parameters F7 (UDT:Print)” on page 4-92.
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Only users who are logged on as a superuser can amend details in these 
screens. Other users can access this screen on a display-only basis.

F9 - Pr Jobs

Displays the Maintain Spooled Reports screen.

Prompts

Printer Name

A physical printer name from the set of defined physical printers.

Location

(Display only.) The location for the physical printer entered if it has been 
defined.

Path/Type

This corresponds to the Unix Device Name field in the physical printer 
record. The default from the physical printer record is displayed, and can be 
amended if required. The path must be a valid path to a UNIX device. If the 
device name begins with a / character, you must enter a \ character preceding 
the name. 

Form

A form name to start the printer with. This can be any form name, but should 
be one of the form names associated with the stationery types entered in the 
physical printer definition. You will be warned if the entered form name is 
not one of these. The F3 key provides a list from the physical printer 
definition. The default is the value entered in either the Serial Printer 
Characteristics or the Parallel Printer Characteristics screens in the Physical 
Printer Definition screen, or the form entered for the first stationery in the 
physical printer definition for other device types. For printers already 
started, the current form name will be shown.

This field can be amended by any user, but will only have effect if the user is 
logged on as superuser.
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Status

(Display only.) The current status of a printer in the UDT:Print system. The 
initial status is Unknown. Other statuses are Halted, Idle, Offline, Printing 
and Error.

Modify Print Parameters F7 (UDT:Print)

The Modify Printer Parameters screens are displayed by pressing the F7 key 
from the Maintain Printers screen. 

The screen displayed depends on the device type specified at the Device 
Type prompt in the physical printer definition for the printer on the current 
line:

These screens allow the default characteristics defined for the printer in the 
physical printer definition to be modified as required. These parameters can 
be changed at any time as required.

You must be logged on as superuser to be able to change any of these 
parameters.

The Modify Print Parameters screens are as follows:

Value Description

S Serial printer.

P Parallel printer.

T Terminal server program.

N Non-UDT:Print printer on a network node.

U UDT:Print printer on a network node.

Device Types 
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Serial Printer Characteristics (S)

This screen is accessed by entering S at the Device Type prompt in the 
physical printer definition and pressing the F7 key in the Maintain Printers 
screen.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Port Setup Command

The name of a UNIX program used to initialize the serial device entered at 
the Unix Device Name prompt, if required.

Filter Program

The name of a UNIX program that will filter the output from the UDT:Print 
spooler. An example of this is a Postscript filter program.

Flow

The method of flow control for this printer.
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Baud Rate

The speed at which the system communicates with the printer.

Parity

The type of error checking the system is to use when communicating with the 
printer.

Word Lgth

The number of bits that comprise one word of data for this printer.

Open Timeout

The length of time allowed for attempting to open the printer device before 
timing out.

Off Timeout

The length of time allowed for attempting to establish an online connection 
to the printer device before timing out.

Buffer Size

The printer buffer size in bytes.

Parallel Printer Characteristics (P)

This screen is accessed by entering P at the Device Type prompt in the 
physical printer definition and pressing the F7 key in the Maintain Printers 
screen.
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Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Filter Program

The name of a UNIX program to filter the output from the UDT:Print spooler. 
An example is a Postscript filter program.

Open Timeout

The length of time allowed for attempting to open the printer device before 
timing out.

Offline Timeout

The length of time allowed for attempting to establish an online connection 
to the printer device before timing out.

Buffer Size

The printer buffer size in bytes.

Terminal Server Printer Characteristics (T)

This screen is accessed by entering T at the Device Type prompt in the 
physical printer definition and pressing the F7 key in the Maintain Printers 
screen.
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Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Server Transfer Command

The full pathname of a UNIX Terminal Server program that will print the 
current job to a printer attached to a Terminal Server on the UNIX host.

Network Printer Characteristics (N)

This screen is accessed by entering N at the Device Type prompt in the 
physical printer definition and pressing the F7 key in the Maintain Printers 
screen.

This allows jobs to be printed to any printer on a remote machine defined 
using the UNIX printer administration tools.

Function Keys

F2 - Accept

Accepts the screen parameters.
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Prompts

Node Name

The name of the node or its Internet address (for example, 192.0.0.10). If a 
name is entered, the name must exist in your local /etc/hosts file. The F3 key 
displays the /etc/hosts file.

Local Remote Shell Command

The remote shell command that resides on your local machine. This is usually 
/bin/rsh or /bin/remsh.

Remote Print Command

The command to print jobs to the spooler on the remote machine. This is 
usually lp or lpr.

Remote User Id

The user ID to be used to log on to the remote machine. User ID spooler is the 
default.

Remote USAM:Print Printer (U)

This screen is accessed by entering U at the Device Type prompt in the 
physical printer definition and pressing the F7 key in the Maintain Printers 
screen.

It allows jobs to be printed to printers on a remote machine defined using 
UDT:Print on that machine.
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Function Keys

F2 - Accept

Accepts the screen parameters.

Prompts

Node Name

The name of the node or its Internet address (for example, 192.0.0.10). If a 
name is entered, the name must exist in your local /etc/hosts file. The F3 key 
displays the /etc/hosts file.

Alias

An alias used for the node if specified.

Auto Start

Options are:

Value Description

Y Invokes UDT:Print on the remote machine if it is not 
already started, and tests for the requested printer's 
existence.

N UDT:Print must be started on the remote machine before 
the test for the requested printer's existence can be carried 
out.

Auto Start Options 
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Maintain Printers – UniVerse

Process /LISTPTRS

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Maintain Printers or by pressing the F9 key in the 
Maintain Spooled Reports screen. Use it to start and stop all printers, and to 
modify parameters for starting the printer as entered in the physical printer 
definition.

To start a printer:

1. On the current cursor line, enter the physical printer name. The 
current location is displayed, if defined.

2. Modify the UNIX path if required.

3. Enter a form name. The form name should be one of the names 
associated with a stationery type associated with the physical 
printer. You can enter any form name; however, a warning is 
displayed if the form name is not associated with the physical 
printer.
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If you want to modify the default printer characteristics for the current 
physical printer, move back to the line containing the required printer and 
press the F7 key. The Modify Print Parameters screen allows you to modify 
these parameters.

If you want to stop a printer, place the cursor on the line containing the 
printer you want to stop and delete the line, using the line delete key.

You can enter as many printers to start as required, or remove as many 
printers as required. To start and/or stop the printers, press the F2 key. When 
the changes are performed, the screen reappears, allowing you to check the 
result of your action.

You can only start and stop printers, or modify the parameters and the 
current form if you are logged on as superuser. Otherwise, you can view all 
printer information, but you cannot modify it.

Function Keys

F2 - Accept

Accepts the screen parameters and performs any changes made to the screen.

F5 - Toggle Pr

This option toggles the Print Enable flag on and off for the current printer. 
This is the same as the UNIX-level UniVerse command:

usa -p printername +/-n

Only users who are logged on as superuser or are members of a print group 
that contains the printer on the cursor line can change this flag.

F6 - Toggle Qu

This option toggles the Queue Enable flag on and off for the current printer. 
This is the same as the UNIX-level UniVerse command:

usa -p printername +|-q

Only users who are logged on as superuser or are members of a print group 
that contains the printer on the cursor line can change this flag.
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F7 - Mod Pr Params

Displays the Modify Print Parameters screen. This is where defaults entered 
in the Physical Printer Definition > Default Printer Characteristics screen 
can be amended. For further information, see “Modify Print Parameters F7” 
on page 4-102.

Only users who are logged on as superuser can amend details in this screen. 
Other users can access this screen on a display-only basis.

F8 - Pr Group

Displays the Maintain Printer Groups screen, where the UniVerse file 
print_group can be maintained. For further information on print groups, see 
your UniVerse documentation.

Only users who are logged on as superuser can access or amend details in 
this screen. For further information, see “Maintain Printer Groups F8” on 
page 4-105.

F9 - Pr Jobs

Displays the Maintain Spooled Reports screen. For details, see “Maintain 
Spooled Reports – UniVerse” on page 4-120.

Prompts

Printer Name

A physical printer name from the set of defined physical printers.

Location

(Display only.) Shows the location for the physical printer entered if it has 
been defined.

Printer Path

This corresponds to the Unix Device Name field in the physical printer 
record. The default from the physical printer record is displayed, and can be 
changed if required. The pathname must be preceded with a \ character. The 
path must be a valid path to a UNIX device.
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Form Name

A form name with which to start the printer. This can be any form name, but 
should be one of the form names associated with the stationery types entered 
in the physical printer definition. If the entered form name is not one of these, 
a warning is issued. The F3 key provides a list from the physical printer 
definition. The default is the value entered for the first stationery in the 
physical printer definition. For started printers, the current form name is 
shown.

This field can be amended by a member of a print group containing the 
printer on the current cursor line, or by a user logged on as superuser. The 
field can be initialized (for example, when starting a printer) only by a user 
logged on as superuser.

Modify Print Parameters F7

This screen is accessed by pressing the F7 key in the Maintain Printers screen. 
It allows you to modify the default characteristics defined for the printer in 
the physical printer definition. These parameters can be changed at any time.

Many of the parameters in this screen refer to serial printers. Any value 
entered for those parameters, for example, Baud or Parity, is ignored for 
parallel devices.

You must be logged on as superuser to change any of these parameters. SB+ 
assumes the standard UniVerse setup: sp.config and the &DEVICE& file are 
created with root-only permissions, and SB+ does not attempt to determine 
whether a particular user has read/write permissions in a particular case. All 
access decisions are based on user status.
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Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Lock File Path(s) 1 & 2

The full UNIX pathname of the file that will be used when sharing this 
printer with other UNIX processes. See the UniVerse Spooler Administration 
section in your UniVerse System Administration manual. The pathname must 
be preceded with a \ character. You can enter up to two paths.

Driver Path

The full UNIX pathname to the shell script used by UniVerse as the printer 
device driver. The pathname must be preceded with a \ character.

Flow

The method of flow control for this printer.

Baud

The speed at which the system communicates with the printer.

Parity

The type of error checking that will be used by the system when 
communicating with the printer.

Print

If printing is to be enabled on this printer when the spooler is initialized 
(which will occur when the printer is started in Maintain Printers), enter Y. If 
not, enter N.
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Queue

If queuing to this printer is to be enabled when the spooler is initialized 
(which will occur when the printer is started in Maintain Printers), enter Y. If 
not, enter N.

CR Cnv

The UniVerse term for the type of conversion carried out on a carriage return 
on output. Null means no conversion.

Tabs

If embedded tabs are to be expanded to 8 spaces in the output, enter Y. If not, 
enter N.

FF

The form feed delay factor to be used. One of three values can be entered. For 
further information, see your UniVerse documentation or press the F3 key.

LF

The line feed delay factor to be used. One of nine values can be entered. For 
further information, see your UniVerse documentation or press the F3 key.

Wrdln

The number of bits that comprise one word of data for this printer.

Other Opts

Other UniVerse spooler options, such as PTERM settings. For further 
information, see your UniVerse documentation.
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Maintain Printer Groups F8

This screen is accessed by pressing the F8 key in the Maintain Printers screen. 
It allows a user who is logged on as superuser to maintain the print_group 
item in the UniVerse spooler directory from within SB+. No other users can 
access this screen. For further information, see your UniVerse 
documentation.

Function Key

F2 - Accept

Accepts the details entered into this screen.

Prompts

Printer Group

The printer group name. This can be any name that the system administrator 
considers valid.
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Member Users

A comma-delimited list of users in this group; for example, susan, fred.

Note: These are the UNIX logon names, not SB+ user IDs.

Group Printers

The list of printers in this group, comma-delimited; for example, 
ACC1,AUD2 or all (lowercase). For a list of physical printer definitions, press 
the F3 key.

Assign Printer to a Report

Process /PTR.TO.REPORT

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Assign Printer to a Report. It allows you to specify 
print parameters for Report Writer and Query reports that override the 
standard print defaults in the Printer Selection screen. These can be 
modified, subject to location restrictions, if you have access to the Printer 
Selection screen. If not, the print parameters passed are used by the Printer 
Manager to set up printing for the report.
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You can also assign printers to a report using the Additional Report 
Parameters screen from the PD.R (Report Writer) and PD.E (Query) process 
definition screens:

This screen and the Assign Printer to a Report screen are functionally the 
same, except that the Assign Printer to a Report screen prompts for a Query 
or Report Writer process definition, whereas the Additional Report 
Parameters screen is called from PD.E/PD.R with the process definition 
available.

Function Keys

F2 - Accept

Accepts the screen parameters.

F4 - Delete Printer Parameters

Clears all printing options for the report process definition.
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F5 - Aux Parameters

The auxiliary output parameters can be set specifically for individual reports 
using the new PD.RD.ADDIT.AUX process. This process is accessed from the 
PD.R screen > F9 – Additional Report Parameters > F6 – Aux Parameters:

The parameters entered here overwrite any other option set using other Print 
Default screens and processes. The value of the Disp Aux Sel Screen flag in 
this case can be one of the following:

Prompts

Process Name

(Assign Printer to a Report only.) The name of a Report Writer or Query 
process definition.

Description

(Display only. Assign Printer to a Report only.) Displays the process 
definition description.

Value Description

A Always display SB+ Print Selection screen

N Never display SB+ Print Selection screen

W Display Windows Print Setup screen only

Auto Start Options 
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Phys. Printer Name

A physical printer name. You can enter an expression in parentheses to be 
evaluated at run time.

Stationery Type

The stationery type for this report. The stationery type must be associated 
with the physical printer specified above. If a physical printer is not specified, 
you can select a stationery type from the current default physical printer. 
Because a stationery type selected in this way cannot be valid when the 
report is run, a warning message is displayed. You can enter an expression in 
parentheses to be evaluated at run time.

Spooler Options

Use the F3 key to display a list of available options, or consult your OE 
documentation. You can enter an expression in parentheses to be evaluated 
at run time.

No. of Copies

The number of copies for this report (1 to 125). You can enter an expression in 
parentheses to be evaluated at run time.

Report Type

A report type for this report (The F3 key provides a list of report types). See 
“Maintain Report Types” on page 4-115 later in this chapter for more 
information on report types.
4-109 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\4Admin.fm
Disp Print Sel Screen

Forces the display mode for the Printer Selection screen for the current 
report process. Options are:

Leave this field blank if you want to use the user’s display flag setting.

Form Feeds At Start

The number of form feeds to be sent to the printer before the report is printed.

Form Feeds At End

The number of form feeds to be sent to the printer at the end of the report.

All fields in PD.R and all but the first two fields in PTR.TO.REPORT are 
optional. Partial completion of the first four printer-related fields results in a 
partial replacement of the Printer Selection screen parameters. The 
displayed parameters will contain the standard default parameters where the 
equivalent report parameter is blank.

Value Description

A Forces the Printer Selection screen to be displayed, 
irrespective of the current user’s display flag setting in 
Security > User Security Setup. (See “User Security Setup” 
on page 3-20.)

N Prevents the Printer Selection screen from being 
displayed, irrespective of the current user’s display flag 
setting in Security > User Security Setup. 

Display Mode Options 
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Maintain Stationery Types

Process /STATIONERY.DEFN

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Maintain Stationery Types. It allows you to define 
the standard columns and rows for the type of stationery you specify. You can 
define any type of stationery.

The stationery type is an entity independent of the printer class it may be 
associated with. For example, the A4 stationery type can be associated with 
any number of classes without the need for redefinition. Class specific printer 
sequences that configure the printer to be able to print on this stationery are 
defined separately for each class the stationery type is associated with.

SB+ uses the stationery type definition, with physical printer and printer 
class definitions, to create the PRINT.DEFN COMMON variable, and 
associated run-time records in DMSECURITY.

PRINT.DEFN is used in conjunction with the Printer Manager throughout SB+ 
generally, and can be used within user subroutines.

Function Keys

F2 - Save

Saves the stationery type definition.
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F4 - Del

Deletes the stationery type definition.

Prompts

Stationery Type

The name of an existing stationery type to edit, or a suitable name to define 
a new stationery type.

Description

A meaningful description. This is a multivalued field.

Standard Columns

Sets the page width for printing.

Standard Rows

Sets the page depth for printing.
  4-112



E:\SVN\SB55\doc_set\sbplus\administration\4Admin.fm
5/13/14 
Maintain Locations

Process /LOCATION.DEFN

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Maintain Locations. It allows you to define a 
location, and a list of physical printers grouped in that location. A location 
does not have to contain physical printers. When a physical printer is added 
to a particular location, it cannot be assigned to another location without 
being moved from its current location using the F5 key.

You can use locations to limit access to printers by users in a security group. 
Use the F8 key in the Group Security Setup screen to access the Report 
Locations screen, which allows you to specify available locations for a group. 
If the location you specify does not exist, and you want to create it, the 
Location Definition screen is displayed. 

At any given level, a group has available only those locations entered for its 
parent group. An empty location list in Group Security means that physical 
printers in all locations available to the parent of the current group can be 
specified. If the group and all parent groups have an empty list, all locations 
are available to the group.
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Function Keys

F2 - Save

Saves the location definition.

F4 - Del

Deletes the location definition.

F5 - Move Printer

Allows you to move physical printers. Pressing the F5 key at the Physical 
Printers prompt requests the location to move to. After copied to the new 
location, the physical printer is removed from the current location.

Prompts

Location

The name of an existing location to edit, or a suitable name to define a new 
location.

Description

A meaningful description.

Physical Printers

The physical printers entered here are grouped in the location for security 
checking. A physical printer can only be in one location at a time.
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Maintain Report Types

Process /REPORT.TYPE.DEFN

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Maintain Report Types. Report types provide a 
method of matching Query and Report Writer reports to printers. A single 
valid report type code can be associated with a report, and a list of valid codes 
can be associated with a physical printer. You can use any code for any 
physical printer.

If a valid code is present in a report being printed, and a list of valid codes is 
present for the physical printer being selected, an attempt is made to locate 
the report's code in the physical printer's list. If not found, the report cannot 
be printed using the selected printer. Printing to the selected printer is 
allowed if either the report has no valid code, or the physical printer has no 
list.

A central list of valid report types is stored in the REPORT.TYPES record in 
the DMSYSDEFN file. This screen maintains a multivalued list of report type 
codes. Codes can be in any format, but must be unique. You can optionally 
enter a description for each code. This table of report types is used in all 
systems across all accounts.
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Developers should note that, because the report types table is global, you will 
need to consider uniqueness when creating report types for your application. 
When the application is installed at a customer site, it is necessary to 
manually update the report type table during installation.

Function Key

F2 - Save

Saves the report type definition.

Prompts

Report Type

A unique character string to define a report type.

Description

A meaningful description for the report type. This is used in intuitive help.
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Maintain Spooled Reports (UDT:Print) – UniData

Process /LISTJOBS

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Maintain Spooled Reports. It allows you to 
view/maintain print jobs currently held in the spool queue. There are 
facilities to delete spooled entries or to alter the printing parameters such as 
the number of copies and whether the report is to be held in the spooler even 
after it has been printed.

Function Keys

F2 - Accept

Accepts the screen parameters and performs any changes made to the screen.
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F5 - View Job

Displays the current job on the terminal (the line being edited).

F9 - Printers

Invokes the Maintain Printers screen.

Prompts

Job

The entry number of the print job in the spooler.

User

(Display only.) The UNIX user ID who created this print job.

Description

(Display only.) The UniData file name for this print job.

Printer

The name of the printer to which the print job is being sent.

Form

The form to which the print job is assigned.

Co

The number of copies specified for this print job.

St

The status of the print job; for example, H for Hold. See your OE manual.

Size

(Display only.) The size of the print job in bytes.
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%

(Display only.) Percentage of print job actually printed, if job is printing now.

Act Fm

(Display only.) Active form name. Options are:

Value Description

Y Use this setting if the form for this print job matches the 
active form on the printer.

N Use this setting if the form for this print job does not match 
the active form on the printer.

Active Form Options 
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Maintain Spooled Reports – UniVerse

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Maintain Spooled Reports. It allows you to 
view/maintain print jobs currently held in the spool queue. You can use this 
screen to delete spooled entries or to alter the printing parameters, such as 
the number of copies and whether the report is to be held in the spooler even 
after it has been printed.

Function Keys

F2 - Accept

Accepts the screen parameters and performs any changes made to the screen.

F5 - View Job

Displays the current job on the terminal (the line being edited).
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F9 - Printers

Invokes the Maintain Printers screen.

Prompts

Printer Name

The name of the printer to which the print job is being sent.

Form Name

The form to which the print job is assigned.

Unix User

(Display only.) The user who created this print job. 

Entry

(Display only.) The entry number of the print job in the spooler.

Co

The number of copies specified for this print job.

Status

The option to determine the action to be taken on this print job. For further 
information, see your OE manual.

Size

(Display only.) The size of the print job in bytes.

Active Form

(Display only.) Y indicates that the form for this print job matches the active 
form on the printer; N indicates that the form for this print job does not match 
the active form on the printer.
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Kill Current Job

Process /PTR.KILL0

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Kill Current Job in UniVerse or in UniData with 
UDT:Print. It allows you to stop printing the currently spooled job. You are 
prompted for the job number.

Initialize Spooler – UniData

Process /PTR.INIT

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Initialize Spooler. It allows you to reinitialize (clear 
the spooler) and return to normal operation. Use if corruption has occurred 
in the spooler. Reports may be lost.

Prompts

Kill All Spooler Entries (Y/N)

Options are:

Value Description

Y Deletes all entries in the spooler queue. These jobs are lost 
and cannot be recovered.

N Leaves jobs in the spooler queue.

Spooler Options 
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Enter ‘C’ to Confirm

Options are:

Initialize Spooler – UniVerse

This screen is accessed by selecting Admin > Printers and Terminals > 
Printer Management > Initialize Spooler. You must be logged on as 
superuser to access this screen.

Prompts

Kill All Spooler Entries (Y/N)

To delete all spooled print jobs, enter Y. These jobs cannot be recovered. To 
retain all spooled print jobs, enter N.

Log Activity And Errors (Y/N)

To set up spooler logging, enter Y. The Enter Log Parameters screen appears. 
For instructions, see “Enter Log Parameters” below. For no spooler logging, 
enter N.

Value Description

C Confirms reinitialization of the spooler with the option 
determined at the previous prompt. 

N Default. Returns to the previous menu, with no action 
taken.

Confirmation Options 
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Spool Directory

A spooler directory name. If you leave this prompt blank, /usr/spool/uv is 
assumed. The pathname should be preceded with a \ character.

Enter ‘C’ to Confirm

To perform the spooler initialization as defined in the previous prompts, 
enter C. To cancel and exit the screen without taking action, enter N.

Enter Log Parameters

This screen is accessed by entering Y at the Log Activity and Errors prompt 
in the Initialize Spooler screen. It allows you to define error and/or activity 
logging of the spooler. You can select default error and activity logging and 
specify both or either separately.

Function Key

F2 - Save

Saves the log parameters.
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Prompts

Use Default Activity And Error Logs (Y/N)

To use default activity and error log files in the spooler directory, and turn on 
activity and error logging, enter Y. To specify logging individually, enter N.

Use Activity Log (Y/N)

To turn on activity logging using the log file specified in the next field, enter 
Y. To skip activity logging, enter N.

Activity Log Path

A valid UNIX path to the activity log file you want to use. The pathname 
should be preceded with a \ character.

Use Error Log (Y/N)

To turn on error logging using the log file specified in the next field, enter Y. 
To skip error logging, enter N.

Error Log Path

A valid UNIX path to the error log file you want to use. The pathname should 
be preceded with a \ character.

If all options are set to N in this screen, the Log Activity And Errors field in 
the Initialize Spooler screen is set to N.
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Terminal Definitions

The Terminal Definitions option allows you to define the settings for 
terminals on your system.
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Terminal Definition: General Screen

Process /TERM.DEFN

This screen is accessed by selecting Admin > Printers and Terminals > 
Terminal Definitions. It allows you to define and maintain terminal 
definitions for use with SB+. Many common terminal definitions are 
supplied with SB+ and can be amended.

The Terminal Definition screen consists of three pages, described below. You 
can access the other pages of the screen by pressing the PAGE DOWN key. 
Function keys for the three tabs are described below.
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You can change your current terminal definition on-the-fly through the 
CHANGE.TERMINAL process. The new terminal definition is loaded into the 
COMMON variable TERM.DEFN, and any OE-related terminal commands 
are performed. For example, at logon you may have entered the incorrect 
terminal type. If you are still able to enter text, running this process corrects 
the terminal definition.

Note: When changing terminal definitions, previously stacked screens may not be 
redisplayed correctly because they are stored internally with embedded cursor/video 
attribute sequences that may no longer be valid. Exiting to the OE shell and then re-
entering SB+ via the MM command corrects any screen problems.

Function Keys

F2 - Save

Saves the current terminal definition.

F4 - Del

Deletes the current terminal definition.

F5 - Colors (if used from screen 1)

If the value of Support Color is set to Y, F5 displays the Terminal Colors 
screen. This allows you to define the colors to use for prompts, inputs, error 
messages, and other elements (only if your terminal supports color). For 
further information, see “Terminal Colors F5” on page 4-137.

GoTo MV (if used from screens 2 and 3)

Invokes the GOTO.MVLINE process. This allows you to move quickly around 
several pages of data by entering any of the following:

■ A line number, or

■ The letter P and a page number, or

■ Part of the text found under the Description or Edit Function 
headings.
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F6 - Cursor (if used from screens 1 and 2) 

Displays the Cursor Definition Parameters screen, which allows you to 
define cursor addressing specifically for the current terminal type. Use this 
feature only if you are experiencing problems with the default cursor addressing. For 
further information, see “Cursor Definition Parameters F6” on page 4-140.

F6 - Pointer (if used from screen 3) 

Displays the Pointer Device Parameters screen, which allows you to define 
the pointer device if the pointer device does not work correctly or if you are 
using a nonstandard mouse or touch screen device. For further information, 
see “Pointer Device Parameters F6” on page 4-143.

F7 - Keys+

Allows you to enter an existing edit key function number for which you want 
to specify an additional or alternative key definition. For further information, 
see “Additional/Alternative Keys F7” on page 4-146.

F8 - Download

Specifies the character sequence or processes to be downloaded to the 
terminal when logging on. This ensures that the keyboard will work as 
specified in the definition. For further information, see “Download Character 
Sequence F8” on page 4-148.

F9 - Seq+

Allows additional terminal characteristics to be setup. These are held in the 
COMMON variable TERM.DEFN<19>. For further information, see 
“Additional Terminal Sequences F9” on page 4-150.
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F10 - Action

Displays the action bar:

Prompts

Terminal Id

An ID or name for the terminal definition. SB+ provides a number of 
commonly used definitions. Every terminal type must have a terminal 
definition specifying edit keys and graphics characters.

DEFAULT.TERM works for all terminal types. This definition uses standard 
keys and simple graphics characters, and is used if no terminal ID is specified 
for a port in the Terminal Configuration screen or the user definition. This 
terminal definition allows you to use SB+ before setting up a specific 
definition for your terminal type.

We recommend setting up a terminal definition that is specific to your 
terminal type so you can take advantage of your own keyboard layout while 
using SB+. This definition can then be specified for your port in the Port 
Configuration screen, described later.

Description

A description for the terminal ID specified.

OE Term Type

The operating environment terminal type associated with this definition. 
This is used only for correct cursor addressing, and for clear screen, line, and 
end-of-screen functions.

Action Description

Print Prints selected terminal definitions.

Copy Copies a terminal definition to another name.

Help Displays a menu of additional help options.

Terminal Definition Action Bar 
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GUI Mode Enabled

Options are:

Support Color (Y/N)

Options are:

Standard Columns

The number of columns displayed by the terminal being defined. See your 
terminal documentation for details. This is usually 80.

Standard Rows

The number of rows the terminal displays. See your terminal documentation 
for details. This is usually 24.

Condensed Columns

The number of columns the terminal displays in condensed mode. See your 
terminal documentation for details. This is usually 132 when available.

Condensed Rows

The number of rows the terminal displays in condensed mode. See your 
terminal documentation for details. This is usually 24, but may be 43.

Value Description

Y Enables GUI mode when using this terminal definition. 
This applies only to terminal emulators that support GUI 
mode.

N Disables GUI mode.

GUI Mode Options 

Value Description

Y The terminal you are defining supports color. After 
entering Y, you can press the F5 key to define the colors.

N The terminal you are defining is monochrome.

Color Options 
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Graphics Mode On

The character sequence sent to the terminal to turn on graphics mode, if 
supported. For control characters, enter the decimal ASCII value in 
parentheses. Graphics mode is used for drawing boxes and lines.

Many terminals are now able to draw box lines without switching to graphics 
mode. In this case, leave this prompt blank. See your terminal documentation 
for details.

Graphics Mode Off

The character sequence sent to the terminal to turn off graphics mode, if 
supported. See your terminal documentation for details.

GRAPHIC BOX CHARACTERS

Description

(Display only.) Description for the graphics character to be defined at the next 
prompt. 

Characters

The character sent to the terminal to display the graphics character defined 
at the Description prompt. See your terminal documentation for details. SB+ 
uses these characters when drawing windows and other graphic displays. If 
your terminal has a graphics character set (the ability to draw straight lines 
and corners), enter these characters. Enter the decimal ASCII value, enclosed 
in parentheses, of the character to be used. For example, a horizontal 
character could be (113), (119), or (205).

Alternatively, if graphics mode is not supported, a normal display character 
to be used instead can be specified. For example, a vertical character might 
be |.

You are prompted for both single- and double line characters. When defining 
windows in your application, you can specify the frame type (if you want 
single or double lines, or no lines).
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Terminal Definition: Video Characteristics Screen

This screen is accessed by pressing the PAGE DOWN key in the Terminal 
Definition: General screen. Function keys are as described for the Terminal 
Definition: General screen.

Prompts

Terminal Id

(Display only.) The ID or name for the terminal definition.
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Hidden Attributes

Options are:

Description

(Display only.) A description of the type of video characteristic for which a 
value must be entered at the next two prompts.

ON Sequence

The character sequence to turn on the effect described at the Description 
prompt. See your terminal documentation for details. This character 
sequence usually contains a mixture of control characters and normal 
characters. Enter control characters (such as ESC) by giving their decimal 
ASCII value in parentheses. For example, the half intensity on-sequence for 
the Wyse60 terminal is (27)Gp.

OFF Sequence

The character sequence to turn off the effect described at the Description 
prompt. See your terminal documentation for details. This character 
sequence usually contains a mixture of control characters and normal 
characters. Enter any control characters (such as ESC) by giving their decimal 
ASCII value in parentheses. For example, the half intensity off-sequence for 
Wyse60 is (27)GO.

Value Description

Y The terminal you are defining uses hidden video attributes 
that do not take up a character position. See your terminal 
documentation if you are unsure whether your terminal 
supports hidden video attributes.

N The terminal being defined does not use hidden video 
attributes.

Hidden Attributes Options 
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Terminal Definition: Edit/Function Keys Screen

This screen is accessed by pressing the PAGE DOWN key in the Terminal 
Definition: Video Characteristics screen. Function keys are as described for 
the Terminal Definition: General screen above.

Prompts

Terminal Id

(Display only.) The ID or name for the terminal definition.
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Edit Function

(Display only.) Describes the edit function for which a value must be entered 
at the next two prompts.

Decimal ASCII Val

The decimal ASCII values generated by the key you want to use for the edit 
function. To use the full-text editing facilities SB+ offers on all input prompts, 
you must assign a keyboard key (or keys) to each function.

If you are setting up the terminal definition for the terminal you are currently 
using and you do not know the value of the key you want to define, press any 
non-numeric key. You are then prompted to press the key you require. SB+ 
returns the value of the key.

Note: By default, only keys that return a lead-in character less than decimal 32 
(space) can be used as an edit key. Use the F7-Additional/Alternative Keys > 
Limit Value of Displayable Characters prompt to change this value if required.

Key Description

The description to be displayed as part of the help for available edit keys. 
This is used to describe the keyboard key used to carry out edit functions and 
is shown whenever you invoke the /KEYS process to see what keys are 
defined for your terminal.
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Terminal Colors F5

This screen is accessed by entering Y at the Support Color prompt and 
pressing the F5 key in the Terminal Definition: General page.

Note: These values apply to the color of character screens only. The color of GUI 
screens is determined by the appropriate GUI Default Set.

Function Key

F2 - Accept

Accepts the terminal color parameters.
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Prompts

Colors

(Display only.) The available colors. Each color has a number displayed 
beside it. Use these numbers for reference when defining the default color 
combinations for Deflt Menu and Deflt Screen.

Foreground

The character sequences for the appropriate foreground color.

Background

The character sequence for the appropriate background color.

Dealt Menu

The background, highlight letter, lowlight letter, select background, select 
foreground, and unavailable foreground color numbers as a default for 
menus. Separate numbers with commas; for example, 8, 6, 2, 2, 16,12.

Note: You can override these colors for any individual menu.

The F3 key provides a list of available colors.

Deflt Screen

The background, foreground, and prompt color numbers to be used as a 
default for screens. Separate numbers with commas.

Note: You can override these colors for any individual screen.

Help Colors

The background, highlight, and lowlight color numbers for help screens. 
Separate numbers with commas.

Std Back/Fore

The standard background and foreground colors to be used by SB+. Separate 
numbers with commas.
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Lookup B/F

The background, foreground, low intensity, select background, and select 
foreground color numbers to be used in the lookup windows. Separate 
numbers with commas.

Prompt B/F

The background and foreground numbers to be used in prompts on the 
prompt line. Separate numbers with commas.

Functkey B/F

The background and foreground color numbers to be used in displaying the 
function key status line. Separate numbers with commas.

Error B/F

The background, highlight text, lowlight text, select background, and select 
foreground color numbers to be used in error message display. Separate 
numbers with commas.

Dialog Box

The background, highlight text, lowlight text, select background, and select 
foreground color numbers to be used in dialog box display. Separate 
numbers with commas.
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Cursor Definition Parameters F6

This screen is accessed by pressing the F6 key in the Terminal Definition: 
General and Video Characteristics pages. If you are experiencing problems 
with default cursor addressing, use this screen to specifically define cursor 
addressing for the current terminal type.

The information in this screen is used by SB+ functions like ‘smart screen 
refresh’ to parse text and cursor directives from screen images. It does not 
affect the operation of the terminal device itself.

Function Key

F2 - Accept

Accepts the cursor definition parameters.
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Prompts

ANSI Mode (Y/N)

Options are:

Press F3 to generate the default information.

Leadin Sequence

The cursor lead-in sequence. For example, the ANSI lead-in sequence would 
be (27)[

Column First

Options are:

Col and Row Separator

The column and row separator if any; otherwise leave blank.

Terminating Sequence

The terminating character for the cursor sequence if any; otherwise leave 
blank. ASCII sequences usually have a terminating character.

Col Base Offset

A numeric offset value that is to be applied to the column value. Enter 0 for 
none.

Value Description

Y The terminal uses ANSI cursor address sequences.

N The terminal uses ASCII type sequences.

ANSI Mode Options 

Value Description

Y The column is sent first in the cursor address sequence.

N The row is sent first in the cursor address sequence.

Column/Row Options 
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Row Base Offset

A numeric offset value that is to be applied to the row value. Enter 0 for none.

Col Increments in BCD

Options are:

Row Increments in BCD

Options are:

Clear Screen & Home

The sequence that, when sent to the terminal, clears the screen and moves the 
cursor to the upper left corner.

Clear to End Of Line

The sequence that, when sent to the terminal, clears the line from the current 
cursor location to the end of the current screen line.

Clear To End Of Page

The sequence that, when sent to the terminal, clears the screen from the 
current cursor location to the end of the current screen page.

Value Description

Y The column value increments in Binary Coded Decimal 
(BCD) format.

N The column value does not increment in BCD format.

Column Increment Options 

Value Description

Y The row value increments in BCD format.

N The row value does not increment in BCD format.

Row Increment Options 
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Clear Screen to Pattern

The sequence that, when sent to the terminal, clears the screen to a 
background pattern.

Pointer Device Parameters F6

This screen is accessed by pressing the F6 key in the Terminal Definition: 
Edit/Function Keys page. If the pointer device does not work correctly or if 
you are using a nonstandard mouse or touch screen device, use this screen to 
define the pointer device.

Function Key

F2 - Accept

Accepts the pointer device parameters.
4-143 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\4Admin.fm
Prompts

Pointer Device Code

If you are using a pointer device other than the default mouse type, enter the   
code for the pointer device.

Type 1 allows use of a mouse device, which returns sequences in the standard 
mouse format.

Types 2 and 3 allow the use of high- and low-resolution touch screen devices.

Type 4 allows entry of a user-defined device. Enter Type 4 parameters at the 
following prompts:

Pointer Sequence Length

(Applicable to Type 4 only.) If the pointer sequence has a fixed length, enter 
the number of characters in the string returned by the device. If the pointer 
sequence has a variable length terminated by a carriage return, enter 0. 

Button Delimiter Character

(Applicable to Type 4 only.) The delimiter character surrounding the button 
number, if present. This is used for field extractions. Leave blank for the 
position,length extraction method.

X, Y Delimiter Character

(Applicable to Type 4 only.) The delimiter character used to delimit the X and 
Y values. This is used for field extractions. Leave blank for the position,length 
extraction method.

Button Field/Pos, Len

(Applicable to Type 4 only.) The field extraction position of the button value 
or if there is no delimiter, its position,length in a fixed-length string.

X value Field/Pos, Len

(Applicable to Type 4 only.) The field extraction position of the X coordinate 
or if there is no delimiter, its position,length in a fixed-length string.
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Y value Field/Pos, Len

(Applicable to Type 4 only.) The field extraction position of the Y coordinate 
or if there is no delimiter, its position,length in a fixed-length string.

ButtonBar Field/Pos, Len

(Applicable to Type 4 only.) The field extraction position of the ButtonBar 
value or if there is no delimiter, its position,length in a fixed length string.

X Conversion Code Method

(Applicable to Type 4 only.) The conversion code method to apply to the X 
coordinate.

Options are:

Y Conversion Code Method

(Applicable to Type 4 only.) Conversion code method to apply to the Y 
coordinate.

Options are:

Value Description

0 Value is decimal, no conversion. 

1 Hexadecimal to decimal. 

2 sequence value SEQ().

X Conversion Code Methods 

Value Description

0 Value is decimal, no conversion. 

1 Hexadecimal to decimal. 

2 Sequence value SEQ().

Y Conversion Code Methods 
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Additional/Alternative Keys F7

This screen is accessed by pressing the F7 key from any of the Terminal 
Definition pages.

Enter an existing edit key function number for which you want to specify an 
additional or alternative key definition. For example, the delete line function 
can be mapped to the SHIFT-DEL key, but some users may prefer other 
standards to which they are more accustomed, such as CTRL V.

Function Key

F2 - Accept

Accepts the additional/alternative key parameters.
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Prompts

Limit Value of Displayable Characters

The range of nonstandard edit keys is from CHAR(32) up to the value of this 
field, which is assumed to be 256 if blank. Enter a value here if any edit key 
lead-in sequences commence with a character greater than decimal 128 for 
the current terminal type.

For example, function key sequences on some terminals have a lead-in 
character of CHAR(155). In this case, set the limit to 155. If the limit is set too 
low, some graphic and/or foreign character sets cannot be entered from the 
keyboard.

Edit Key Function

The existing edit key function number for which you want to specify an 
additional or alternative key definition.

Decimal ASCII Val

The decimal ASCII values generated by the key you want to use for the edit 
function. To use the full-text editing facilities that SB+ offers on all input 
prompts, a keyboard key (or keys) must be assigned to each function.

If you are setting the terminal definition for the terminal you are currently 
using and you do not know the value of the key to be defined, press any non-
numeric key. You are then prompted to press the key you require. SB+ returns 
the value of the key.

By default, only keys that return a lead-in character less than decimal 32 
(space) can be used as an edit key. F7-Limit Value of Displayable Characters 
prompt.

Key Description

The description to be displayed as part of the help for available edit keys. 
This is used to describe the keyboard key used to carry out edit functions and 
is shown whenever you invoke the /KEYS process to see what keys are 
defined for your terminal.
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Download Character Sequence F8

This screen is accessed by pressing the F8 key in any of the Terminal 
Definition screens.

Function Keys

F2 - Accept

Saves the download character sequence parameters.

Prompts

Download Recovery Time (Seconds)

The number of seconds of delay (required for some terminals before they can 
accept other data) after downloading the download character sequence 
defined in the Download Sequence prompt below.
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Execute DownLoad when Switching Accounts

Options are:

Download Sequence

A character sequence to set the keyboard characteristics and the terminal 
setup, downloaded to the terminal when logging on. The download 
sequence sets the internal programmable functions of the terminal to the 
values used in SB+, ensuring that the terminal will operate as required. You 
can enter the decimal ASCII value in parentheses for any character not 
normally entered through the keyboard. See your terminal documentation 
for details of the sequences required.

A sequence can occupy as many lines on the screen as necessary. You can also 
enter ;∗text after a download sequence, where text is a comment describing the 
effect of the sequence. Lines commencing with ;∗ are ignored. If the 
characters >: appear at the start of a line, the remainder of the line is executed 
as a shell sentence. (All >: shell sentences are executed before any of the 
download sequences, regardless of where they are defined in the download 
sequence).

Value Description

Y Resends the download sequence in the next field when 
switching to another SB+ account via the LOGTO process. 

N (Default.) Does not resend the download sequence when 
switching to another account. 

Execute Download Options 
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Additional Terminal Sequences F9

This screen is accessed by pressing the F9 key in any of the Terminal 
Definition screens. It allows you to define any additional data that is 
dependent on the type of terminal in use. Take care to define information in 
the same sequence for all terminal definitions used in your system.

Function Key

F2 - Accept

Accepts the additional terminal sequence parameters.
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Prompts

Description

A description for the terminal sequence to be entered.

Sequence

The terminal sequence required. For example, if you are defining a cash 
register terminal, you may want to define the sequence to open the cash 
drawer.

Details are held in attribute 19,x of the COMMON variable TERM.DEFN. You 
can access this in expressions and user subroutines.

You can enter the decimal ASCII value in parentheses for any character not 
normally entered through the keyboard. For example, the ESC key would be 
(27).

Port Configure

The Port Configure option allows you to define the ports on your system.
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Port Configuration

Process /TERM.CONFIG

This screen is accessed by selecting Admin > Printers and Terminals > Port 
Configure. It allows you to define your system's port configuration. You can 
define terminals, printers, auxiliary printers, and the baud rate of each port.

On some systems the ports are dynamically allocated at logon, and you 
cannot rely on the port setup as defined. To eliminate this problem, SB+ 
allows you to define ASK or ASK(name) as the type of terminal and/or 
printers. This prompts the user at logon to nominate the terminal and printer 
types to be used.

You can also link the terminal/printer to each user if this is more appropriate 
to your installation. See “Setting Print Defaults” on page B-14.

Function Keys

F2 - Save

Saves the port configuration parameters.
  4-152



E:\SVN\SB55\doc_set\sbplus\administration\4Admin.fm
5/13/14 
F5 - Sort

Sorts entries by port number, if used at the Port prompt. You can specify the 
sort sequence.

F7 - Terminals

Displays the Terminal Definition screen. If you entered a terminal ID at any 
Terminal Id prompt and the cursor is at that prompt when you press the F7 
key, the ID is passed to the terminal definition process.

F8 - Printers

Displays the Physical Printer Definition screen. If you entered a printer 
name at any Printer Name prompt and the cursor is at that prompt when you 
press the F8 key, the printer name is passed to the terminal definition process.

F9 - Default

Allows you to define default values to be used by SB+ when terminal and 
printer ID prompts for a port are left blank. 

Note that users may have their own list of terminal/printer IDs specified in 
their user definition record, to be consulted if the defaults specified here are 
left blank or are multiple choice. For further information, see “Default 
Terminal/Printer Specification F9” on page 4-155.

F10 - Action

Displays the action bar:

PC Monitor

If you are using a PC monitor and terminal definition PCMON (or 
PCMON.COL) you need to run this function once initially. It assigns values to 
some of the keys (such as INS, DEL, PAGE UP, PAGE DOWN); otherwise these keys 
are undefined.

Prompts

Port

The port number that the device is connected to on the system. 
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T/P

The device type. Options are:

Terminal Id

The terminal ID if the port is connected to a terminal. The terminal ID must 
be defined in the Terminal Definition screen, described previously (or via 
the F7 key). This ID refers to a terminal definition containing details of the 
edit keys and graphics characters to be used for that type of terminal.

If you do not specify a terminal ID at this prompt, SB+ uses the terminal ID 
specified in the F10 - Default Terminal/Printer Specification screen. If a 
terminal ID is not specified there, SB+ uses the terminal ID specified for the 
user as indicated in Security > User Security Setup. For further information, 
see “User Security Setup” on page 3-20. If a terminal ID is not specified for 
the user, SB+ uses a default terminal ID called DEFAULT.TERM.

If ASK is entered, the terminal ID is prompted for at logon. ASK(xx) defaults 
to ID xx.

Printer Name

The physical printer name for the printer usually assigned to this port. The 
physical printer must be defined in the Physical Printer Definition screen. 
You can access this screen by pressing the F8 key. For further information, see 
“Setting Print Defaults” on page B-14.

Aux Prt Name

If a terminal has a printer connected to its auxiliary output, enter an 
appropriate physical printer name for the printer. This should have a printer 
class attached with the appropriate set of escape and other sequences for the 
type of printer connected. This printer is commonly called an auxiliary 
printer.

Value Description

T The port has a terminal connected.

P The port has a printer connected.

Terminal/Printer Device Options 
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User Name

The name of the normal user or location for the port. The System House 
Keeping > Port Setup > List Users Logged On option uses this user name or 
location.

Default Terminal/Printer Specification F9

This screen is accessed by pressing the F9 key in the Port Configuration 
screen.

Function Key

F2 - Accept

Accepts the default specifications.
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Prompts

Terminal Id

The terminal ID to use if an ID is not specified for a port. To prompt for the 
ID at logon, specify ASK or ASK(TERMID), where TERMID is the default. If you 
do not specify a terminal ID for this prompt or if you enter multiple IDs, SB+ 
consults the terminal IDs specified in Security > User Security Setup after 
the user has been identified. For further information, see “User Security 
Setup” on page 3-20. If SB+ finds a single terminal ID here, it uses that ID; 
otherwise the terminal ID is prompted for at logon, showing a list (if there is 
one) when ∗ is entered. If no terminal ID is specified at logon, the default ID 
DEFAULT.TERM is used.

The terminal ID may be of the form filename,itemid, where the contents of the 
record is a list of valid terminal IDs displayed if you enter * at the Terminal 
Id prompt. The default is the first entry in the list.

Printer Name

The physical printer name for the printer usually assigned to a user if a 
number of other default conditions are not met; usually if no other printer 
default parameters are specified elsewhere. The physical printer must be 
defined in the physical printer definition, available from the F8 key in the Port 
Configuration screen. For further information, see “Setting Print Defaults” 
on page B-14.

Aux Printer Name

The physical printer name for a printer on an auxiliary port, usually assigned 
to a user if a number of other default conditions are not met; usually if no 
other printer default parameters are specified elsewhere. The physical 
printer must have been defined in the physical printer definition, available 
from the F8 key in the Port Configuration screen. For further information, see 
“Setting Print Defaults” on page B-14.
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Media Commands

The Media Commands menu allows you to manage the media (such as tapes 
and diskettes) and media devices (such as tape drives and disk drives) on 
your system. You can also read records from and write records to the media.

Commands that do not require a lengthy description are described only in 
the table below. Other commands are fully described in the pages that follow.

Option Description

Define Media Device Allows you to define a media device on your system. 

Select Media Device Allows you to choose a media device. Use this before any 
other media options. For further information, see “Select 
Media” on page 2-4.

Attach Media Device UniData only. Allows you to gain exclusive access to the 
selected media device.

Rewind Media Allows you to rewind the currently attached media. Use 
this before reading or writing to media.

Read Tape/Diskette Allows you to read a block from the currently attached 
media and display its contents on the screen.

Media Commands Menu Options 
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Define Media Device

This screen is accessed by selecting Admin > Media Commands > Define 
Media Device. It allows you to define a media device on your system.

Note: The above screen sample is for a UniVerse/UNIX installation. The screen for 
UniData/UNIX, UniVerse/Windows, and UniData/Windows is similar.

Write File To Media Allows you to write the contents of selected records 
from a disk file to the currently attached media.

Load File From Media Allows you to load the contents of a file from the 
currently attached media to a specified disk file.

Detach Media Allows you to detach the currently attached media, making 
it available to other users. Ensure that the device is free to 
use if detaching it from another port. For further 
information, see “Detach Media” on page 2-12.

Option Description

Media Commands Menu Options (Continued)
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Function Keys

F2 - Accept

Saves the media device parameters.

F4 - Del

Deletes the media device record.

Prompts

Device Name (UniVerse)

The device name to be used whenever you select the current media.

Device Number (UniData)

The device number to be used whenever you select the current media.

Description

A meaningful description of the media device.

Windows NT Device (Windows only)

The Windows NT sharename for the device. Device names are in the 
following form:

\\.\devname

For example:

\\.\a: 

 or

\\.\tape0
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Device Type (UniVerse)

Specifies the type of media you are defining for the media device. Options 
are:

Block Size

The media block size in bytes.

Operation Mode (UniData)

Specifies the data conversion filter to be used when reading from or writing 
to this device. This allows for alternative storage formats such as EBCDIC. 
Options are:

Rewind Path (UNIX only)

The UNIX path to a device that fully rewinds the tape after tape operations 
are complete.

Value Description

F Floppy disk (diskette)

T Tape

C Cartridge

DT Direct tape

DC Direct cartridge

Device Type Options - UniVerse 

Value Description

0 No conversion. Stores all characters in ASCII format.

1 Assumes data is in EBCDIC format.

2 Inverts high bits.

3 Swap bytes.

Operation Mode Options (UniData) 
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Norewind Path (UNIX only)

The UNIX path to a device that does not rewind the tape after tape operations 
are complete. If you do not specify a device at this prompt, enter a device at 
the Rewind Path prompt.

Backup Command (UNIX only)

The UNIX command to perform the backup called from the Backup menu. 
The F3 key provides help on formatting this and the following commands.

Restore Command (UNIX only)

The UNIX command to perform the restore called from the Backup menu. 

Skip File Command (UNIX only)

The UNIX command to skip a file on the media. 

Rewind Command (UNIX only)

The UNIX command to rewind the device.

Offline Command (UNIX only)

The UNIX command used to handle device offline errors.

Attach Media Device

UniData only. This option allows you to gain exclusive access to the selected 
media device and to specify the block size to be used. SB+ notifies you if the 
media device is already in use.
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Prompts

Block Size (Null=Default)

The block size to be used if different from the default used by the operating 
environment for the selected media device. To use the OE default value, leave 
blank.

Write File To Media

This screen is accessed by selecting Admin > Media Commands > Write File 
To Media. It allows you to write the contents of selected records from a disk 
file to the currently attached media.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to write a file to 
media.

Prompts

File Name

The name of the file to be written to the attached media.
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Data/Dict (0/1)

Options are:

Record Name(s) Or Criteria

The IDs of the records (enclosed in quotation marks) to be selected from the 
file, or selection criteria. To select all records, leave this prompt blank. You can 
enter multiple record IDs; use a space between record IDs.

Load File From Media

This screen is accessed by selecting Admin > Media Commands > Load File 
From Media. It allows you to load the contents of a file from the currently 
attached media to a specified disk file.

Value Description

0 Writes the contents of the data part of the file.

1 Writes the contents of the dictionary part of the file.

Data/Dictionary Options 
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Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to load a file from 
media.

Prompts

File Name

The name of an existing file into which data from the attached media will be 
loaded.

Data/Dict (0/1)

Options are:

Record Name(s) Or Criteria - UniVerse

The IDs (enclosed in double quotes) of the records that are to be loaded, or 
selection criteria. To load all records, leave this prompt blank.

Selection Criteria - UniData

The selection criteria to load a subset of the records from the device. If NULL, 
saved record names will be used here.

Value Description

0 Loads data from the selected media into the data part of the 
file. 

1 Loads data into the dictionary part of the file.

Data/Dictionary Options 
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Overwrite Existing (Y/N)

Options are:

Suppress ID Listing (Y/N)

Options are:

Value Description

Y Overwrites any existing records of the same ID.

N Ignores any record IDs read from the media that already 
exist in the target file.

Overwrite Options 

Value Description

Y Prevents record ID listings from appearing on the screen.

N Displays each record ID as it is loaded.

Suppress ID Listing Options
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SB+ Setup

The SB+ Setup menu provides options for defining the control parameters 
SB+ needs before it can run on your system. Normally you use these options 
only when you are initially setting up an account or system.

SB+ Control Parameters

The SB+ Control Parameters option allows you to specify global control 
parameters used by SB+ for all accounts and system IDs.

This option provides a main screen and a number of subordinate screens that 
can be reached via function keys, as shown in the following diagram:

SB+ Control Parameters

F5 - Sys Defaults F7 - Sys Keys F8 - Disp Defaults F9 - Logto

F5 - Additional F6 - GUI F7 - Language Table F5 - GUI Display Defaults

F6 - OE Transactions
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The main screen is accessed by selecting Admin > SB+ Setup > SB+ Control 
Parameters.

Note: This screen sample is for a Windows installation. The UNIX screen is similar, 
but contains additional prompts.

Function Keys

F2 - Save

Saves the SB+ control parameters.

F5 - System Defaults

Allows you to specify defaults used when setting up a new system ID. For 
further information, see “System Defaults F5” on page 4-172.
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F7 - System Keys

Allows you to configure certain system keys. These settings should never 
have to be changed. For further information, see “System Keys F7” on page 4-
186.

F8 - Display Defaults

Allows you to configure certain default display characteristics. For further 
information, see “Display Defaults F8” on page 4-187.

F9 - Logto Sub

Displays the Logon/Logto Subroutine screen. For further information, see 
“Logon/Logto Subroutine F9” on page 4-192.

Prompts

Prompt Line

Defines where the prompt line is to be displayed on the screen. Enter the 
prompt line number, or L n where n is the number of lines up from the last line 
of the terminal screen. We recommend you leave the default at L1.

Error Line

Defines where on the screen the error line is to be displayed. Enter the error 
line number, or L n where n is the number of lines up from the last line of the 
terminal screen. We recommend leaving the setting at the default, L1.

Help Line

Defines where on the screen the first help line is to be displayed. Enter the 
first help line number, or L n where n is the number of lines up from the last 
line of the terminal screen. We recommend leaving the setting at the default, 
L1.
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Screen Accept Prompt

Options are:

You can override this value for any screen.

Other Language (Y/N)

Informs SB+ whether to use hard-coded English text for its prompts or to use 
a translation table. Options are:

Note: This is for a single, complete transaction. See “Enable Multi-language 
Support” on page 4-175 for an alternative translation function.

Value Description

Y The default for all screen accept prompts displayed within 
the Screen Definition tool is to be Yes. For more information 
on the Screen Definition tool, see the SB+ Server Reference 
Manual.

N The default for all screen accept prompts is to be No. 

Screen Accept Prompt Options 

Value Description

Y SB+ has been translated to another language and these 
language definitions have been loaded into the relevant 
SB+ definition files. The prompts are taken from the 
PROMPT record in DMCONT. Translation is done via the 
process XLATE.DEFN.

N Uses hard-coded English prompts.

Other Language Options 
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Field Definition LC

Options are:

Max Levels Warning

The number of nested process levels allowed before a warning is given. 
Accept the default in most circumstances.

Note: Some OE versions limit the number of levels of process calls.

Edit Key Delay

The delay value (in milliseconds) before checking the type ahead buffer to see 
if another key is pending. This is used as a time-out on function key strokes. 
You need to adjust this parameter only if SB+ is not picking up all the 
characters generated by an edit key.

There are two time-out methods:

Value Description

Y Descriptions entered in field definitions are to be converted 
to mixed upper- and lowercase letters. You can override the 
result by amending an existing field definition and typing 
over the field definition or report header. 

N Leave text as entered.

Field Description Options 

Value Description

n >= 0 Wait for n milliseconds or until a character is found in the 
input buffer (if this occurs first).

n <= 0 Loop n times or until a character is found in the input 
buffer (if this occurs first).

Edit Key Delay Options 
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CUA Arrow Movement

Options are:

Internat/American Date

Determines the format for dates. Options are:

OE Type

(Display only.) An abbreviation for the operating environment to which this 
version of SB+ is ported: UDATA for UniData or UV for UniVerse.

Frame Size

(Display only.) The number of characters in a disk frame. This is used for 
calculating file sizes.

Windows NT Delimiter/Unix Delimiter/

(Display only.) The path delimiter.

Unix Name (UNIX only)

(Display only.) The UNIX system name obtained from the uname command.

Value Description

Y The up arrow key and SHIFT-TAB keys cycle backward 
through input fields. The ESC key cancels the record.

N The up arrow key, SHIFT-TAB, and ESC keys cycle 
backward through input fields. 

CUA Arrow Movement Options 

Value Description

A American (mm/dd/yy).

I International (dd/mm/yy).

Date Format Options 
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Pathname 

(Display only.) The home directory.

SB+ Unix Group (UNIX only)

(Display only.) The group used when SB+ was installed.

File Creation Umask (UNIX only)

(Display only.) The umask value for the current session. This is usually 007.

Max Unix Filename Len (UNIX only)

(Display only.) The maximum filename length, OE-dependent.

System Defaults F5

This screen is accessed by pressing the F5 key in the SB+ Control Parameters 
screen. It allows you to specify default system control parameters for all 
accounts and IDs.
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Function Keys

F2 - Accept

Accepts the screen parameters. The changes are not applied until you save 
the SB+ Control Parameters screen.

F5 - Additional

Allows you to specify additional system defaults. For details, see “Additional 
System Defaults F5” on page 4-175.

F6 - GUI

Displays the GUI System Parameter Defaults screen. For details, see “GUI 
System Parameter Defaults F6” on page 4-179.

F7 - Language Table

Displays the Language Table screen. For details, see “Language Table F7” on 
page 4-184.

F8 - NLS Support

Presents the NLS Support screen. For details, see “NLS Support F8 – 
UniVerse” on page 4-185.

Prompts

Default Date Conversion

A default date conversion.

The Field Definitions tool uses this conversion as the default when creating a 
field of type D (Date). It can be overridden for specific fields if required. For 
further information about the Field Definitions tool, see your SB+ Server 
Reference Manual.

Changing this default conversion does not affect pre-existing field 
definitions, screens, or reports.
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Default Money Conversion

A default money conversion.

The Field Definitions tool uses this conversion as the default when creating a 
field of type M.

Changing this default conversion does not affect pre-existing field 
definitions, screens, or reports.

Proc At Set Common

A process to be called whenever SB.SET.COMMON is called.

You can set up any values specific to your system to be stored in COMMON 
in this process. For example, you may want to store the current company 
code you are working with in COMMON variable PARAMS(1). Whenever 
you go to the OE shell or CHAIN any program, the contents of COMMON 
are lost. To ensure that PARAMS(1) is reset, specify a process here that assigns 
the relevant value to PARAMS(1).

Proc At OE Return

A process to be called whenever a user leaves SB+ to return to the OE.

This can be used to check whether it is legal for the user to go to the OE shell. 
If the process sets RTN.FLAG to X or 1, the attempt to go to the OE shell is 
cancelled.

Proc Before CHAINing

A process to be called whenever CHAINing to external software.

COMMON variables specific to your system can be saved by this process. If 
you use the C or W type in menus, the process is effectively CHAINed. This 
means that the COMMON variables you have set up are lost. You may want 
to save these variables in a process called from this slot.

Note: This complements the process specified at the Proc At Set Common prompt, 
in providing a user exit point on entry to, and exit from SB+.

Field Template Dict

The field template file to be used by this system.
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This name may be the same as that used in other systems.The field template 
file can be shared by different system IDs and across accounts.

Global Dict Name

The global dictionary to be used by this system.

If this file was not created in this account, a file pointer must be defined for it.

Enable Multi-language Support

Select the setting for multi-language support to use as the default for each 
system ID when it is initiated.

SB+ Subroutines in Dictionaries

Select the setting to use as the default for determining whether subroutines 
are stored in dictionaries.

Additional System Defaults F5

This screen is accessed by pressing the F5 key in the System Defaults screen. 
It allows you to specify additional system defaults to be used as the defaults 
when a new system ID is created.
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Function Keys

F2 - Accept

Accepts the additional system default parameters. The changes are not 
applied until you save the SB+ Control Parameters screen.

F6 - OE Transactions

Opens the OE Transactions Parameters screen. For further information, see 
“OE Transaction Parameters F6” on page 4-178.

Prompts

Global Process

The name of the file to be used as the global process file as a fallback from 
xxPROCESS. The file must already exist, and a file pointer to the file must 
exist if the file was not created locally. 

For further information, see “Global Files” in the SB+ Server Reference Manual.

Global Menu

The name of the file to be used as the global menu file as a fallback from 
xxMENUS. The file must already exist, and a file pointer to the file must exist 
if the file was not created locally. 

For further information, see “Global Files” in the SB+ Server Reference Manual.

Global Help

The name of the file to be used as the global help file as a fallback from 
xxHELP. The file must already exist, and a file pointer to the file must exist if 
the file was not created locally. 

For further information, see “Global Files” in the SB+ Server Reference Manual.

Global Defn

The name of the file to be used as the global definition file as a fallback from 
xxDEFN. The file must already exist, and a file pointer to the file must exist 
if the file was not created locally. 
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For further information, see “Global Files” in the SB+ Server Reference Manual.

Proc Before '/proc'

A process to be executed before any process is invoked using the /name 
syntax. If RTN.FLAG is set to 1 or X, the process being invoked will not be 
executed.

Process After Tool Read

A process to be called after the read step in SB+ tools. The action of the 
process is entirely user-defined. Any RTN.FLAG settings are passed back to 
the tool for processing.

For example, a value of X in RTN.FLAG causes the tool process to terminate. 
A value of 1 in RTN.FLAG causes the cursor to return to the key field of the 
tool.

The COMMON variables KEY, ACTION, MAINFILE, and RECORD contain data 
relevant to the read just performed. You can use this process to control SB+ 
tool usage or to implement version control for application development.

DDE Timeout

The number of seconds to allow for a DDE action to complete before 
reporting an error. The default value is 10 seconds.

Form Defns to Store

The number of previous versions of a form to store (maximum of 9) during 
development. You can access previous versions by pressing the Restore 
function key.
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OE Transaction Parameters F6

This screen is accessed by pressing the F6 key in the Additional System 
Defaults screen.

Function Key

F2 - Accept

This accepts the screen.
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GUI System Parameter Defaults F6

This screen is accessed by pressing the F6 key in the System Defaults screen. 
The values entered here are used as the default only when creating new 
accounts or modules. They do not affect existing accounts or modules.

Function Keys

F2 - Accept

Accepts the GUI system parameter defaults. The changes are not applied 
until you save the SB+ Control Parameters screen.

F5 - GUI System Defaults

Opens the GUI System Defaults screen. For details, see “GUI System 
Defaults F5” below.
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Prompts

GUI Mode Enabled

If GUI mode is to be enabled for each module when it is initiated, select Yes.

Add Scrollbars to Multivalued Fields

If scrollbars are to be added by default to multivalued fields in GUI mode, 
select Yes.

Use Tabfolders in GUI Screens

If tabfolders are to be used by default for linked screens in GUI mode, select 
Yes.

Use Grids for Multivalued Fields

If grid controls are to be used by default for multivalued fields in GUI mode, 
select Yes.

Navigation Method

Enter a value for the default method by which users will navigate the system 
and invoke SB+ processes.

Remove Tool Branch

If the Tool branch is to be removed from the Explorer pane in new GUI 
modules by default, select Yes.

Value Description

M Menus on MainWin

EM Explorer with MainWin

EN Explorer without MainWin

N No MainWin

Navigation Method Options 
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Remove Help Branch

If the Help branch is to be removed from the Explorer pane in new GUI 
modules by default, select Yes.

Remove Readme Branch

If the Readme branch is to be removed from the Explorer pane in new GUI 
modules by default, select Yes.

Multiple Sysids

If multiple system IDs are to be shown in the Explorer pane in new GUI 
modules by default, select Yes.

Self-Contained Forms

If the action bar, toolbar, and status line are to be part of the GUI form by 
default, select Yes.
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GUI System Defaults F5

This screen is accessed by pressing the F5 key in the GUI System Parameter 
Defaults screen. This screen contains the default values for some of the GUI 
parameters. The values entered here are used only as the default when 
creating new accounts or modules. They do not affect existing accounts or 
modules.

Function Keys

F2 - Accept

Accepts the GUI system default parameters. The changes are not applied 
until you save the SB+ Control Parameters screen.

Prompts

GUI Screen Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating 
screens.
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GUI Menu Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating 
menus.

GUI Help Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating help 
items.

GUI Dialog Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating 
dialog boxes.

GUI Error Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating error 
displays.

GUI Lookup Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating 
lookup displays.

GUI Prompt Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating 
prompt screens.

GUI CEO Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating 
character emulation objects.
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GUI HTML Defaults

Enter the control name to be used as the default for each module when it is 
initiated. This entry defines the default characteristics used for creating 
HTML code.

Language Table F7

This screen is accessed by pressing the F7 key in the System Defaults screen. 
It allows you to maintain the system-wide language table. This table defines 
the languages that will be supported in multi-language applications.

Function Keys

F2 - Save

Saves the language table.

F4 - Del

Deletes the language table. The language files specified for the languages will 
not be deleted.
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Prompts

Code

This is a code used to denote a language supported in the system.

Description

The full description of the language.

Language File

This is the file used to store most of the translated text for the language. The 
default is 'DMLANGUAGE.xx' where xx is the language code, but any valid 
filename can be used. If the file does not exist, it will be created.

NLS Support F8 – UniVerse

This screen is accessed by pressing the F8 key in the System Defaults screen.

Function Keys

F2 - Save

Saves the language table.
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System Keys F7

This screen is accessed by pressing the F7 key in the SB+ Control Parameters 
screen. It allows you to change certain default system key characteristics used 
by SB+.

Prompts

Decimal Value For <Enter> key

The decimal value to be returned by pressing the ENTER key.

Decimal Value For <Backspace> Key

The decimal value to be returned by the Backspace key.

Call Process Character

The character to be used to call a process.

Call Help Character

The character to be used to call help.

Alternative Delete Character

The character to be used to delete a field.
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Display Defaults F8

This screen is accessed by pressing the F8 key in the SB+ Control Parameters 
screen. It allows you to change certain default display characteristics used by 
SB+.

Function Keys

F2 - Accept

Accepts the screen parameters.

F5 - GUI Display Defaults

Opens the GUI Display Defaults screen. See “GUI Display Defaults F5” on 
page 4-190
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Prompts

Action Bar Option Spacing Method

This parameter specifies how option spacing in action bars is determined. 
Options are:

Action Bar Highlight Effect Number

The display effect number from the terminal definition for displaying the 
highlighted letter in an action bar; this is normally reverse video. For further 
information, see “Terminal Definitions” on page 4-126.

Action Bar Display Line

The line (1 or 0) on which the action bar is displayed.

Value Description

0 Gives a constant number of spaces between options; the 
number of spaces being determined by the number and 
length of options.

1 Gives a uniform number of characters per option; shorter 
option descriptions are padded with spaces.

2 Options are fitted (as near as possible) to the full width of 
the screen. This is a combination of 0 and 1.

n A number greater than 2 uses the type 0 spacing method 
but reserves at least n number of spaces from the start of the 
last option to the screen width. This allows menus to be 
pulled down under the last option in the menu bar.

-n Same as for n but uses the type 1 spacing method.

Option Spacing Methods 
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Default Window Frame Type

The window frame (border) type for drawing window frames that do not 
have the frame type specified in their window coordinates. Options are:

Default Window Style Code

The window style code to be used on terminals capable of using these codes, 
where no style code is given in their window coordinates. Options are:

Style codes other than 0 are only applicable when using SBTerm terminal 
emulation products in character mode. 

Mouse Double Click Interval

The timing interval (in milliseconds) between the first and second mouse 
click to cause a double-click action to take place.

Value Description

0 No frame.

1 Single line frame.

2 Double line frame.

Frame Type Options 

Value Description

0 No shadow or exploding windows.

1 Shadow.

2 Exploding window.

3 Shadow and exploding windows.

Window Style Codes 
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GUI Display Defaults F5

This screen holds the system-wide control flags that relate to GUI mode. It 
can be accessed by performing the following steps:

1. Enter "/SB.PARMS".

2. Press the F8 key to open the Display Defaults screen.

3. Press the F5 key.

This screen is different from the GUI System Defaults screen.

The GUI System Defaults screen contains information that is applied to new 
modules when they are created, while the GUI Display Defaults screen 
affects the behavior of all modules at run time, not just when they are being 
created.
  4-190



E:\SVN\SB55\doc_set\sbplus\administration\4Admin.fm
5/13/14 
Prompts

SB+ Host Name

This name will be used as a prefix for all downloaded GUI definitions and 
allows a distinction between identical forms from different hosts. An entry is 
required in this field only if there are users who will be running in GUI mode 
and accessing SB+ Server on more than one host machine.

Disable Previous Menu

If set to Y, the previous menu will be disabled when a screen does not have an 
action bar. If set to N, the previous menu will be accessible as an action bar.

Enable 'No Refresh' Feature

If set to Y, a subordinate screen with the N (no refresh) option will not be 
destroyed on exit. It will be disabled, but will persist until the main screen is 
destroyed.

Exclude HELP_STRING from Driver

If set to Y, ToolTip style help is disabled by preventing the help string from 
being included in the driver.

Use new LFK Style Buttons

If set to Y, the LFK process replaces any existing buttons on the form instead 
of attaching the function key set to menu.

Adjust Form Size for Toolbar

If set to Y, automatic resizing of the form is enabled in situations where a 
toolbar attached to a form is larger than the form. If set to N, the toolbar is 
wrapped into as many rows or columns as required to fit it onto the form.

Use Flat Style Buttons on Toolbar

If set to Y, buttons on fixed toolbars will be created in the newer flat style. If 
set to N, the buttons will be created in the older raised style.
4-191 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\4Admin.fm
Use ListView Style Selects

Logon/Logto Subroutine F9

Process /LOG.PROC

This screen is accessed by pressing the F9 key in the SB+ Control Parameters 
screen. It allows you to call a user subroutine to perform processing at logon 
or logto, before any terminal or printer setup occurs. This must be a 
subroutine, because processes will not function at this point of the 
logon/logto process. This process is not available from system menus, 
because it operates on a per-account basis.

Function Key

F2 - Save

Saves the screen parameters.

Prompts

Subroutine Name

The name of the user subroutine to be called.

Value Description

Y Use ListView style select lists.

N Use traditional style select lists.

ListView Style Options 
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Prompts

OE Transactions

Warn on Error

Commit Fail Process

This is used to specify the name of a process that is to be run automatically if 
an operating environment transaction fails.

Value Description

Y Set to this value if Transaction Processing has been enabled 
in the operating environment,

N Set to this value if Transaction Processing has not been 
enabled in the operating environment.

OE Transaction Options 

Value Description

Y A warning is to be issued when an operating environment 
transaction fails.

N If a warning is not to be issued when an operating 
environment transaction fails.

Warn on Error Options 
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SB+ Configuration Options

Provides options for customizing the way SB+ interfaces with the operating 
environment and options for setting up some SB+ global processes.
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Global Postings

This screen is accessed by selecting Admin > SB+ Configuration Options > 
Global Postings. It allows you to specify file pointers, program pointers, and 
verbs to be propagated to all SB+ accounts.

Function Keys

F2 - Save

Saves the global postings parameters.

F4 - Del

Deletes the global postings record.
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Prompts

Last Posted By

(Display only.) The ID for the last user to have updated this screen.

Last Posted On

(Display only.) The date of the last update to this screen.

Global Files

The name of the file (in this VOC) to have a file pointer created in all other 
SB+ accounts.

Global Verbs

The name of the verb in this account or cataloged program to have its 
definition copied to all SB+ accounts.

Posted Processes

The name of the process (in SAPROCESS) to be copied to all other SB+ 
systems.

Posted Menus

The name of the menu (in SAMENUS) to be copied to all other SB+ systems.

Posted Defns

The name of the definition (in SADEFN) to be copied to all other SB+ systems.
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Global Print Defaults

This screen is accessed by selecting Admin > SB+ Configuration Options > 
Global Print Defaults. It allows you to specify several global print defaults. 
These defaults affect all systems in an installation that do not have print 
defaults. For related information, see “Setting Print Defaults” on page B-14, 
and “System Control Record” on page 4-114 in the SB+ Server Reference 
Manual.

Function Keys

F2 - Save

Saves the global printer default record.

F4 - Del

Deletes the global printer defaults record.
4-197 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\adminis
tration\4Admin.fm
Prompts

Physical Printer Name

The name of existing defined physical printer definition. If the physical 
printer has not been started, a warning message is displayed. You can enter 
an expression in parentheses to be evaluated at run time.

Stationery Type

A valid stationery type for this physical printer. The stationery type can be 
selected from the list currently associated with the selected printer. You can 
enter an expression in parentheses to be evaluated at run time.

Assign Options

Any printer assign options required. These differ slightly from platform to 
platform. However, the following list is common to all:

UniData and UniVerse have different options for handling the use of the 
‘hold’ file. See your OE documentation and “Printer Management” on 
page 4-48.

You can enter an expression in parentheses to be evaluated at run time.

No of Copies

The number of copies to be produced in a single print request. You can enter 
an expression in parentheses to be evaluated at run time.

Type Description

P (Default.) Prints to printer or output device.

H Holds the print job on the queue and prints to the printer or 
output device.

HS Holds the print job on the queue without printing.

Printer Assign Options 
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Global Print Mngr Proc

The process name entered here is used to invoke a user-implemented process 
to add functionality to print management in SB+ for all systems that do not 
have a process nominated in the local System Control Record. (For further 
information, see “System Control Record” on page 4-114 in your SB+ Server 
Reference Manual.) This prompt is checked only if there is no local process 
defined. If a process is not entered here, standard SB+ Print Management is 
used.

Setting @RTN.FLAG in the process makes a number of options possible. 
Options are:

Global Prnt Redir On

The process name entered here is used to invoke a user-supplied process that 
works independently of, or in conjunction with, the normal SB+ print 
redirection functionality (such as the Screen/Printer/Aux prompt in Report 
Writer). This process applies globally where a local redirection process has 
not been specified in the local System Control Record.

If no process name is entered here or in the local System Control Record, 
normal SB+ output redirection is used. If a process name is present, SB+ does 
not prompt but leaves this to the user process.

@RTN.FLAG and @VALUE are tested on return from the process. If 
@RTN.FLAG is X, the current run is aborted. Any other value falls through to 
the @VALUE check. 

@VALUE is tested for any one of the enabling key letters for SB+ redirection 
(such as S, P, or X). If @VALUE contains one of the enabling key letters, SB+ 
performs the normal SB+ functions associated with that letter.

Value Description

0 Continues with the standard SB+ Printer Manager setup.

1 Ignores the SB+ Printer Manager. The user process must 
provide all print set/reset functions.

X Causes the current print run to be aborted.

Print Management Options 
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If SB+ redirection is bypassed, the user process must supply all redirection 
functionality.

Global Prnt Redir Off

The process name entered here is used to invoke a user-supplied process that 
will work independently of, or in conjunction with, the normal SB+ print 
redirection reset functionality. This process is used to restore the environment 
that existed before that created by the redirection-on process and/or SB+ 
redirection-on routines.

This process applies globally where a local redirection process has not been 
specified in the local System Control Record.

If no process name is entered here or in the local System Control Record, 
normal SB+ redirection-off is used. We highly recommend that redirection-on 
and redirection-off processes are created as a pair. This ensures that user 
routines, especially those that bypass SB+ output redirection altogether, 
correctly set and reset the environment.
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OH Process Scope Control

This screen is accessed by selecting Admin > SB+ Configuration Options > 
OH Process Scope Control. It provides additional security on the /OH and 
/MP processes so that end users of applications cannot readily modify certain 
definitions.

Function Keys

F2 - Save

Saves the screen parameters.

F4 - Del

Deletes this record.
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Prompts

Can use /OH or /MP

The IDs of users allowed to use the /OH process or /MP process even if these 
processes are copied and run under another name. If this is blank, all users 
who gain access to /OH or /MP have no further security applied to their 
actions.

Can use /OH on Tool Processes

The IDs of users allowed to use the /OH process on tool or flagged processes 
(where the process type is suffixed), even if the /OH process is renamed.

A flagged process is one that has an additional character added to the process 
type letter in attribute 1 of the process definition record. All SB+ tool 
processes have a T appended. You can flag a process by manually adding an 
additional letter to attribute 1 of the process definition.

If this is blank, all users who gain access to /OH have no further security 
applied to their actions.
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OE Setup Commands

This screen is accessed by selecting Admin > SB+ Configuration Options > 
OE Setup Commands. It allows for the execution of OE commands before 
control is handed over to SB+; for example, to release the backspace character 
via the PTERM command.

Function Keys

F2 - Save

Saves the OE setup command parameters.

F4 - Del

Deletes this record.

Prompts

Statements To Be Executed

Commands to be executed line by line. 
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OE Reset Commands

This screen is accessed by selecting Admin > SB+ Configuration Options > 
OE Reset Commands. It allows OE commands to be executed before SB+ 
terminating; for example, to reverse the effects of commands executed in the 
OE Setup Commands screen.

Function Keys

F2 - Save

Saves the OE Reset Command parameters.

F4 - Del

Deletes this record.

Prompts

Statements To Be Executed

Commands to be executed line by line, when leaving SB+ and returning to 
the OE. 
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Wrapping OFF Verb

This screen is accessed by selecting Admin > SB+ Configuration Options > 
Wrapping OFF Verb. Allows you to rename the OE OFF verb so that SB+ can 
change the original to call its own verb that does additional housekeeping.

Function Keys

F2 - Save

Saves the screen parameters.

F4 - Del

Deletes this record.

Prompts

New Name

A new name for the real OFF verb. If no name is given or this record is deleted 
then the OFF verb is not wrapped.
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Replace Original With

Optional replacement text for the record to replace the OFF verb. You should 
leave the call to SH.OFF, but you may want to add something extra.

Wrapping LOGTO Verb

This screen is accessed by selecting Admin > SB+ Configuration Options > 
Wrapping LOGTO Verb. It allows you to rename the OE LOGTO verb so SB+ 
can change the original to call its own verb that does extra housekeeping.

Function Keys

F2 - Save

Saves the screen parameters.

F4 - Del

Deletes this record.
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Prompts

New Name

A new name for the real LOGTO verb. If no name is given or this record is 
deleted, the LOGTO verb is not wrapped.

Replace Original With

The optional replacement text for the record to replace the LOGTO verb. 

SB+ Patching System

The SB+ Patching System option allows you to load, view, and unload 
patches. A patch is a modification to the existing SB+ software.

The patching system is implemented in a similar way to revision control. (For 
further information, see your SB+ Server Reference Manual.) You use revision 
control functions to create media and format records. Action codes (such as 
item copy or item delete) are the same as those used in revision control.
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System Builder normally creates a patch and distributes it as either a file or 
on media (such as tape or diskette). If the patch contains object code 
(programs), the patch cannot be distributed as a file for certain platforms (for 
example, AP and R83). Media must be used in these instances. A patch can 
be distributed as a file for platforms such as UniData, UniVerse, and Pi/Open 
where the object is encoded first (using the UNIX uuencode command) and 
then decoded when the patch is applied. If the patch does not contain object 
code, it can be distributed as a file for all platforms.

Maintain Patch Definition

This screen is accessed by selecting Admin > SB+ Configuration Options > 
SB+ Patching System > Maintain Patch Definition. It allows you to view 
patch definition records.

Patches are identified by their patch number. The patch number relates to all 
platforms of SB+.
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Function Keys

F4 - Del

Deletes selected files from the patch.

F5 - Readme

Invokes the PATCH.README process, which displays the patch readme 
screen. This contains additional information related to the patch, including 
details of changes.

Prompts

SB+ Release

(Display only.) The current SB+ version and release number.

OE Type

(Display only.) The operating environment to which the patch applies.

Patch No

The sequential number allocated by System Builder when the patch was 
created.

Dependent On

(Display only.) A list of any related patches (comma-delimited) that need to 
be applied first.

Obj/Source

The type of SB program the patch has been created for. Options are:

Type Description

O Object.

S Source.

Program Type Options 
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This is normally set to 0.

Description

(Display only.) A description of the patch.

Action

(Display only.) The action to be performed, such as item copy or file load.

Filename

(Display only.) The file on which the action is to be performed.

Item

(Display only.) The item name (if applicable).

Parameters

(Display only.) The required parameters (such as file type, modulo, and 
sysID), depending on the action.

Load the Patch

This screen is accessed by selecting Admin > SB+ Configuration Options > 
SB+ Patching System > Load. It allows you to load a patch.

You must apply patches from your SB+ account. On UNIX systems you need 
to be logged on as superuser.
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Function Keys

F2 - Accept

Accepts the screen parameters, and proceeds with the loading of the patch. 
Patch details are retrieved from the specified media/file and the Patch 
Selection screen displayed.

This allows you to load patches selectively. Enter Y at the Apply prompt to 
apply a particular patch. The Apply prompt defaults to N if the current SB+ 
patch level is higher than the one being applied, otherwise it defaults to Y.

The function keys on the Patch Selection screen are:

F2 - Accept

Accepts the Patch Selection screen details.

F4 - Quit

This enables you to exit this screen without saving details.

F5 - README

Displays the README for the current batch.
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Prompts

(M)edia/(F)ile

Indicates whether the patch is to be loaded from a file or from media. Options 
are:

Filename

The filename of the patch, if you selected the F (File) option at the previous 
prompt.

Unload the Patch

In some cases you may want to reverse the patch. If the patch was flagged as 
reversible at the time of creation, a media/file was created with the reverse 
patch definitions when the patch was loaded. This process loads the reverse 
definitions, effectively resetting the system to its former state.

Only the most recent patch can be unloaded.

Value Description

M Loads patch from media.

F Loads patch from a file.

Patch Load Options 
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Function Key

F2 - Accept

Accepts the data entered into this screen, and unloads the most recent patch.

Prompts

Patch

(Display only.) The current SB+ patch level.

Sub Patch

(Display only.) The sub-patch number, if applicable.

(M)edia/(F)ile

Indicates whether the patch was loaded from a file or from media. Options 
are:

Filename

The name of the patch file if you selected the F (File) option at the previous 
prompt.

Value Description

M Media

F File

Patch Load Options 
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SB+ Release Info

Displays the SB+ version and release number, the current patch number, and 
details of patches applied.
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System House Keeping

The System House Keeping menu allows you to manipulate operating 
environment details.

Port Setup

This option provides menus for maintaining and reviewing various port-
related details. 
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Your Terminal Settings (OE)

This screen is accessed by selecting Admin > System House Keeping > Port 
Setup > Your Terminal Settings (OE). It allows you to view and change the 
display format and some terminal parameters for the current port and logon 
session only. This option relates to the OE TERM command.

Function Key

F2 - Accept

Accepts the screen parameters and updates the terminal settings.

Prompts

Terminal Line Width in Horizontal Print Positions

The number of columns available on the terminal.

Terminal Lines Depth

The number of rows available on the terminal.
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Number Of Blank Lines At Bottom Of Screen - UniVerse

The number of blank lines to appear at the bottom of every screen.

Number Of Delay Characters Output After Linefeed - UniVerse

The number of delay characters output after a line feed. This is used for 
terminal timing and synchronization.

Number Of Delay Characters After Top-Of-Form - UniVerse

The number of delay characters after a top-of-form. This is used for terminal 
timing and synchronization.

Backspace Character - UniVerse

The decimal ASCII character that represents the BACKSPACE key. Usually 8.

Printer Line Width

The number of columns to be printed when output is assigned to a printer.

Printer Lines Depth

The number of rows to be printed per page when output is assigned to a 
printer.

Term-Type Code For Terminal Code Definitions - UniVerse

The OE term-type specific to the terminal. For example, in UniVerse, vt340 
signifies a DEC VT340 terminal.

List Users Logged On

This screen is accessed by selecting Admin > System House Keeping > Port 
Setup > List Users Logged On. Displays details of all users currently logged 
on the system. See “List Users Logged On” on page 3-35.
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Log-Off a Port 

This screen is accessed by selecting Admin > System House Keeping > Port 
Setup > Log-Off a Port. It allows you to log off a specified port. The process 
ID of the database session is used to log off the port. 

Function Key

F2 - Accept

Accepts the screen parameters and logs off the specified port.

Prompts

Port To Log-Off

The port number to be logged off.

System Default Term Def

This screen is accessed by selecting Admin > System House Keeping > Port 
Setup > System Default Term Def. Use this screen to set the default terminal 
settings of the OE that take effect whenever you log to a new account. It has 
the same parameters as the Port Setup:Your Terminal Settings (OE) submenu, 
but uses the SET-TERM command rather than TERM. For details, see “Your 
Terminal Settings (OE)” on page 4-216.
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Date and Time Setup

Provides a menu for maintaining the system date and time.

Display System Date & Time

Displays the current date and time for the system.

Set International Date Format

Sets the system date format to International: dd/mm/yy

This option affects the entire system and normally requires setting one time 
only.

Set American Date Format

Sets the system date format to American: mm/dd/yy

This option affects the entire system and normally requires setting one time 
only.
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List Available Disk Space

This screen is accessed by selecting Admin > System House Keeping > List 
Available Disk Space. It displays details of available space on your system, 
determined at the moment the option is selected.
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Accounts

The Accounts menu allows you to list, create, update, and delete accounts.

An account is a logical grouping of files and system IDs. Your system disk is 
divided into one or more accounts. Each system must have at least one 
account, in which you create your applications (such as Accounts Receivable, 
Accounts Payable, and General Ledger). You might keep complementary 
applications in one account and separate more sensitive applications (such as 
Payroll) into other accounts.

The security system allows control over access to accounts. Accounts can be 
saved as entities and can be easily transferred to other machines.

List Accounts

This screen is accessed by selecting Admin > System House Keeping > List 
Accounts. It lists existing accounts on the system. For further information, 
see your OE documentation.
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Create An Account

This screen is accessed by selecting Admin > System House Keeping > 
Create an Account. It allows you to create a new account.

Function Keys

F2 - Accept

Accepts the screen parameters and initiates account creation.

F9 - Acc Notes

Allows you to enter a more detailed description of the account. For example:

This account is for use by the Finance Department to process 

Accounts Receivable.

Prompts

Account Name

The name of the account to be created. The account name must be unique.
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Description

The description for the account being created. This description is used within 
headings if SB+ is installed in this account.

SB+ Account (Y/N)

Options are:

Full Account Path

The full pathname for the account.

System Id

Identifies the SB+ systems to be created in the account; for example, PO for a 
Purchase Orders system. Multiple system IDs are allowed in an account.

System Menu Description

A description for the system ID to appear in the System menu and as a 
heading for the main menu when in this account and system ID.

Value Description

Y SB+ is to be installed in the account being created. 

N SB+ is not to be installed. 

SB+ Account Options 
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Update An Account

This screen is accessed by selecting Admin > System House Keeping > 
Update an Account. It allows you to convert an existing account into an SB+ 
account and to change its description.

Function Keys

F2 - Accept

Accepts the screen parameters and initiates the process to upgrade an 
account.

F8 - Add In An Account

Allows you to specify an additional account to which to apply the update.

F9 - Acc Notes

Allows you to enter a more detailed description of the account. For example: 

This account is for use by the Accounts Dept to process invoices
  4-224



E:\SVN\SB55\doc_set\sbplus\administration\4Admin.fm
5/13/14 
Prompts

Account Name

The name of the account you want to modify or to which you want to add 
SB+. The account must have been previously created.

Description

The description of the account. This description is used within headings if 
SB+ is installed in this account.

SB+ Account (Y/N)

Options are:

Full Account Path

The full pathname for the account.

Initial Sys Id

The system ID for the first system to be created in the account; for example, 
PO for a Purchase Orders system. While multiple system IDs are allowed in 
an account, this prompt only applies if you are updating from a non-SB+ 
account to an SB+ account.

Note: To add a new system ID to an existing account, use Admin > SB+ Setup > 
Initiate New System in that account.

Menu Description

A description for the system ID. This will appear in the System menu and as 
a heading for the main menu when in this account and system ID.

Value Description

Y SB+ is to be installed into the account being created.

N SB+ is not to be installed.

SB+ Account Options 
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Delete An Account

This screen is accessed by selecting Admin > System House Keeping > 
Delete an Account. It allows you to delete an account.

Deleting an account destroys all data held in that account. Be sure to make a 
backup before deleting the account.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to delete an account.

Prompts

Account(s) to Delete

The name of the accounts to be deleted, separated by spaces.

Display Files (S/P/N)

Options are:

Value Description

S Displays the names of files being deleted to the screen.

P Sends the names of files being deleted to the printer.

N Does not print or display the names of files being deleted.

Display Files Options 
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Export SBClient Settings

Existing customers who installed SBClient 5.4.4 or earlier may have session 
configurations, scripts, phone books, toolbars, and Smart Query definitions 
that can be used in SBClient 5.5.0 or later.

If you want to save settings from SBClient 5.4.4 or earlier, you can export the 
settings to a file before installing SBClient 5.5.0 or later. After installing the 
latest version of SBClient, you can then import the files containing the 
settings that you saved.

For details on exporting and importing SBClient settings, see Chapter 2, 
“Installing SBClient on a Stand-alone PC,” in SBClient Getting Started.
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About Office Features

The Office menu provides a range of office automation tools, including a 
diary for managing interoffice mail, activities, and contacts.

Office Menu Options

The options of the Office menu are summarized below. The sections that 
follow explain these options in greater detail.

Menu Option Description

Diary Allows you to maintain your diary. 

Receive Message Displays a summary of messages sent to you. You can read 
the full text of any message and reply to and delete 
messages.

Send Message Allows you to compose and send a message to selected 
users.

Office Menu Options 
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Purge Messages Allows you to purge read messages, either up to and 
including a specified date, or all read messages.

Activity Allows you to create or amend activities. These activities 
may become either scheduled events, appointments, or to-
do activities.

Contacts Allows you to maintain contact details (company names, 
contact names, addresses, and telephone numbers).

Categories and 
Projects

Allows you to enter details of categories and projects. You 
can then reference these in activities and use them to 
classify contacts.

Reports and Enquiries Provides a menu of reports based on your diary, activities, 
categories, and projects.

Calculator Opens the SB+ calculator.

Diary Configuration Allows you to tailor the configuration of your diary.

Time Zone 
Maintenance

Allows you to maintain city time zone definitions used by 
the TIME process.

Maintain Repeat Flags Maintains diary repeat flags used when producing 
calendar summary reports.

Menu Option Description

Office Menu Options (Continued)
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Diary

Process /DIARY

Diary Functionality

The Diary tool allows you to maintain to-do items, scheduled appointments, 
contacts, and messages. Any activity can be converted to any other type of 
activity.

You can make the contents of the diary private to the user, or shared between 
a number of selected users (specified at the Diary Configuration > Diary 
Private Flag (P/E) prompt). 
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Function Keys

Note: Function keys differ in the calendar section of the diary and these are defined 
in the Calendar Prompts section following.

F2 - Save

Saves the diary contents.

F4 - Del Line

Allows you to delete an appointment or to-do line. The activity is deleted 
only when you save the Diary screen, using the F2 or F8 key.

F5 - More

Allows you to view and amend details for the current activity, determined by 
the current cursor position. If the activity has a time and date associated with 
it, that activity becomes an appointment. If more information is available for 
an activity, an ∗ is displayed below the column heading M.

F6 - Message

Allows you to send and receive messages. You are prompted for the type of 
action required. Using the F6 key at an appointment or to-do line allows you 
to optionally send details of the appointment or to-do line as a message.

F7 - Contacts

Displays the Contacts screen, allowing you to add or amend contacts.

F8 - Exit

Saves details and exits the diary without prompting for another date.

F9 - Swap

Swaps from the To Do List section of the diary to the Appointments section 
and vice versa.
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F10 - Action

Displays the action bar:

Calendar Prompts

Owner

The owner of this diary.

Date

Press the F3 key to select a date. The F5 and F6 key move the calendar forward 
and backward one month, while the F7 and F8 key move it forward and 
backward one year. The F9 key allows you to specify an internal format date.

Appointment or To Do

Options are:

Action Description

Calc Displays the SB+ calculator.

Time Displays the SB+ world time zone display.

Owner Allows you to access the diary of another user. Security 
restrictions apply.

Sort Allows you to sort the to-do list and appointments into 
priority and time order.

Reports Provides a menu of various office automation reports.

Help Provides a menu of help options.

Action Bar 

Value Description

A Displays the Appointments section of the diary.

T Displays the To Do List section.

Appointment/To Do Options 
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To Do Prompts

P

A priority level for this item in the to-do list. This value is used when sorting 
the to-do list. Any input is acceptable.

S

Assigns a status to the to-do list activity. Any input is acceptable. D means 
Done and removes the activity to the archive DMDIARY.ARCHIVE. Any other 
status is carried forward.

M

An ∗ indicates more text that can be viewed using the F5 key.

To Do List

The activity or summary for the to-do list. Use the F5 key to enter more 
detailed text. If you add a time, the activity becomes an appointment.

Appointment Prompts

Time

The time (in a 24-hour clock this is either hhmm or hh:mm) at which the 
activity is due to take place. Enter P and a priority number to change this to 
a to-do activity.

Durn

The optional duration of the activity in hours and minutes (this is either 
hhmm or hh:mm).

S

The status of the activity. D indicates that this activity is done, and moves the 
activity to the archive file called DMDIARY.ARCHIVE. Any input is accepted.

M

An ∗ indicates more text that can be viewed using the F5 key.
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Scheduled Activity

A summary of this activity. Use the F5 key to enter more information. If you 
remove the time, the activity becomes a to-do item.
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Receive Message

Displays a summary of all messages you have received. You can read the full 
text of your messages and delete or reply to the messages as appropriate. Use 
the cursor keys to move to the required message.

An N in the Prio column indicates that this message is new and you have not 
read it. An ∗ in the M column indicates that there is more text, which you can 
view by pressing the F5 key. 

To indicate that you have read your mail, press the F5 key on the message 
line, press the F4 key to delete the line, or press the F6 key to reply to the 
message. An r beside the message ID indicates you have replied (an r is also 
displayed in the Priority field of the sender’s Send Message screen). When 
you save the message, the date and time at which you read the message is 
shown at the Read prompt in the sender’s Send Message screen.

Function Keys

F2 - Accept

Saves the current record of messages and their status.
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F4 - Del Line

Deletes the entry on the current line.

F5 - More

Accesses any additional text for the message on which the cursor is 
positioned. An ∗ indicates that there is more text to be read.

F6 - Reply To

Allows you to reply to the sender of the current message.

If a message is private, you can send a reply to the originator only. If any non-
originating recipients are present, they are removed and the following 
message displayed:

YOU MAY ONLY REPLY TO THE ORIGINATOR OF A PRIVATE MSG

The reply is then sent to the originator.

F7 - Msg Outg

Displays the Send Message screen, allowing you to send a new message.

If the cursor is positioned on a private message, you will receive the 
following message:

WARNING A PRIVATE MESSAGE MAY NOT BE FORWARDED

You are not prevented from entering the Send Message screen from where 
you can send other messages, but you are prevented from sending the 
current private message.

If you attempt to send the current private message you are again warned, and 
the Send Message screen is redisplayed.

F8 - Convert

Converts the current message into a scheduled appointment or to-do activity.

F9 - Time

Displays the SB+ world time clock. 
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Prompts

Prio

An N indicates this message is new and has not been read by you. An r 
indicates the message has been replied to.

Note: Any value can be used by the originator of the message.

Msg Id

The message ID created automatically by the send-message process.

M

An ∗ under the M column indicates more text is available. Press the F5 key to 
view this additional information.

Summary/RE

The summary entered by the originator of the message.

Sender

The user ID of the sender.

Sent

The date the message was sent.
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Send Message

Allows you to enter and send a message to selected users, or to review a 
previously sent message.

Function Keys

F2 - Save

Saves the message and sends it.

F4 - Del

Deletes the message.
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F5 - More

Allows you to convert the message to an appointment or to-do activity.

F6 - Status

Displays a summary of outgoing messages and shows the number of people 
who have read each message.

F7 - View Reply

Allows you to view a reply.

F8 - Msg In

Allows you to access the Incoming Messages screen.

F9 - Time

Allows access to the SB+ world time clock.

Prompts

Message ID

Accepts the default value NEW if entering a new message. Enter a message ID 
if amending or viewing an existing message.

Sender

(Display only.) The user ID of the sender.

Message/RE

A summary of the message. This will be displayed on the recipient’s 
Incoming Messages screen.

Full Text

The (optional) full text of the message.
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Recipient(s)

The user IDs of any recipients for the message. Alternatively, enter a group 
ID to send the message to all users in the specified group.

Read

 (Display only.) If a message that was sent has been read, this shows the date 
and time at which the message was read by each recipient.

Reply

(Display only.) If you received a reply to a message, this shows the date, time, 
and message ID of the reply.

Private Message (P/E)

Options are:

Priority

An (optional) priority level determining the order in which messages are 
displayed on the recipient’s Incoming Messages screen. 1 is the highest 
priority.

Value Description

P The message is private, to be read by recipients only, and 
not to be forwarded. A recipient can reply to the originator 
only.

E Encrypts the message using your diary access code 
(specified at the Security > User Security Setup > Diary 
Access Code prompt).

Private Message Options 
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Alert Recipient(s) Immediately (Y/N)

Options are:

Sent Date

The date on which the message was sent.

Sent Time

The time at which the message was sent.

Value Description

Y Alerts all recipients currently logged on. A summary of the 
message is displayed on their terminals.

N Does not interrupt users, but displays the message flag 
when the OA.MSG process is invoked.

Recipient Alert Options 
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Purge Messages

Process /MESSAGE.PURGE

Allows you to purge messages that have been read (the status N has 
disappeared from the Prio column of the Incoming Messages screen).

This option does not remove messages from the diary archive file; it removes 
references to the message from the user's message list.

Prompts

Purge All Read Messages

Options are:

Purge To and Including Date

Only messages read up to and including the specified date are purged.

Value Description

Y Deletes all read messages for the current user. 

N (Default.) Allows you to use the Purge To and Including 
Date option to specify a date up to which messages will be 
purged.

Purge All Message Options 
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Activity

Allows you to create or amend activities. An activity is any transaction within 
the office system. It can be an appointment, a to-do item or a message (sent 
or received).

Any type of activity can be converted into any other type. For example, a to-
do activity can be changed to an appointment by adding a scheduled date 
and time to it. An appointment can be sent as a message using F6-Message 
while the cursor is positioned on the message in the Diary screen.
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Function Keys

F2 - Save

Saves the activity parameters.

F4 - Del

Deletes the current activity record.

F5 - More

Allows you to add or amend information at the Contact Company, 
Categories, and Project prompts, if available.

F6 - Repeat

Opens the F6-Activity Repeat Definition subscreen, which allows you to 
repeat an activity (such as weekly meetings or anniversaries). 

F7 - Recipients

Displays the Send Message screen.

F8 - Msg In

Allows you to access your incoming message details.

F9 - Time

Displays the SB+ world time clock.

Prompts

Activity Key

You can accept the default value NEW if entering a new activity, otherwise 
enter the activity code. Type the first part of the summary text and press the 
F3 key to access the activity.

Owner

(Display only.) The owner of the activity.
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Appointment/ToDo/Msg

Options are:

You can do any of the following:

■ Change an appointment to a to-do item or post it as a message. 

■ Change a to-do item to an appointment or post it as a message.

■ Change a message to an appointment or change a to-do item.

Summary/RE

A summary of, or reference to, the activity. This summary is used whenever 
the activity is displayed in a diary.

On

Either the actual date of an appointment or the date for which a to-do item is 
displayed in the diary to-do list.

at

The time of the appointment. Leave blank if A is entered at the 
Appointment/ToDo/Msg prompt above.

for

(Optional.) The duration of the appointment.

Value Description

A Appointment (scheduled activity). An appointment has a 
date and time allocated to it.

T To-do activity. A to-do activity has a date allocated to it, but 
no time.

M Message. A message has a date and list of recipients 
allocated to it.

Appointment/To Do Options 
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Priority

(Optional.) The priority level for this activity. This determines the order of the 
display in the diary. Any input is acceptable. 0 is higher than 1 and 1 is higher 
than A.

Status

(Optional.) The status of the activity. D (Done) archives the activity in the 
DMDIARY.ARCHIVE file. Any input is accepted.

Private

Options are:

If blank, the activity details are accessible to all users. The default is taken 
from your diary configuration.

Full Text

The full text required for the activity. The F5 key from the Diary or Message 
screen recalls this text.

Contact Company

The company code of any company that has contact persons associated with 
the activity. The F3 key accepts company names, sort IDs, or contact names to 
retrieve their associated company.

Name

(Optional.) The name of the person to contact within the company selected.

Value Description

P The activity is Private and restricted to nominated users. 

E Encrypts the activity using your diary access code 
(specified at the Security > User Security Setup > Diary 
Access Code prompt). 

Activity Privacy Options 
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Telephone

(Optional.) The telephone number of the contact.

Categories

(Optional.) The category code associated with the activity.

Projects

(Optional.) The project codes associated with the activity.

Activity Repeat Definition F6

This screen is invoked by the F6 key from the Activity screen. It allows you to 
specify activities that repeat at specific intervals (such as birthdays, 
anniversaries, or weekly meetings).

Function Keys

F2 - Save

Saves the activity repeat parameters.

F9 - Repeat Flags

Displays the Repeat Flags subscreen.
  5-21



E:\SVN\SB55\doc_set\sbplus\administration\5Office.fm
5/13/14 
Prompts

Repetition Type Flag

The letter denoting the type of repetition. This is used when reporting. The 
type flags are maintained from the Diary Configuration screen or by the F9 
key.

Repeat Expression

The repeat expression determining when the activity is to be repeated within 
your diary. The format is:

day[,dayofweek,];[weekinmonth,];[monthinyear,]

where:

day is an actual date if no week or month is given; otherwise, it is the day of 
the week or the day of the month. For example, 1;; is the first day (Monday) 
of every month, because no specific month is specified.

dayofweek is an optional day in the week. You can separate different days with 
commas. For example, 1,2,3;1; is the first, second, and third day of the first 
week in every month.

weekinmonth is the optional week of a month. You can separate different 
weeks with commas. For example, 5;1,2,3,4,5; is the fifth day (Friday) of every 
week (1, 2, 3, 4 and 5) in any month.

monthinyear is the optional month in the year. You can separate different 
months with commas. For example, 25;;12 is the 25th day of month 12 
(December).
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Contacts

Process /CONTACTS

Allows you to maintain company names, contact names, addresses, and 
phone numbers for contacts.

Function Keys

F2 - Save

Saves the contact parameters.

F4 - Del

Deletes the current record.
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F5 - Categories

Allows you to allocate contacts to any optional categories.

F6 - Address

Allows you to enter a contact’s delivery and postal address.

F9 - Time

Displays the SB+ world time clock.

Prompts

Contact ID

You can accept the default value NEW if entering a new contact, otherwise 
enter the required contact code. You can enter part of a contact name, or an 
alternative ID (Sort & Alt) and then press the F3 key.

Owner

(Display only.) The owner of the contact.

Priv

Options are:

If blank, the contact details are accessible to all users. The default is taken 
from your diary configuration.

Value Description

P Contact details are Private to you and the diary users 
nominated in your diary configuration.

E Encrypts the contact details using your diary access code 
(specified at the Security > User Security Setup > Diary 
Access Code prompt).

Contact Detail Privacy Options
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Phone

The telephone number for the contact. The first number entered is used as the 
default for the contact names entered below.

Company Name

The company (or equivalent) name for this contact. This is displayed 
whenever you reference the contact within a diary activity.

Sort & All

Alternative IDs for the company name. The first ID entered is used for 
sorting. Other IDs are used for alternative access.

Fax

The fax number for the contact being defined.

Contact Names

The names of any contacts for the company being entered.

Contact Title

(Optional.) The title normally used for this contact. 

Telephone

The telephone number for a contact. The default is the first number entered 
at Phone.

Notes

(Optional.) Any notes about the contact. 
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Categories and Projects

Allows you to enter details for categories and projects. These can then be 
referenced in activities and used to classify contacts. You can select and report 
on any activity by category and/or project. 

Function Keys

F2 - Save

Saves the categories and project parameters.

F4 - Del

Deletes the categories and project parameters.

Prompts

Category or Project ID

You can accept the default value NEW if entering new details, otherwise enter 
an existing ID. Enter part of a name or an alternative name, followed by the 
F3 key to select from existing IDs.
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Category or Project Type

Options are:

Owner

(Display only.) The user ID of the owner.

Private

Options are:

If blank, the category and project details are accessible to all users. The 
default is taken from your diary configuration.

Name for Display

The name displayed within a diary or activity, if this category or project is 
referenced.

Alternative Name(s)

Alternative names for this category or project. These names are used as an 
alternative means of access for these details.

Value Description

C Details are for a category.

P Details are for a project.

Category/Project Type Options

Value Description

P The details are private to you and users nominated on your 
diary configuration record. 

E The details are to be encrypted, and can only be decrypted 
by users designated in your user record in User Security 
Setup.

Details Privacy Options 
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Description

Text to describe in detail the category or project being defined.
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Reports and Enquiries

Provides a menu of reports based on your diary, activities, categories, and 
projects. For most reports you have the option of printing either brief 
summaries or full reports.

Reports can be sent to:

Value Description

S The screen (within an optional window).

P The printer, via the spooler.

X An auxiliary port.

D A DIFF format file in xxWORK or another file.

F xxWORK.

B The printer, via a background process.

Report Output Options 
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Calculator

Process /CALC

This option displays the SB+ calculator. In addition to using the calculator as 
a normal calculator, you can enter an expression in the calculator display 
field, and the result is returned in the current input field.

To select numbers or operators, press the appropriate character on the 
keyboard or use the cursor keys to move to the required character on the 
screen and press the Spacebar to accept. Pressing the ENTER or = key performs 
the calculation. 

S changes the sign of a value (from negative to positive and vice versa).
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The options on the calculator are:

Function Keys

F2 - Return Value

Returns the value in the calculator display field to the current input field. 
Alternatively, this value is automatically placed in your input paste buffer; 
you can recall it by pressing your macro key twice. 

F7 - Run Process

Allows you to run a process.

F8 - Move

Allows you to change the position of the calculator on the screen.

Option Description

CLR Clears the current value from the calculator display field.

A/C Clears both the current value from the calculator display 
field and any value in memory.

M/C Clears any value in memory.

M/R Recalls any value in memory to the calculator display field.

M- Subtracts any value in memory from the value in the 
calculator display field.

M+ Adds the value in the calculator display field to memory.

Pcn

(or N from the 
keyboard)

Allows you to define the precision of the results of your 
calculation.

%

(or B from the 
keyboard)

Calculates the percentage of the current value. 

Calculator Options 
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F9 - Expression

Allows you to enter an SB+ expression and display its result.
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Diary Configuration

Allows you to determine the configuration for your diary.

Function Keys

F2 - Save

Saves the configuration parameters.

F6 - Update Xrefs

Rebuilds the various cross-references (for example, activity IDs of incoming 
and outgoing messages) held in DMDIARY. Normally you would use this 
option if you upgraded to a new version of SB+ containing additional 
features, or if you suspect loss of data integrity due to anomalies in your 
diary system.
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Prompts

Activity Default Flag (P/E)

Options are:

Otherwise leave blank. Users who have access to P and E entries are set up in 
the user record within User Security Setup.

Morning Appointment Char

(Optional.) A character to signify a morning appointment in your diary when 
viewing the calendar. For example, m.

Afternoon Appointment Char

(Optional.) A character to signify an afternoon appointment in your diary 
when viewing the calendar. For example, a.

Morning & Afternoon Char

(Optional.) A character to signify both a morning and an afternoon 
appointment in your diary when viewing the calendar. For example, b.

Value Description

P Activity details entered are to be set to private by default. 

E Activity details entered are to be encrypted by default. 

Activity Default Flag Options 
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Default List (A/T/MA/MT)

Options are:

Diary Private Flag (P/E)

Options are:

If you enter E or P and press the ENTER key, the Private Users Access screen 
is displayed wherein you can specify the users that have access to your diary. 
Otherwise leave blank.

Activity Default Priority

Default priority for new activities.

Value Description

A Defaults to the Appointments section when you enter the 
diary. 

T Defaults to the To-Do List section. 

MA Sets the Appointment or To Do prompt on the Diary screen 
to A (move directly to the Appointments section). 

MT Sets the Appointment or To Do prompt to T (move directly 
to the To Do List section). 

Default List Options 

Value Description

P The diary is to be private. 

E The diary is to be encrypted.

Diary Privacy Options 
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Time Zone Maintenance

Allows you to maintain city time zone definitions used by the /TIME 
process.

Function Keys

F2 - Save

Saves the time zone definition.

F5 - Goto City

Allows you to go to a particular city. You are prompted for a line number, 
text, or a multivalued page number.
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F6 - Time

Displays the SB+ world time clock.

Prompts

Local City Name

The name of a city that is in your time zone. (The city must appear in the 
following City list.)

City

The name of a city to have time details entered against it. It is available when 
viewing times in different cities using the /TIME process.

Offset G.M.T.

The number of hours (plus or minus) the selected city is ahead or behind 
Greenwich Mean Time (without taking daylight saving time into account).

w.r.t. Local

(Display only.) The difference ‘with respect to’ the local time.

Std Text

(Optional.) An abbreviation for the normal time zone name used to display 
the time in the specified city.

Day

The day of the month on which daylight saving time or summer time begins. 
If unknown, leave blank. This is used to adjust the lookup time display.

Month

The month daylight saving time or summer time begins.

To Day

The day of the month on which daylight saving time or summer time ends.
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To Month

The month daylight saving time or summer time ends.

Time Text

An optional time zone abbreviation indicating summer time is in effect in this 
city. The default is DLS.
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Maintain Repeat Flags

Allows you to maintain diary repeat flags. These flags are used when 
producing calendar summary reports.

F2 - Save

Saves the diary repeat flag parameters.
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Prompts

Description

A description of the type of repetition; for example, Valentine’s Day.

Value Description

F An alphabetic character used by reports to represent the 
type of repetition. This is the key letter stored on file against 
an activity; for example, V for Valentine’s Day.

L An alphabetic character to be displayed, rather than stored 
on file, representing the repetition type for reports. This can 
be different from that entered in the prompt above if 
multiple languages apply.

Diary Repeat Options 
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About Shell and Logto Features
This chapter describes the two remaining options on the System 
Administration main menu:

Shell allows you to enter an OE command or SB+ process.

Logto allows you to log between accounts without having to re-enter your 
user ID and password for every account accessed.
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Shell
Process /SHELL or /TCL

The Shell option invokes the SB+ shell command line prompt, allowing you 
to enter any OE command or SB+ process (subject to security restrictions).

SB+ initially checks if the first word entered at the prompt is a command, and 
if not, it checks to see whether the first word is an SB+ process.

The shell stack stores the last 100 command lines per user, any of which can 
be recalled for editing or executing. You can also group command lines 
together and place them in a menu for quick access and execution.

Function Keys

F2 - Save

Selects entries from the stack and saves them with their name and description 
and place in the menu.

F4 - Del

Deletes a saved menu stack.

F5 - List

Lists the current stack.

Menu F6

Lists the available saved stacks as a menu and allows selection.

F7 - Edit

Edits the current stack (all entries).
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Stack Commands

You can enter the following stack commands at the shell command line:

If you enter a command with a ? at the end, the command is not executed but 
is pushed onto the stack.

You can also create synonyms for command line strings, using the following 
syntax:

synonym == commandstring

For example:

TO.FIX == LIST SBFEEDBACK WITH TYPE = "P"

Command Description

Up arrow Recalls the previous entry to edit and execute.

Down arrow Recalls the next entry to edit and execute.

.L Lists the last 20 commands on the stack.

.Ln-n Lists the commands on the stack from n to n.

. Recalls the last command to edit and execute.

.n Recalls the stack entry n to edit and execute.

.Xn Executes the stack entry n as is, with no edit.

.n,n-n,n-n,n Multiple executions separated by a comma and/or range 
lists (hyphen-delimited).

.Dn,n-n Deletes the current stack entry, or specified entry.

.Dname Deletes the saved stack referenced by name.

.E Edits the current stack using the screen editor.

.Ename Edits the saved stack referenced by name, using the screen 
editor.

.Un Converts the next n characters to uppercase.

Stack Commands 
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To delete a synonym from the list, use the following syntax:

synonym ==
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Logto

Process /LOGTO

The logto option allows you to log between accounts without requiring you 
to re-enter your user ID and password for every account accessed.

All requests are subject to security restrictions. If you enter a prohibited 
account or option, the message ACCESS DENIED appears and the request 
is denied.

Prompt

Logto Account (or OFF)

Enter the name of the account you want to log to; for example, LEDGERS. You 
are logged to the new account without being prompted to enter your user ID 
or password again.

If you want to log directly to a specific system ID within the account, append 
the system ID after the account name separated by a comma; for example, 
LEDGERS,GL.

To log directly to a menu within a system ID, specify the menu name after the 
system ID. For example, LEDGERS,GL,REPORTMENU.

To log directly to an option within a menu, append the option number to the 
menu name; for example, LEDGERS,GL,REPORTMENU,2.

To log to the SB+ Administration account, you can specify SA (System 
Administration). This is a synonym for SB+.

To log off the system, enter OFF.
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Appendix A: Admin Within 
a User Account
This appendix discusses the functions you can perform from the 
Admin menu within a user account.
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Admin Menu
The Admin option in a user account is very similar to the Admin option in 
the SB+ account.

Some Admin options are available on the menu for the SB+ account only; 
these options do not appear on the user Admin menus. There are also options 
that are different and options that are additional.

Options in the Admin menu (within a user account) are described below.

Files

These options are exactly the same as for the SB+ account.

Printers & Terminals

These options are the same as for the SB+ account except that the Initialize 
Spooler option of the Printer Management menu is not available in the user 
account.
A-2 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\administration\A.fm
5/13/14 
Media Commands

These options are exactly the same as for the SB+ account.

SB+ Setup

The SB+ Configuration Options option is available in the SB+ account only.

Initiate New System

Allows you to create another system ID within the current account. You are 
prompted for the system ID prefix and description, after which the new 
system is initialized. If this is the second (or subsequent) system ID in the 
account, you are presented with a System menu at logon (after entering your 
user ID and password) to select the system you require.

Delete System

Allows you to delete a system ID from the current account. You are presented 
with the System menu from which to select the system to be deleted. A 
lookup window displays all the files created in the system. Tag those you 
want to delete. Normally this is all the files, but there may be some files 
created in this system that are used in other systems which you do not want 
to delete.

Note: Make sure you have a backup of this account before deleting the system in case 
you need to restore data inadvertently deleted.

Logon/Logto Subroutine

Allows you to specify a user subroutine to be called at logon/logto after 
security and print setup have been performed. An SB+ process cannot be 
executed from here and the user subroutine should not contain SB+ function 
calls, because SB+ COMMON variables are not fully initialized at this point.
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System Enquiries

This option has a subset of options found in the SB+ account under the 
System House Keeping option:

Your Terminal Settings (OE)

This is the same option as described in “Port Setup” on page 215.

List Users Logged On

This is the same option as described in “Port Setup” on page 215.

Display System Date & Time

This is the same option as described in “Port Setup” on page 215.

List Available Disk Space

This is the same option as described in “System House Keeping” on page 215.
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Display Where Table

This is the same option as described in “System House Keeping” on page 215.

Detailed System Usage

This is the same option as described in “System House Keeping” on page 215.

List Overflow Fragmentation

This is the same option as described in “System House Keeping” on page 215.

Security

This has the following options:

Group Security Setup

This is the same option as described in Chapter 3, “ Chapter 3: Security 
Menu.”
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User Security Setup

This is the same option as described in Chapter 3, “ Chapter 3: Security 
Menu.”

Edit Your Macro Keys

This option invokes the /UK (User Keys) process to define your macro keys. 
This is described in “Define User Macro Keys (F6)” on page 3-32 in this 
manual and in Appendix K, “Macro Keys” in the SB+ Server Reference Manual.

Change Your Password

Allows you to change your password. You are prompted for your existing 
password before you can enter a new one.

Change Keyboard Timeout

Allows you to change your keyboard timeout – the number of minutes of 
inactivity before your keyboard locks and requires password entry to 
reactivate. You are prompted for your password before you can change the 
timeout.
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Appendix B: Printer 
Management
This appendix contains information on administering the SB+ 
Printer Manager.
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About SB+ Printer Manager
The new SB+ Printer Manager differs substantially from the Printer Manager 
in versions through 2.3.2. However, it retains a number of features in altered 
form, such as stationery types and locations, the COMMON variable 
PRINT.DEFN, and the Printer and Spooler Maintenance functions.

The significant differences are:

■ The way printers are defined and maintained.

■ The way print defaults are determined and used.

■ The printer assignment process.

■ The scope and availability of the Printer Manager to SB+ tools and 
user processes.

■ User interaction in the printing process.

■ The addition of features such as report types.

The diagrams on the following pages provide a schematic representation of 
the new Printer Manager. The Printer Definition and Maintenance section 
provides an outline of the new system, with comparative notes on the old 
Printer Manager. The remaining sections describe the various elements of the 
new system in detail.
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Printer Entity

Start & Stop
Sequences

Physical Class Stationery

Printer Class
such as EPSON

Stationery
such as A4, 15x11

Location
such as Administration

Device
such as PRN:

Form Feeds
Before, After
such as 0, 1

Name
such as ADMIN1

MV Stationery Table
Stationery Set Reset Orientation

*A4 NULL NULL NULL
15x11 NULL NULL NULL
LABELS NULL NULL NULL

Printer Class
such as EPSON

Attribute/Graphic
Set/Reset Sequence

Character
Graphics Table

Standard Cols
& Rows

such as 80, 60

Stationery
such as A4

Columns
such as 80

Rows
such as 60

Report Type
such as 01 15x11

Condensed Cols
& Rows

such as 132, 60

Flags
such as Color N
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PRINTER.SELECT and AUX.SELECT Forms
The PRINTER.SELECT and AUX.SELECT forms (printer and stationery 
front-end processes for system and auxiliary printing) display printer and 
stationery description. Also, the intuitive help for the stationery display 
stationery name in addition to the stationery code.

In GUI mode, a spin button is available for the No of Copies prompt.

In SB+ versions 2.3.2 and earlier, when the default printer presented in 
PRINTER.SELECT or AUX.SELECT process was modified, the stationery was 
also changed to the first stationery entry for the new printer. This behavior 
has been modified to leave stationery intact if it is a valid stationery for the 
newly selected printer.
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Printer Definition and Maintenance

Old Printer Manager

In SB+ versions 2.3.2 and earlier, printers were defined and maintained using 
the Printer Definition screen. This screen defined a hardware specific 
printer, in a similar manner to terminal definitions. The definition also 
included hardware-dependent escape sequences and a graphic character 
equivalence table.

In addition, form queues (which correspond to a UniData/UniVerse form of 
the same name in those environments) and current stationery types and 
locations were defined in the printer definition. The stationery was 
associated with the form queue, with one stationery per form queue. Each 
form queue could be associated with only one printer definition at a time. 
The system printer device number was also uniquely associated with one 
printer at a time.

Printers could have a location specified that was used to prevent assignment 
of a printer where the printer name was not present in the user’s group 
location list.

All printer-related items, such as printer and stationery definitions, were 
stored in the file DMSECURITY.

New Printer Manager

At SB+ version 3.3.1, the new Printer Manager introduced the concept of 
physical printers and printer classes. Instead of keeping all hardware-specific 
information, such as graphics tables and attribute escape sequences, in each 
printer definition, this information is stored in the printer class.

Stationery types are separately defined and attached to the class. Each 
definition is a generic type that can be used in any class, with all stationery 
type set, reset, and page orientation sequences defined uniquely within the 
class, for each class. Thus, any number of classes can have a stationery type 
of A4, with appropriate sequences for that class.
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The printer entity is created by attaching a printer class to a physical printer 
and specifying other parameters. The system uses the physical printer record 
name when starting and stopping printers, and when printing. The physical 
printer record allows any class of printer to be associated with a printer 
entity.

With this system, it is possible to maintain entities such as ADMIN1 or 
ACCOUNTS.LABELS as constants, while being able to change the actual 
printer hardware and device/port configurations to suit current hardware 
specifications.

The Printer Entity diagram shown previously provides a schematic 
representation of the printer entity.

Locations have been redefined. See “Maintain Locations” on page 4-113.

All printer-related items are stored in the file DMSYSDEFN, with the 
exception of the printer control items created at logon and used at run time, 
which are stored in DMSECURITY.

Determining Print Defaults

Old Printer Manager

The default printer was determined using a printer name or the word ASK in 
one of three places:

■ The Port Configure screen.

■ The Defaults subscreen (F10 from the Port Configure screen).

■ The Terminals and Printers subscreen (F7 from the User Security 
screen).

With ASK or ASK(printername) in any of these locations, or a multiple list of 
printers in the latter two locations, a prompt required the user to enter the 
printer name at logon. With a single printer name in any location, this printer 
was used without prompting at logon.

The selected printer’s current stationery type was used to determine the form 
queue, and the printer assignment was performed.
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New Printer Manager

The old default system was retained for compatibility, with the following 
changes. The initial assignment uses the printer name to determine the 
stationery type. The first stationery in the list attached to the physical printer 
record is used as the default, and default Assign Options and No of Copies 
are used.

In addition, the following additional default options are available:

■ Global Print Defaults

■ User Print Defaults

■ Group Print Defaults

These allow a complete specification of the default, with no assumptions 
made. Physical Printer Name, Stationery Type, Assign Options, and No of 
Copies can be specified. See “Setting Print Defaults” on page B-14 for a 
discussion of the defaults hierarchy.

Printer Assignment

Old Printer Manager

At logon, the initial print assignment was performed using the printer name 
as described above. The current stationery type for the printer definition was 
used to determine the form queue.

In order to reassign printers, the Assign Form Queue screen was invoked. 
This allowed the user to nominate a form queue to which to change. Selection 
of the form queue also selected the printer definition and stationery type with 
which the form queue was associated.

Users could not directly request a change in form queue from a report or 
other print request without invoking the /PTR.ASSIGN process at the output 
redirection prompt or incorporating the process in the report. A change in 
printer assignment could be effected from Query and Report Writer reports 
using the Assign Printer To A Report tool.
 B-9



E:\SVN\SB55\doc_set\sbplus\administration\B.fm
5/13/14 
This allowed you to enter a stationery type and/or location name in the 
process definition of the report. When the report was printed, the printer 
parameters specified in the process definition were used to reassign the 
printer for the job, and the original environment was restored on completion. 
This process was invisible to users.

It was possible to change the current printer definition in use (and 
consequently PRINT.DEFN and the form queue) on the fly using the 
CHANGE.PRINTER process.

New Printer Manager

At logon, the default print parameters described above are determined and 
an initial assignment is performed based on these defaults.

Assignment within SB+ Tools is done on a per-print request basis. That is, 
when a report or tool print is requested, the user is prompted (if authorized) 
to use the defaults (either the user defaults or report print parameters) or 
change the printer for the current request. If display of the prompt screen is 
not authorized, the defaults are used without user intervention. After the 
selection is made, the parameters are saved and the new assignment is 
performed.

After the job is printed, the printer environment that existed prior to the 
selection is reinstated. The printer stack and printer assignment can be 
controlled from user processes. For further information, see “Using Printer 
Manager Calls in User Subroutines, Paragraphs, and Processes” on page B-
16.

The Assign Printer To A Report process has been retained, with the following 
changes: location and/or stationery are no longer used to determine the 
printer to assign. The printer name and stationery type are explicitly 
specified, and when printing the report, these parameters are displayed 
instead of the user defaults in the prompt screen, where they can be changed 
if required.

You can change the default assignment used (and consequently the default 
PRINT.DEFN) for the life of the current logon session, including logging to 
other accounts, using the CHANGE.PRINTER process (described later). 
Logging off and on resets the environment to the defaults.
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Starting & Stopping Printers

Old Printer Manager

In UniVerse, creating a printer definition started the printer; it created an 
entry in the sp.config file and a device in the &DEVICE& file. The printer was 
stopped by deleting the printer definition; the entry for the printer was 
removed from sp.config and the device from the &DEVICE& file.

Similarly, if UDT:Print was installed in a UniData environment, creating a 
printer definition started the printer, and deleting the printer definition 
stopped the printer.

The Maintain Printers screen was used to display currently started printers 
and, if the user was a superuser, to enable or disable the printing for the 
printer on the current cursor line.

New Printer Manager

The Maintain Printers screen is now used for starting and stopping all 
printers, and for modifying the parameters used to start the printer (entered 
in the Physical Printer Definition screen).

Printer Manager Scope and Availability

Old Printer Manager

Users were only able to use the Assign Printer To A Report tool to change the 
printer (without invoking the PTR.ASSIGN process in Query and Report 
Writer reports). They had no access to the Printer Manager from subroutines 
or processes.

New Printer Manager

All SB+ tools that have a printing option use the new Printer Manager 
program SH.PRINT.MANAGER to control printing. Users are able to call this 
subroutine from their own processes, subroutines, and SB+ paragraphs. For 
examples of calling this subroutine, see “Using Printer Manager Calls in User 
Subroutines, Paragraphs, and Processes” on page B-16.
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User Interaction

Old Printer Manager

There was no user interaction at print time. When printing was selected, the 
currently assigned printer was always used. Reports with print parameters 
attached allowed a one-time change of assignment, but again without user 
interaction.

New Printer Manager

In all SB+ tools, the Printer Selection screen is displayed, with either the 
current user defaults or the report parameters. This screen allows users to 
change the physical printer, stationery type, assign options, and number of 
copies for the current print job, or accept the parameters presented.

The display of this screen can be controlled with a flag in User Security 
and/or a flag in the process definition of a report. For a detailed discussion 
of this topic, see “Printer Selection” on page B-13.

New Features

A number of features were added in the new Printer Manager:

■ Third-party printer management hook point. This allows you to 
specify a process in the System Control Record, which either 
bypasses the SB+ Printer Manager or operates in conjunction with it.

■ User print redirection hook point. This allows you to specify a 
process in the System Control Record, which either bypasses SB+ 
output redirection prompts or operates in conjunction with them.

■ Output to print file or to DIFF format items. These options allow a 
Report Writer report to have its print output stored in a print file, or 
the data normally displayed in the report to be written out in DIFF 
file format for export to a DOS spreadsheet.

■ Report Writer and Query reports have new printer management 
related hook points.
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■ Report types. These allow you to group reports to one or more 
printers, and to nominate appropriate stationery for all reports in the 
group.

Printer Selection

When printing is requested, Printer Manager may display the Printer 
Selection screen (shown above) with the current print parameters. The 
option to display the Printer Selection screen is set for each user in the User 
Security Setup screen, or by using the /USER.FLAGS process. Depending on 
the value of this flag, the screen may be displayed for all of the user’s print 
tasks, for Report Writer, Query, and user defined user subroutine reports 
only, or never displayed. An optional flag in Report Writer and Query 
reports, or optionally passed from a user subroutine report may be specified 
to override the user security flag.

You can include physical printers in a location record. You can designate 
valid locations for a given group so that a member of that group only has 
access to the printers in the locations specified. Subject to this restriction, you 
can alter the parameters in the Printer Selection screen, including the Printer 
Name, Stationery Type (which must be a valid stationery type in the class 
attached to the physical printer), Assign Options (which vary depending on 
the platform), and No of Copies.
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Relationship With Other Tools

All printing functions in SB+ use the new Printer Manager to control 
selection of printers. The CHANGE.PRINTER process changes a user's defaults 
for the current session only.

Function Key

F2 - Accept

Accepts the print parameters, and proceeds with printer setup and printing.

Setting Print Defaults

The following hierarchical system is used to establish the print defaults for a 
user at logon. These defaults are displayed in the Printer Selection screen 
when printing (where allowed), or used as the printing defaults when no 
selection is permitted:

1. Physical printer names or the word ASK present in User Security 
Setup > F7-Term/Print. If ASK is present, the user is prompted for a 
physical printer name. If a list is present the user is solicited for the 
printer name, and the ∗ help list contains the names specified in the 
list. Any valid physical printer name is accepted.

2. ASK specified at the Printer Name prompt in the Port Configuration 
screen for the current port. The user is prompted for a physical 
printer name. Any valid physical printer name is accepted.

3. Multivalued list of physical printer names or the word ASK present 
at the Printer Name prompt in the Default Terminal/Printer 
Specification screen. If the word ASK is present, the user is 
prompted for a physical printer name. If a list is present, the user is 
prompted for a printer name, and the ∗ help list contains the names 
specified in the list. Any valid physical printer name is accepted.
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4. User-specific print defaults can be set up in the user security record 
from the User Security Setup screen, using the F10 key action bar 
Print Defaults option. In the User Print Defaults subscreen, the 
system administrator can specify Physical Printer Name, Stationery 
Type, Assign Options, and No of Copies specifically for individual 
users. A cross-check of locations is made so that default physical 
printer and stationery types cannot be assigned to a printer outside 
the group locations.

5. Printer name specified in the Port Configuration screen for the 
current port if not ASK. The default stationery type (the first) is read 
from the physical printer definition stationery type table. A default 
assign option of P or the platform equivalent is assigned, and a 
default of 1 copy is assigned.

6. Group-specific print defaults can be set up in the group security 
record using the Print Defaults option in the F10 key action bar in the 
Group Security Setup screen. In the Group Print Defaults 
subscreen, the system administrator can specify Physical Printer 
Name, Stationery Type, Assign Options, and No of Copies 
specifically for a group of users. A cross-check of locations is made 
so that the default physical printer and stationery types cannot be 
assigned to a printer outside of the locations in the group’s parents.

7. Global print defaults. These are set up in the System Administration 
account (SB+) from the Admin > SB+ Setup > SB+ Configuration 
Options > Global Print Defaults option. In the Global Print 
Defaults screen, the system administrator can specify Physical 
Printer Name, Stationery Type, Assign Options, and No of Copies.

8. Default printer name defined in Port Configure defaults if a single 
printer name is entered (not ASK or a multivalued list). The default 
stationery type (the first) is read from the physical printer definition 
stationery type table. A default assign option of P or the platform 
equivalent is assigned, and a default of 1 copy is assigned.

9. If none of the above are present, the default physical printer record 
DEFAULT.PRINTER, using the default printer class DEFAULT.CLASS, is 
used. The default stationery type (the first) is read from the physical 
printer definition stationery type table. If no stationery type is 
present in the table, the standard column and row values in the 
printer class are used. If these are not defined, default column and 
row values of 80 and 60 are used. A default assign option of P or the 
platform equivalent is assigned, and a default of 1 copy is assigned.
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Using Printer Manager Calls in User Subroutines, Paragraphs, 
and Processes

User Subroutines

The program SH.PRINT.MANAGER controls all printing functions in the 
Printer Manager. You can include calls to SH.PRINT.MANAGER in user 
subroutines, to set report parameters, as in the following code example:

PARAM = "SRP,":REPORT.TYPE:",":PHYSICAL.PRINTER
PARAM = PARAM:",":STATIONERY:",":ASSIGN.OPTS
PARAM = PARAM:",":NO.OF.COPIES:",":PRINT.SEL.FLAG
CALL SH.PRINT.MANAGER

where:

REPORT.TYPE is the report type assigned to the report.

PHYSICAL PRINTER is the name of a physical printer.

STATIONERY is the name of the selected stationery type.

ASSIGN.OPTS are platform specific assign options. For details of assign 
options, check your OE documentation.

NO.OF.COPIES is the number of copies to be printed.

PRINT.SEL.FLAG overrides the current state of the Printer Selection screen 
display flag setting in the User Security Setup screen. See the discussion of 
this flag in “Other Features” on page B-19.

Use the following call to reset the printer to the previous environment:

PARAM = "R" ; CALL SH.PRINT.MANAGER

Printers can be stacked on as often as required. Be sure to match all S type 
calls with corresponding R type calls. With S type calls, use the PRINTER ON 
statement to set the environment to Print mode. Do not use PRINTER OFF and 
PRINTER CLOSE because the R type call performs these statements after any 
physical printer and/or stationery type reset sequences are printed. If you use 
PRINTER OFF and PRINTER CLOSE in this case, you may get two jobs on the 
spooler instead of one.
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Paragraphs

Using the EXEC command, you can call the Printer Manager from a 
paragraph. In this case, you must use the comma-delimited parameter form. 
The following example illustrates the method:

LOCAL I
EXEC "B:SH.PRINT.MANAGER,S"
IF @RTN.FLAG THEN EXIT
PRINTER ON
FOR I = 1 TO 10

CRT I
NEXT I
EXEC "B:SH.PRINT.MANAGER,R"

Note the use of the S parameter. If the User Security Setup screen display flag 
is set to Y, this parameter displays the user defaults. This is the non-report 
mode of calling SH.PRINT.MANAGER. In this mode, report parameters 
REPORT.TYPE and PRINT.SEL.FLAG are not tested. You can use the syntax 
shown above in the User Subroutine subsection, suitably translated to 
paragraph format.
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Processes

You can use user subroutine processes to perform these functions from 
anywhere in SB+, where appropriate. The following two PD.B screens 
illustrate this method:

In this case, the SRP parameter is used so that the Printer Selection screen 
display can be forced regardless of the user’s security flag setting.
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Other Features

Hook for Third-Party Printer Management

A hook point in Printer Manager allows you to specify a third-party printer 
management/add-in process, the name of which is stored in the record 
PARAMS in the xxCONTROL file for each system ID. You can also specify an 
@RTN.FLAG value within the user process to bypass the SB+ Printer Manager 
completely or to function normally in addition to the user process. 
@RTN.FLAG may be:

User Print Redirection Prompt

You can specify print redirection processes to replace the current prompts in 
SB+, as in the Screen,Printer,auX (S/P/X) style of prompt. This allows you to 
bypass SB+ functionality or use it in conjunction with the user process.

These processes are specified for each system at the Prnt Redir Proc On and 
Prnt Redir Proc Off prompts in the System Control Record screen, accessed 
from the Tools > Other Tools/Utilities > House Keeping menu. For further 
information, see your SB+ Server Reference Manual.

The on-process tests @VALUE and @RTN.FLAG on return, and if @RTN.FLAG 
is equal to X, the process aborts completely. If @RTN.FLAG is not equal to X, 
@VALUE is tested for characters corresponding to the enabling keys in the 
SB+ prompt. If present, the SB+ functionality corresponding to that letter is 
performed; otherwise no SB+ functionality is performed.

The off-process, if present, bypasses SB+ off functionality; otherwise SB+ 
functionality is used.

Value Description

0 Use normal SB+ print functionality in addition to user 
process.

1 Do not use any SB+ print functionality; use the user process 
only.

X Stop print job.

@RTN.FLAG Values 
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Redirection features of Report Writer are:

■ Output to a print file.

■ Output to a DIFF file.

■ Background processing (where supported by the platform).

These redirection options provide you with a number of options. In the F8-
More Report Parameters subscreen from the F6-Report Parameters screen in 
the Report Painter, you can enter the following options at the File/DIFF 
Destn: File and Item prompts:

■ To prevent output to a print file or DIFF file, enter NONE at the File 
prompt.

■ To prompt at run time for file and item, enter ASK at the File prompt.

■ To specify a file and item, enter the file and item names at the File 
and Item prompts.

■ To use the default file and item, leave the File and Item fields blank.

In Report Writer, Query, and user reports, you can specify a Printer Selection 
flag to allow the report to override the current setting of the Print Screen flag 
in the User Security Setup screen for the current user without changing it; 
the flag is in effect only for the current run of the report.

For Report Writer, the flag is maintained via the Report Writer Definition > 
Report Parameters > More Report Parameters > Disp Print Sel Screen 
prompt. For further information, see your SB+ Server Reference Manual.

For Query, the flag is maintained via the Query Report Definition > More 
Query Parameters > Disp Print Sel Screen prompt. For further information, 
see your SB+ Server Reference Manual.

See also “Using Printer Manager Calls in User Subroutines, Paragraphs, and 
Processes” on page B-16.

The available options are:

Value Description

A Always display the Printer Selection screen.

N Never display the Printer Selection screen.

Printer Selection Screen Display Options 
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If the Disp Print Sel Screen field is left blank, Printer Manager uses the 
Printer Selection flag in User Security Setup.

Report Types

Report types provide a method of matching Query and Report Writer reports 
to printers. The system allows you to attach a single valid report type code to 
a report, and attach a list of valid codes to a physical printer. You can use any 
code for any physical printer.

If a valid code is present in a report being printed and a list of valid codes is 
present for the physical printer being selected, an attempt is made to locate 
the report's code in the physical printer's list. If not found, the report cannot 
be printed using the selected printer. Printing to the selected printer is 
allowed if either the report has no valid code, or the physical printer has no 
list.

A central list of valid report types is stored in the record REPORT.TYPES in 
the DMSYSDEFN file. The Maintain Report Types screen (accessed from 
Printers & Terminals > Printer Management) maintains a multivalued list of 
report type codes. Codes can be in any format, but must be unique. You can 
optionally enter a description for each code. This table of report types is used 
in all systems across all accounts.

Note that the report types table is global, so developers need to consider 
uniqueness when creating report types in applications. When the application 
is installed at a customer site, it is necessary to manually update the report 
type table during installation.

Assigning Report Types to a Physical Printer

The Report Type Table subscreen is accessed by F5 in the Physical Printer 
Definition screen. 
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A multivalued list of report types can be assigned to the physical printer 
record using the Report Type Table subscreen. You can enter any valid report 
type, and optionally attach a stationery type. This stationery type must be in 
the printer class currently attached to the physical printer record being 
edited. If a stationery type is attached to the report type and the requested 
report has the matching code, the stationery type specified for the report type 
overrides any other stationery type selection, including any selection made 
in the Printer Selection screen.

Associating Report Types with Reports

Report types are associated with the process definition of a Query or Report 
Writer report. When editing a Query report using the PD.E process, or a 
Report Writer report using the PD.R process, pressing F9 opens the 
Additional Report Parameters subscreen.

You can enter the report type for the report at the Report Type prompt in this 
subscreen, as well as in the Assign Printer To A Report screen. For details of 
report type entry in these screens, see the Assign Printer To A Report section.

Report types can also be used in user subroutines to implement user 
subroutine reports. See “Using Printer Manager Calls in User Subroutines, 
Paragraphs, and Processes” on page B-16.

CHANGE.PRINTER Process

This process allows you to change your current print defaults, as displayed 
in the Printer Selection screen, for the current logon session only. The Printer 
Selection screen is displayed regardless of your Security flag, where you can 
change the current defaults within the location restrictions prevailing.

After selected, the new defaults are displayed in the Printer Selection screen 
for the duration of the current logon session (unless overridden by a report 
assignment). The next time you log on, your normal defaults are restored. 
This process can be disallowed in Group Security if required.

For example, if your current defaults are incorrect (perhaps due to a change 
in the printer entity, such as a change in printer class, stationery type, or other 
parameter), running this process allows you to change the defaults until a 
more permanent change can be arranged with the system administrator.
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SB+ Printer Setup Guidelines

This is a suggested procedure for setting up the SB+ Printer Manager 
definitions in a new installation. Although the structures may seem 
complicated at first, they are designed for maximum flexibility. System 
maintenance to handle changing requirements is small. The setup can also be 
simplified by not defining features that will not be used. For example, 
locations and report types are optional.

The following steps, carried out in the order given, simplify the task of 
defining the various components of the SB+ Printer Manager:

■ Establish how many printers will be connected to the system, and 
what type of printer will be connected to what port.

■ Determine how many printer classes will be required—one for each 
make and model of printer, or for each common emulation.

■ Determine how many stationery definitions will be used. A separate 
stationery type must be defined for the following groups:

❑ Reports that will share the same type of stationery (form queue). 
Note that the same stationery may be available concurrently on 
multiple printers.

❑ Reports that must only be printed on a particular type of 
stationery, such as invoices and checks.

❑ Reports that must only be printed on a particular printer (this 
may also require a particular type of stationery).

■ If the installation requires the use of locations, determine which 
locations will be used. Typically, locations are used to ensure that 
certain reports are directed to a specific room, floor, or building.

■ If the installation requires the use of report types, determine the 
report types to be used. Typically, report types are implemented for 
all reports and printers, and are used to allow printing of a particular 
report on specific printers only.
 B-23



E:\SVN\SB55\doc_set\sbplus\administration\B.fm
5/13/14 
■ Define a stationery type for each type of output that needs to be kept 
separate from all other types. Apart from distinguishing, for 
example, plain paper, checks, and invoices, stationery types can also 
be used to segregate the same type of paper on different printers. For 
example, reports to be printed on plain stationery on the line printer 
in the Accounts department are not confused with reports to be 
printed on plain paper in a warehouse. On those platforms that use 
form queues or form names, a stationery type corresponds to a form 
queue or form name.

■ Define the printer classes and include all the stationery types that can 
be printed in each class. Printer effects such as special fonts and draft 
mode can be defined for each stationery type if required. The reset 
sequence should return the printer to its default settings for any 
reports that do not have specific set and reset sequences.

■ If locations are to be used, define them now and specify which user 
groups have access to them by using the F8 key in Group Security 
Setup.

■ Define the physical printers, and for each include the appropriate 
stationery types, allocating a form queue if the platform requires it. 
If locations are to be used, use the F7 key to specify the location of 
each printer. If report types are to be used, use the F5 key to specify 
the report types that can be printed on each printer. Printer effects 
such as special fonts that apply to all reports or the majority of the 
reports produced on the printer can be defined. The definition 
DEFAULT.PRINTER should be amended appropriately; it will be used 
if a report is not directed specifically to any other printer.

■ For those reports that must be printed on special stationery, use the 
Assign Printer To A Report option to define the relationship. This 
may include specification of hold files and number of copies.

■ If the destination of all reports is predetermined, the Display Print 
Select Screen prompt in User Security Setup should be set to N for 
all users. Otherwise, this flag should be set to Y for any users who 
may select a printer destination at run time.
B-24 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\administration\B.fm
5/13/14 
■ Global print default settings should be defined in System 
Administration in the Global Print Defaults screen. (For further 
information, see “SB+ Configuration Options” on page 4-194.) If any 
groups require different defaults, you can set defaults from the action 
bar in Security > Group Security Setup. If further individual user 
defaults are required, you can set defaults from the action bar in 
Security > User Security Setup.

■ If the DEFAULT.PRINTER setting is not suitable for all users, 
alternatives can be associated with particular ports in Admin > 
Printers & Terminals > Port Configure. A list of printers can be 
defined for an individual user from the F7 key in Security > User 
Security Setup. The first printer listed is the user’s default, and the 
user can direct reports to the nominated printers only.
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Auxiliary Printing
In SB+ version 4, the Printer Manager was further enhanced to provide fully 
featured auxiliary printing, especially in situations in which SBClient is used. 
The new functionality added most of the existing System Printing features to 
the auxiliary print interface, plus some SBClient-specific features.

The following functionality is available with the Printer Manager:

■ Comprehensive system for setting of default auxiliary printer.

■ Options for Display Aux Select Screen Flag of USER.FLAGS process.

■ Selection of the printer and stationery at run time and additional 
print output options for users of SBClient version 4 and later.

■ Assignment of the auxiliary print parameters to individual reports.

■ Use of printer setup sequences specified on printer class and 
physical printer definition records.

■ Logical Printer Definition to provide full use of Microsoft Windows 
print interface.

■ Ability to set the stationery’s number of rows at run time.

Setting the Default Auxiliary Printer

Setting the default auxiliary printer for the SB+ session is very similar to 
setting the defaults for the system printer.

On initial logon, the auxiliary printer default is checked in the User Security 
Term/Printer Setup screen (F7 in SEC.USER.SETUP). If the word ASK is 
present, the user is prompted for a Physical Printer name. If a list is present, 
the user is prompted and the '*' help list contains the names specified in the 
User Security Term/Printer Setup screen.

If the word ASK is specified in Port Configure screen (TERM.CONFIG process, 
F9 subscreen - REFERENCE), the user is prompted for the Physical Printer 
name. Any valid physical printer is accepted.
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If the multilist of Physical Printer names is present in Port Configure screen 
(TERM.CONFIG process, F9 subscreen - REFERENCE) the user is prompted 
for the physical printer and the '*' help list contains the names specified in the 
list.

User-specific print defaults can be set in the User Security screen 
(SEC.USER.SETUP process - REFERENCE) using the Aux Defaults option on 
the action bar (F10). On this screen, the system administrator can specify the 
physical printer name and stationery type to be used.

Group-specific print defaults can be set in the Group Security screen 
(SEC.GROUP.SETUP process) using the Aux Defaults option of the action 
bar (F10). On this screen, the system administrator can specify the physical 
printer name and stationery type to be used. The details entered here apply 
to the whole group.
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Global print defaults can be set in the System Administration account (SB+ 
or SB on some platforms) from the Admin > SB+ Setup > SB+ Configuration 
Options > Global Print Defaults option (process SYS.PRINT.DEFAULT). The 
system administrator can specify physical printer name and stationery type 
to be used.

If none of the above is present, the physical printer DEFAULT.PRINTER is 
used. The default (first) stationery type is retrieved from the Physical Printer 
definition record.

Note: The process CHANGE.AUX.PRINTER can be used to change the current 
default auxiliary printer for the session.
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The SEC.USER.SETUP process contains the Display Aux Select prompt. The 
available settings are:

Note: The W option is enabled in SBClient version 4 and later. If SBClient 4 is not 
detected or if the user is using dumb terminal, this option behaves like Y option; the 
user is prompted for the output details.

Selecting a Printer and Stationery at Run Time

When the report is run and auxiliary output selected, the setting of the user 
flag is checked and appropriate action taken.

The user flag setting of N uses the current session settings for the auxiliary 
printer, it does not display Print Selection screen.

Value Description

Y Always display the SB+ Print Selection screen.

This option prompts the user for the output details every 
time the output is directed to auxiliary print device.

N Never display the SB+ Print Selection screen.

This option bypasses the screen and uses default auxiliary 
output details as determined at logon.

W Display the Windows Print Setup screen only.

This option applies to SBClient sessions only. The Windows 
Print Setup dialog box allows the user to select any printer 
connected to the network. The default Windows printer is 
the one set in SBClient session setup.

Auxiliary Prompt Options 
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The setting of Y invokes the AUX.SELECT process and allows selection of 
printer and stationery:

Function Keys

Note: If you change any of the SBClient print settings and then save the session 
settings, the newly selected options become your default options.

Above processes (Print Options and Print Setup) require SBClient 4 to be 
used. If the processes are invoked from an older version of SBClient or dumb 
terminal, the message “MAY ONLY BE RUN FROM SBCLIENT” is 
displayed.

Function Key Description

F5 - Print Options This key invokes 'Print Options' option of the SBClient File 
menu. The screen allows users to set various print 
formatting parameters. For more details, see your SBClient 
documentation.

F6 - Print Setup Here the user can select the target Windows printer. The 
presented screen is common Windows Print Setup screen. 
This option is the same one as SBClient's Print Setup option 
on the file menu.

Function Keys
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Assignment of the Auxiliary Print Parameters to Individual Reports

You can set the auxiliary output parameters specifically for individual 
reports through the PD.RD.ADDIT.AUX process. This process is accessed 
from the PD.R screen, F9 - Additional Report Parameters, F5 - Aux 
Parameters.

The parameters entered here overwrite any other option set via other print 
default screens and processes. The value of the Disp Aux Sel Screen flag in 
this case can be one of the following: 

Use of Printer Setup/Escape Sequences

Any specific printer setup sequences defined for physical printer and printer 
class definitions (set, reset, orientation, printer start, and printer stop 
sequences) will be sent to the auxiliary output before/after the print job.

These sequences are normally used to select the appropriate physical printer 
settings like page length and orientation before the job is printed and to reset 
the printer after.

Value Description

A Always display the SB+ Print Selection screen.

N Never display the SB+ Print Selection screen.

W Display the Windows Print Setup Screen only.

Auxiliary Printer Parameters 
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Logical Printer Definition Provides Full Use of Windows Print Interface

For SBClient users, the physical printer definition LOGICAL.PRINTER (of 
class LOGICAL.CLASS) greatly simplifies printer setup and does not require 
entry of true escape sequences in Physical Printer/Printer Class definition 
screens. SBClient/SBDesktop translates all printer/font sequences for this 
class at run time to the appropriate sequences suitable for Windows print 
drivers.

The idea behind this concept is that the user need only specify 
LOGICAL.PRINTER as the auxiliary printer type and not set up the 
appropriate class and escape sequences. In SBClient print options (File:Print 
Options from SBClient menu or F5 - Print Options from SB+ Print Select 
screen), select the Use Windows Print Drivers check box. This is required for 
Logical Printer to work correctly. If that option is not selected, the printer 
works in pass-through mode, where all of the characters (including escape 
and graphic sequences) are sent directly to the printer.

Auto Stationery Setting

The auxiliary print interface in SB+ has the capability to automatically 
determine number of lines (page size) when printing via SBClient. This 
eliminates the need for predefined stationery in Printer Manager. If the user 
is using Windows print drivers and auxiliary printing, the number of lines is 
calculated according to paper size, orientation, and SBClient printer font.

To enable this feature, the physical printer LOGICAL.PRINTER must be used 
when output is directed to Auxiliary port. Also, Windows Print Drivers 
option in File:Print Options must be selected.

This functionality is turned off by default. To enable it, edit the SB.CONTROL 
item in DMCONT file and set the value <34,6> to 1.

Note: If the report definitions contains preassigned stationery (via Addit:Aux 
Parameters in PD.R/PD.E), the 'auto stationery' feature does not apply. In that case, 
the number of lines is determined by the stationery attached to the report process 
definition.

Logical Printer Escape Sequences

Note: ESC is used to represent CHAR(27).
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ESC_P8+  Turns ON compressed mode printing. This causes a font point size 
to be selected that will allow 132 characters to be printed across a page using 
the full paper width. Note that the point size used here assumes a fixed pitch 
font so selecting a variable pitch font could cause the text to not reach the 
edge of the page or even run off the right edge.

ESC_P8-  Turns OFF compressed mode printing. This causes a font point size 
to be selected that will allow 80 characters to be printed across a page using 
the full paper width.

ESC_PWnn  Selects a font that will allow nn columns to be printed across a 
page. Note that using ESC_PW132 and ESC_PW80 are equivalent to 
ESC_P8+ and ESC_P8- respectively.

ESC_PLnn Selects a font that will allow nn rows to be printed across a page.

ESC_PU+  Turns underlined printing ON. If the specified font that is being 
used does not support underline then this has no effect.

ESC_PU-  Turns underlined printing OFF.

ESC_PI+  Turns italic printing ON. If the specified font that is being used 
does not support italic then this has no effect.

ESC_PI-  Turns italic printing OFF.

ESC_PB+  Turns bold printing ON.

ESC_PB-  Turns bold printing OFF.

ESC_PV+  Turns reverse video printing ON. Reverse video is where the 
background is shown in black and the text as white.

ESC_PV-  Turns reverse video OFF.

ESC_PF"fontfamily"  This sequence selects a font with the font family name 
specified between the quotation marks "". 

ESC_PP+  Turns pass-through mode ON. Turning pass-through mode on 
means that all text until an ESC_PP- or ESC_PR is encountered is sent directly 
to the printer without being interpreted by the print program. This allows 
existing reports or print jobs that use some if the more complicated printer 
escape sequences to still be used.

Note: Not all printer drivers support pass-through printing.
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ESC_PP-  Turns pass-through mode OFF.

ESC_PR   Resets all printer settings.

Note: Any one escape sequence may contain a number of individual sequences. For 
example, the following sequence selects a compressed bold reverse video font: 
 
ESC_P8+ESC_PB+ESC_PV+

Use of Auxiliary Printer in User Subroutines and Processes

The program SH.PRINT.MANAGER controls all printing functions in the 
SB+ Print Manager. The calls to SH.PRINT.MANAGER can be included in 
user subroutines and process, to set and reset auxiliary printer parameters.

The following is example of the call from user subroutines:

PARAM = "SRPX,":REPORT.TYPE:",":PHYSICAL.PRINTER
PARAM = PARAM:",":STATIONERY:",,,"
PARAM = PARAM:PRINT.SEL.FLAG
CALL SH.PRINT.MANAGER

where:

REPORT.TYPE is the report type assigned to the report.

PHYSICAL.PRINTER is the name of the physical printer as defined in SB+.

STATIONERY is the name of the stationery attached to the printer.

PRINT.SEL.FLAG overrides the current Display Aux Select Screen setting in 
the user security setup (or USER.FLAGS process).

The following call should be used to reset the default auxiliary printer 
settings to the previous state:

PARAM = "RX" ; CALL SH.PRINT.MANAGER
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Using the EXEC command, you can call the Printer Manager from 
paragraphs. In this case, you must use the comma delimited parameter form. 
The following example illustrates the method: 

LOCAL I
EXEC "B:SH.PRINT.MANAGER,SX"
IF @RTN.FLAG THEN EXIT
CRT @TERM.DEFN<3,7>:
FOR I = 1 TO 10
     CRT I
NEXT I
EXEC "B:SH.PRINT.MANAGER,RX"

Notice the use of the S parameter. This parameter displays the user defaults, 
if the User Security Setup screen display flag is set to Y. This is the non-report 
mode of calling SH.PRINT.MANAGER. In this mode, report parameters 
REPORT.TYPE and PRINT.SEL.FLAG are not tested. You can use the syntax 
shown above in the User Subroutine calls as well.
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Auxiliary Print Interface Improvements
At SB+ version 5, auxiliary printing was improved to automatically 
determine the number of lines to use when printing via SBClient. This 
eliminated the need for predefined stationery in Printer Manager. If a user is 
using Windows print drivers and auxiliary printing, the number of lines are 
calculated according to paper size, orientation, and SBClient printer font.

To enable this feature, the physical printer LOGICAL.PRINTER must be used 
when output is directed to the auxiliary port. Also, the Windows Print 
Drivers option in File > Print Options must be selected.

This functionality is turned off by default. To enable it, edit the SB.CONTROL 
item in DMCONT file and set the value <34,6> to 1.

Note that if a report has stationery preassigned via Addit:Aux Parameters in 
PD.R/PD.E, the auto stationery feature does not apply. In that case, the 
number of lines is determined by the stationery attached to the report process 
definition.
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Appendix C: SB+ Control 
Parameters
This appendix contains information on the set of parameters 
used to define the manner in which SB+ processes information 
and presents it in screens and reports. These parameters enable 
the system administrator to customize the behaviors of SB+.
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About SB+ Control Parameters
Many behaviors of SB+ are preferences stored in SB.CONTROL records. The 
parameters are set to standard default values when the product is shipped. 
The system administrator can change the value of most parameters by 
entering information in the SB+ Control Parameters screen.

The settings for these parameters apply to the installation of a specific version 
of SB+ installed on a single server. For example, the settings in the DMCONT 
file for SB+ version 5.3.8 installed on the server ‘americas’ apply only to that 
installation of SB+. These preferences can be changed at any time to 
customize the implementation of SB+.

All SB.CONTROL records are stored in the DMCONT file. The file is 
organized into attribute groups and values within the attribute groups. Each 
parameter has an attribute number and may also have a value number.

■ If a parameter has no related parameters, it is assigned an attribute 
number only.

For example, SB.CONTROL <5> has an attribute number only. There 
are no other parameters related to the prompt line.

■ If a group of parameters share a common characteristic, they are 
assigned the same attribute number. Each parameter within the 
attribute group is assigned a unique value number that corresponds 
to the position in which the value is stored within the attribute 
group.

For example, SB.CONTROL <15.6> is assigned attribute 15 for the 
group of GUI parameters. It is assigned the unique value number 6 
for the position in which the value of the No Refresh parameter is 
stored within this group.
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SB.CONTROL Records
This section describes the purpose of each SB.CONTROL record used to 
define a processing option used by SB+. If applicable, it also lists the valid 
settings and their descriptions.

SB. CONTROL<0>
The key (or item ID) for the master SB.CONTROL record in the DMCONT file.

SB. CONTROL<1>
The delay in milliseconds before checking database function SYSTEM(14).

Valid settings are:

SB. CONTROL<2>

Indicates whether users’ screens are to be translated to a language other than 
the system default language. The Language Code must also be set for each 
user in USER.FLAGS, and translation in the selected language must be set up 
for screens.

Value Description

0 No delay before checking SYSTEM(14).

n (integer 1 or greater) The number of milliseconds delay before checking 
SYSTEM(14).

For UniData, the default setting is 50.

For UniVerse, the default setting is 1.

SYSTEM(14) Delay Settings
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Valid settings are:

SB.CONTROL<3>

Specifies the horizontal position of dialog box titles. The title of a dialog box 
can be either left-justified or centered within the title bar at the top of the 
dialog box.

Valid settings are:

SB.CONTROL<4>

Specifies the line number on which the prompt appears on the screen.

Valid settings are:

Value Description

0 No, do not use other language. This is the default setting.

1 Yes, use other language.

Other Language Settings

Value Description

0 Left-justify dialog box titles. This is the default setting.

1 Center dialog box titles.

Dialog Box Title Settings 

Value Description

n (1 or greater, up to 
maximum number of 
lines on the screen in 
the terminal 
definition)

The line number of the prompt on the screen.

For UniData on UNIX and Windows, the default setting is 
L1.

For UniVerse on UNIX, the default setting is L1.

For UniVerse on Windows, the default setting is 22, which 
is the bottom line of the screen in VT220 and WYSE60 
terminal definitions.

Dialog Box Title Settings 
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SB.CONTROL<5>

Specifies the line number on which the error message appears on the screen.

Valid settings are:

SB.CONTROL<6>

Specifies the line number on which the help reminder appears on the screen.

Valid settings are:

SB.CONTROL<7>

Specifies whether screens created in a system are to contain an accept prompt 
by default.

Value Description

n (1 or greater, up to 
maximum number of 
lines on the screen in 
the terminal 
definition)

The line number of the error message on the screen.

For UniData on UNIX and Windows, the default setting is 
L1.

For UniVerse on UNIX, the default setting is L1.

For UniVerse on Windows, the default setting is 22, which 
is the bottom line of the screen in VT220 and WYSE60 
terminal definitions.

Dialog Box Title Settings 

Value Description

n (1 or greater, up to 
maximum number of 
lines on the screen in 
the terminal 
definition)

The line number of the help reminder on the screen.

For UniData on UNIX and Windows, the default setting is 
L1.

For UniVerse on UNIX, the default setting is L1.

For UniVerse on Windows, the default setting is 22, which 
is the bottom line of the screen in VT220 and WYSE60 
terminal definitions.

Dialog Box Title Settings 
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The standard accept prompt is Accept/Change/Delete/File (A/C/D/F). 
However, the system administrator can change the wording of the accept 
prompt used in screens throughout your system. The text of the accept 
prompt is in the system control file xxCONTROL (where xx is the system 
code for your system).

Valid settings are:

SB.CONTROL<8>

Specifies the maximum number of processes that a user can run 
simultaneously before SB+ issues a warning message.

The default setting is 30. This should be an adequate number of processes in 
any situation, and we recommend that you not increase this number. 
However, the setting can be the maximum number of simultaneous processes 
supported by the database.

SB.CONTROL<9>

Indicates the database on which SB+ is running.

This control is set when you load SB+ on the server. The setting may be either 
of the following:

Value Description

0 No, screens do not contain an accept prompt by default. 
This is the default setting.

1 Yes, screens contain an accept prompt by default.

Screen Prompt Settings 

Value Description

UDATA UniData.

UV UniVerse.

Database Settings 
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SB.CONTROL<10>

Currently not in use.

SB.CONTROL<11>

This flag specifies whether the Field Description is to be converted to mixed 
case.

In the Field Definitions screen, the Field Name is displayed in the case in 
which it is entered. Field Description is based on Field Name; the content is 
the same as the Field Name, but the text can remain in the case in which it 
was entered in Field Name or it can be converted to mixed case (initial capital 
letters and lowercase).

Valid settings are:

SB.CONTROL<12>

This flag specifies whether DISP 2 and DISP 3 convert the message to 
uppercase when displayed at run time.

Valid settings are:

Value Description

0 No, do not convert the Field Description to mixed case. Use 
the same case as the Field Name.

1 Yes, convert the Field Description to mixed case. This is the 
default setting.

Field Description Case Settings 

Value Description

0 No, display the message as it was programmed. This is the 
default setting.

1 Yes, convert the message to uppercase.

DISP 2 and 3 Message Display Settings 
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SB.CONTROL<13,1>

Currently not in use.

SB.CONTROL<13,2>

Currently not in use.

SB.CONTROL<13,3>

Currently not in use.

SB.CONTROL<13,4>

Currently not in use.

SB.CONTROL<13,5>

Currently not in use.

SB.CONTROL<13,6>

Currently not in use.

SB.CONTROL<13,7>

Currently not in use.

SB.CONTROL<14>

Specifies the maximum size of a record, expressed as the maximum number 
of characters per record.
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Valid settings are:

SB.CONTROL<15,1>

When a selection process is run as intuitive help, this setting specifies 
whether the intuitive help displays the available function key options.

Valid settings are:

SB.CONTROL<15,2>

Specifies whether Btree routines used by the database operating environment 
to perform indexing functions are also to be used in SB+.

Valid settings are:

Value Description

0 Unlimited record size.

n The maximum number of characters per record. For 
example, a value of 32256 limits the record size to 32,256 
characters.

Maximum Record Size Settings

Value Description

0 No, do not display function key options in intuitive help.

1 Yes, display function key options in intuitive help. This is 
the default setting.

Function Keys in Intuitive Help Settings

Value Description

0 No, do not use the database operating environment’s Btree 
routines. This is the default setting.

1 Yes, use the database operating environment’s Btree 
routines.

Btree Routine Settings
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SB.CONTROL<15,3>

Specifies whether to inhibit the ability of function keys other than F2 to 
invoke the auto-accept function in the current field in a screen.

Valid settings are:

SB.CONTROL<15,4>

Specifies whether pressing F2 in a dependent field in a grid saves the record.

Valid settings are:

SB.CONTROL<15,5>

Specifies the method used to reset the input value after field validation has 
failed. The input value is normally the value that the user types when editing 
the field; however, in some cases the input value may be changed during the 
validation process.

Value Description

0 Do not inhibit the ability of function keys other than F2 to 
invoke the auto-accept function in the current field. This is 
the default setting.

1 Inhibit the ability of function keys other than F2 to invoke 
the auto-accept function in the current field.

Inhibit Auto-Accept Settings

Value Description

0 Pressing F2 in a dependent field in a grid saves the record. 
This is the default setting.

1 Pressing F2 in a dependent field in a grid does not save the 
record.

Behavior of F2 in Dependent Field Settings
C-10 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\administration\C.fm
5/13/14 
Valid settings are:

SB.CONTROL<15,6>

This setting determines the behavior of the interface after the user presses 
ESC or F2 (Save) in subscreens in GUI mode.

Valid settings are:

SB.CONTROL<15,7>

Specifies whether to include HELP_STRING when building GUI drivers. 
Because HELP_STRING stores ToolTips data, this setting effectively switches 
ToolTips on or off.

Value Description

0 Do not reset the input value. (Display the input value 
exactly as the user entered it.) This is the default setting.

1 Reset the input value to the original value that was 
displayed in the field before it was edited.

2 Reset the input value to the value displayed in the field 
after the validation routine has run.

Reset Input Value Settings 

Value Description

0 After the user presses ESC or F2 (Save) in a GUI subscreen, 
the form is destroyed (the subscreen closes). This is the 
default setting.

1 After the user presses ESC or F2 (Save) in a GUI subscreen, 
the form is not destroyed (the subscreen remains open).

Subscreen Behavior Settings 
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Valid settings are:

SB.CONTROL<15,8>

Indicates whether to enable the functionality of auto-accepting a field when 
the cursor is placed in the field and the user presses a standard edit key or 
initiates an Activate, Menu, ActiveX, or SBCom GUI event.

The standard edit keys are keys with decimal character values 31-99. They 
include function keys F1-F10 and other keys. For a list of edit key decimal 
character values and their corresponding key names, see Appendix D, 
“Appendix D: Edit Keys.”

Valid settings are:

SB.CONTROL<15,9>

Specifies the format used in all messages, including warning messages, error 
messages, and dialog box messages.

Value Description

0 Use HELP_STRING. ToolTips are switched on. This is the 
default setting.

1 Do not use HELP_STRING. ToolTips are switched off.

HELP_STRING Settings 

Value Description

0 Enable the auto-accept field feature for standard edit keys 
and GUI events. This is the default setting.

1 Disable the auto-accept field feature for standard edit keys 
and GUI events.

Auto-Accept Field on Standard Edit Key/GUI Event Settings 
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■ The expanded message format provides information about the SB+ 
process that generated the message. This information helps U2 
Technical Support track the cause of the message and resolve 
problems more quickly.

In expanded format, additional details for the message can be 
accessed by pressing F3. Details include the error code and the 
content of two COMMON variables: MAINFILE and KEY.

■ The standard message format does not include information on the 
SB+ process that generated the message.

Valid settings are:

SB.CONTROL<15,10>

Currently not in use.

SB.CONTROL<15,11>

This setting controls the manner in which a grid is refreshed after the user 
deletes or inserts a line in the grid.

Valid settings are:

Value Description

0 Use the standard format in all messages. This is the default 
setting.

1 Use the expanded message format in all messages.

Message Format Settings 

Value Description

0 The line is deleted or inserted and the remainder of the grid 
is repainted by moving the existing data up or down. This 
is the default setting.

1 The server resends all data in the entire grid. This refresh 
method can be time-consuming in large grids.

Grid Refresh Settings 
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SB.CONTROL<15,12>

Indicates whether to disable the functionality of auto-accepting a field when 
the cursor is placed in the field and the user presses an edit key that you have 
specified in this list.

Valid settings are:

SB.CONTROL<15,13>

Specifies whether grid columns are ordered by the sequence in which they 
appear in the SB+ Form Painter (from left to right/top to bottom) or by 
position, as specified at the Pos prompt in the Resequence Fields dialog box.

Valid settings are:

Value Description

null Enable the auto-accept field feature for edit keys. This is the 
default setting.

comma-delimited list 
of edit key numbers 

Disable the auto-accept field feature for the specified edit 
keys.

For example, you can disable auto-accept for the TAB and 
BACKTAB keys by entering 22,25 for this parameter.

For a list of edit key decimal character values and their 
corresponding key names, see Appendix D, “Appendix D: 
Edit Keys.”

Auto-Accept Field on TAB/User-Specified Edit Key Settings 

Value Description

0 Columns are ordered by the sequence in which they appear 
in the SB+ Form Painter. This is the default setting.

1 Columns are ordered by position, as specified in 
Resequence Fields.

Column Order Settings 
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SB.CONTROL<15,14>

Currently not in use. 

SB.CONTROL<15,15>

Allow auto logon at the SB+ Server level. Note that if auto logon is allowed 
at the SB+ Server level, it can still be disallowed for specific users in User 
Security Setup.

Valid settings are:

SB.CONTROL<16>

Indicates whether to use Common User Access (CUA) arrow movement.

Valid settings are:

SB.CONTROL<17>

Currently not in use.

Value Description

0 No, do not allow auto logon. This is the default setting.

1 Yes, allow auto logon.

Auto Logon Settings 

Value Description

0 No, do not use CUA arrow movement. This is the default 
setting.

1 Yes, use CUA arrow movement.

CUA Arrow Movement Settings 
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SB.CONTROL<18>

Sets the maximum number of milliseconds between clicks in the mouse 
double-click, at the system level.

The default setting is 1000. 

SB.CONTROL<19,1>

Specifies the date conversion code used by default in field definitions in the 
system. When the developer defines a date field in Field Definitions, this date 
conversion code is displayed by default; however, the developer can assign a 
different date conversion code to the field.

Valid settings are:

Value Description

D DD MMM YYYY 
Example: 30 NOV 2005

D4. DD.MM.YYYY if system uses International dates. 
Example: 30.11.2005

MM.DD.YYYY if using American dates. 
Example: 11.30.2005

D4/ DD/MM/YYYY if system uses International dates. 
Example: 30/11/2005

MM/DD/YYYY if system uses American dates. 
Example: 11/30/2005

This is the default setting.

D0 DD MMM 
Example: 30 NOV

DD DD 
Example: 30

DM MM 
Example: 11

Date Conversion Settings 
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Note: Date conversion codes commonly used before Y2K are still accepted, but are 
not available in the selection list for this parameter in SB+ Control Parameters.

SB.CONTROL<19,2>

Specifies the money conversion code used by default in field definitions in 
the system. When the developer defines a monetary field in Field Definitions, 
this money conversion code is displayed by default; however, the developer 
can assign a different money conversion code to the field.

Valid settings are:

DY YYYY 
Example: 2005 

DMA MMM 
Example: NOV

DW Day of week (numeric) 
Example: 5 (for Friday)

DWA Day of week (alpha) 
Example: FRI (for Friday)

Value Description

null No default money conversion code is displayed in Field 
Definitions. This is the default setting.

MR22 Display this code by default in Field Definitions. MR22 
performs the following money conversion:

■ If raw data is 12345678, display123456.78

MR2,$ Display this code by default in Field Definitions. MR2,$ 
performs the following money conversion:

■ If raw data is 12345678, display $123,456.78

■ If raw data is -12345678, display -$123,456.78

Money Conversion Settings 

Value Description

Date Conversion Settings (Continued)
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Note: Examples in this table use the dollar sign ($), but the monetary symbol can be 
changed at the system level.

SB.CONTROL<19,3>

Specifies the process to be called as the default ‘Process at Set COMMON.’ 
The SET.COMMON process sets COMMON variables for a System ID when 
the system is initiated. SET.COMMON calls the specified process by default 
during its routine.

The default process name is null, which means no process is called by 
SET.COMMON. You can change the setting to a process name.

MR4 Display this code by default in Field Definitions. MR4 
performs the following money conversion:

■ If raw data is 12345678, display 1234.5678

MR4,$ Display this code by default in Field Definitions. MR4,$ 
performs the following money conversion:

■ If raw data is 12345678, display $1234.5678

MR2,D$ Display this code by default in Field Definitions. MR2,D$ 
performs the following money conversion:

■ If raw data is 12345678, display $123,456.78DB

MR2,C$ Display this code by default in Field Definitions. MR2,C$ 
performs the following money conversion:

■ If raw data is 12345678, display $123,456.78

■ If raw data is -12345678, display $123,456.78CR

MR2,E$ Display this code by default in Field Definitions. MR2,E$ 
performs the following money conversion:

■ If raw data is 12345678, display $123,456.78

■ If raw data is -12345678, display $<123,456.78>

Value Description

Money Conversion Settings (Continued)
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SB.CONTROL<19,4>

Specifies the default name for the field template file that is used when a 
system is created. The field template file name is placed in attribute 6 of the 
PARAMS item in the xxCONTROL file, where xx is the system code. When a 
field definition is displayed, it can be copied into the field template file by 
pressing F6. When creating new files, field definitions can be retrieved from 
the field template file by pressing F6 when the field definition is empty. The 
user is prompted for the name of the field definition to retrieve; F3 retrieves 
a list of field definitions from which to select.

The default file name is null, which means the field template file name is not 
specified. You can change the setting to a file name.

SB.CONTROL<19,5>

Specifies the initial version number assigned by default to a system when it 
is created. The default version number is placed in attribute 10 of the 
PARAMS item in the xxCONTROL file, where xx is the system code. This 
version number is part of the Revision Control attribute that is updated 
automatically every time a developer creates or changes an SB+ item (any 
item available from the SB+ Tools menu).

The default version number is null. You can change the setting to an initial 
version number.

SB.CONTROL<19,6>

Specifies the process to be run by default when the user returns to System 
Builder from the operating system.

The default process name is null, which means no process is run by default 
on return from the operating system. You can change the setting to a process 
name.

SB.CONTROL<19,7>

Specifies the process to be run by default in System Builder before executing 
a CHAIN command in the database.
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The default setting is null, which means no process is run by default before 
CHAINing. You can change the setting to a process name.

SB.CONTROL<19,8>

Specifies the default file name for the global process file. The global process 
file stores definitions for System Builder processes that can be run globally, 
on multiple systems.

The default setting is null, which means the global process file name is not 
specified. You can change the setting to a file name.

SB.CONTROL<19,9>

Specifies the default file name for the global menus file. The global menus file 
stores definitions of menus that can be used globally, on multiple systems.

The default setting is null, which means the global menus file name is not 
specified. You can change the setting to a file name.

SB.CONTROL<19,10>

Specifies the default file name for the global help file. The global help file 
defines help that can be used globally, on multiple systems.

The default setting is null, which means the global help file name is not 
specified. You can change the setting to a file name. 

SB.CONTROL<19,11>

Specifies the default file name for the global definitions file. The global 
definitions file stores definitions for the following items for use globally, on 
multiple systems:

■ Button bars

■ Code tables

■ Function key sets
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■ Job schedules

■ Spreadsheet transfers

The default setting is null, which means the global definitions file name is not 
specified. You can change the setting to a file name.

SB.CONTROL<19,12>

Specifies the default file name for the global dictionary file. The global 
dictionary file stores dictionary definitions shared by multiple files. The 
definitions are the same in each file that uses them.

The default file name is null, which means a global definitions file is not 
specified. You can change the setting to a file name.

SB.CONTROL<19,13>

Currently not in use.

SB.CONTROL<19,14>

Specifies whether GUI mode is enabled at the SB+ server level.

Valid settings are:

Value Description

0 No, disable GUI mode. This is the default setting.

1 Yes, enable GUI mode.

GUI Mode Settings 
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SB.CONTROL<19,15>

Specifies the GUI default set (GDS) of attributes and values for screens to be 
used as the default at the SB+ server level. When creating a new system, the 
name of the specified GDS is displayed by default at the GUI Screen 
Defaults prompt in SB Control Parameters; however, the developer can 
assign a different GDS to the new system.

The default setting is null, which means the SB+ default GDS for screens (the 
SCREEN.GUIDEFS item in the DMCONT file) is used when creating a new 
system. You can change the setting to the name of an existing GDS.

SB.CONTROL<19,16>

Specifies the GUI default set (GDS) of attributes and values for menus to be 
used as the default at the SB+ server level. When creating a new system, the 
name of the specified GDS is displayed by default at the GUI Menu Defaults 
prompt in SB Control Parameters; however, the developer can assign a 
different GDS to the new system.

The default setting is null, which means the SB+ default GDS for menus (the 
MENU.GUIDEFS item in the DMCONT file) is used when creating a new 
system. You can change the setting to the name of an existing GDS.

SB.CONTROL<19,17>

Specifies the GUI default set (GDS) of attributes and values for help to be 
used as the default at the SB+ server level. When creating a new system, the 
name of the specified GDS is displayed by default at the GUI Help Defaults 
prompt in SB Control Parameters; however, the developer can assign a 
different GDS to the new system.

The default setting is null, which means the SB+ default GDS for help (the 
HELP.GUIDEFS item in the DMCONT file) is used when creating a new 
system. You can change the setting to the name of an existing GDS.
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SB.CONTROL<19,18>

Specifies the GUI default set (GDS) of attributes and values for dialog boxes 
to be used as the default at the SB+ server level. When creating a new system, 
the name of the specified GDS is displayed by default at the GUI Dialog 
Defaults prompt in SB Control Parameters; however, the developer can 
assign a different GDS to the new system.

The default setting is null, which means the SB+ default GDS for dialog boxes 
(the DIALOG.GUIDEFS item in the DMCONT file) is used when creating a 
new system. You can change the setting to the name of an existing GDS.

SB.CONTROL<19,19>

Specifies the GUI default set (GDS) of attributes and values for errors to be 
used as the default at the SB+ server level. When creating a new system, the 
name of the specified GDS is displayed by default at the GUI Error Defaults 
prompt in SB Control Parameters; however, the developer can assign a 
different GDS to the new system.

The default setting is null, which means the SB+ default GDS for errors (the 
ERROR.GUIDEFS item in the DMCONT file) is used when creating a new 
system. You can change the setting to the name of an existing GDS.

SB.CONTROL<19,20>

Specifies the GUI default set (GDS) of attributes and values for lookups to be 
used as the default at the SB+ server level. When creating a new system, the 
name of the specified GDS is displayed by default at the GUI Lookup 
Defaults prompt in SB Control Parameters; however, the developer can 
assign a different GDS to the new system.

The default setting is null, which means the SB+ default GDS for lookups (the 
LOOKUP.GUIDEFS item in the DMCONT file) is used when creating a new 
system. You can change the setting to the name of an existing GDS.
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SB.CONTROL<19,21>

Specifies the GUI default set (GDS) of attributes and values for prompts to be 
used as the default at the SB+ server level. When creating a new system, the 
name of the specified GDS is displayed by default at the GUI Prompt 
Defaults prompt in SB Control Parameters; however, the developer can 
assign a different GDS to the new system.

The default setting is null, which means the SB+ default GDS for prompts 
(the PROMPT.GUIDEFS item in the DMCONT file) is used when creating a 
new system. You can change the setting to the name of an existing GDS.

SB.CONTROL<19,22>

Specifies a process to be run by default before executing any / process call.

The default setting is null, which means no process runs by default before 
executing a / process call. You can change the setting to a process name. If 
you enter a process name that does not currently exist, SB+ issues a warning, 
and you can create the process later.

SB.CONTROL<19,23>

Specifies a custom version control process to be executed by default before 
the SB+ version control process runs at all hook points.

The default setting is null, which means no custom version control process is 
executed by default before the SB+ version control process. You can change 
the setting to a process name. If you enter a process name that does not 
currently exist, SB+ issues a warning, and you can create the process later.

SB.CONTROL<19,24>

Specifies the GUI default set (GDS) of attributes and values for the character 
emulation object (CEO) used as the default at the SB+ server level. When 
creating a new system, the name of the specified GDS is displayed by default 
at the GUI CEO Defaults prompt in SB Control Parameters; however, the 
developer can assign a different GDS to the new system.
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The default setting is null, which means the SB+ default GUI CEO (the 
CEO.GUIDEFS item in the DMCONT file) is used when creating a new 
system. You can specify the name of an existing GDS.

SB.CONTROL<19,25>

Indicates whether to add scrollbars to GUI form drivers.

Valid settings are:

SB.CONTROL<19,26>

Specifies whether to use tabfolders to display GUI linked screens. 

Valid settings are:

SB.CONTROL<19,27>

Specifies whether to display multivalued attributes in a grid.

Value Description

0 No, do not add scrollbars to GUI form drivers. This is the 
default setting.

1 Yes, add scrollbars to GUI form drivers. With this setting, 
the developer has the option of creating GUI screens 
with scrollbars.

Scrollbars in GUI Form Driver Settings 

Value Description

0 No, do not use tabfolders for GUI linked screens. Linked 
screens are displayed one after another in linked order. This 
is the default setting.

1 Yes, use tabfolders for GUI linked screens. Linked screens 
are displayed as tabbed pages of a single screen.

Tabfolder for GUI Linked Screens Settings 
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Valid settings are:

SB.CONTROL<19,28>

Specifies the GUI menu navigation method at the SB+ server level. You can 
set a different method at the system level or for a specific user.

Valid settings are:

SB.CONTROL<19,29>

Specifies whether to use GUI self-contained forms. A self-contained form has 
a status line and may also have its own toolbar.

Value Description

0 No, use standard style. Multivalues are displayed in 
separate fields. This is the default setting.

1 Yes, use ActiveX grid style. Multivalues are displayed in 
columns within a group box.

Grid Style Settings 

Value Description

0 M navigation method: MainWin.

1 EM navigation method: Explorer (SBX) with MainWin. 
This is the default setting.

2 EN navigation method: Explorer (SBX) with no MainWin.

3 N navigation method: No MainWin.

Self-Contained Forms Settings 
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Valid settings are:

SB.CONTROL<19,30>

Specifies the name of a custom process to be run by default instead of 
chaining SB.SYSMENU if using GUI mode and the N (No Mainwin) menu 
navigation method.

The default setting is null, which means no custom process is run by default. 
You can change the setting to a custom process name.

SB.CONTROL<19,31>

Specifies the GUI default set (GDS) of attributes and values for HTML pages 
used as the default at the SB+ server level. When creating a new system, the 
name of the specified GDS is displayed by default at the GUI HTML 
Defaults prompt in SB Control Parameters; however, the developer can 
assign a different HTML GDS to the new system.

The default setting is null, which means the SB+ default GDS for HTML (the 
HTML.GUIDEFS item in the DMCONT file) is used when creating a new 
system. You can specify the name of an existing GDS to use as the default.

SB.CONTROL<19,32>

Specifies whether to disable display of the Tools branch in the System Builder 
Explorer (SBX) pane.

Value Description

0 No, do not use GUI self-contained forms. This is the default 
setting.

1 Yes, use GUI self-contained forms.

Self-Contained Forms Settings 
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Valid settings are:

SB.CONTROL<19,33>

Specifies whether to disable display of the General Help branch in the System 
Builder Explorer (SBX) pane.

Valid settings are:

SB.CONTROL<19,34>

Specifies whether to disable display of the Readme branch in the System 
Builder Explorer (SBX) pane.

Valid settings are:

Value Description

0 No, enable SBX Tools branch.

1 Yes, disable SBX Tools branch. This is the default setting.

SBX Tools Branch Settings 

Value Description

0 No, enable SBX General Help branch.

1 Yes, disable SBX General Help branch. This is the default 
setting.

SBX Help Branch Settings 

Value Description

0 No, enable SBX Readme branch. 

1 Yes, disable SBX Readme branch. This is the default setting.

SBX Help Readme Branch Settings 
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SB.CONTROL<19,35>

Specifies whether multiple system IDs are allowed in System Builder 
Explorer (SBX). 

Valid settings are:

SB.CONTROL<20>

Specifies the date format at the SB+ server level. The date format is set during 
installation of SB+ when you license the product on the server.

Valid settings are:

SB.CONTROL<21>

Indicates the path of the directory in which UniData or UniVerse is installed. 
The path is set automatically during installation of SB+ when the installation 
program detects the path of the database. If you later move the database to a 
different path, the new path can be specified here.

SB.CONTROL<22>

Specifies the delimiter character used when SB+ constructs a pathname.

Value Description

0 No, do not allow the use of multiple system IDs in SBX. 
This is the default setting.

1 Yes, allow the use of multiple system IDs in SBX.

SBX Multiple System IDs Settings 

Value Description

I International.

A American.

Date Format Settings 
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The delimiter can be any separator character, such as one of the following:

SB.CONTROL<23>

UNIX only. Specifies the name of the UNIX group to be stamped on files 
generated during the process of creating a new system.

The default setting is sb. The setting is then populated with the group name 
of the user who sets up SB+. You can change this to another UNIX group 
name.

SB.CONTROL<24>

UNIX only. Specifies the umask used to set the read, write, and execute 
permissions for user, group, and other in files generated during the process 
of creating a new system.

The initial default setting is 007. The setting is then populated automatically 
with the umask of the user who sets up SB+ (for example, 777 or 057). You can 
change this to another valid three-digit umask.

Character Example

/ Forward slash

Example:  C:/U2/SBClient

\ Backslash

Example:  C:\U2\SBClient

> Right angle bracket

Example:  C:>U2>SBClient

. Dot (period)

Example:  C:.U2.SBClient

Examples of Delimiter Character in Pathname 
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SB.CONTROL<25>

UNIX only. Specifies the maximum number of characters in a UNIX file 
name/directory name.

The default setting is 255. You can change the setting to a numeric value, up 
to a maximum of 999.

SB.CONTROL<26,1>

Specifies the decimal character value for the ENTER key.

The default value is 13 for Windows or 10 for UNIX. You can change this to 
the decimal character value for the ENTER key as defined in the terminal 
definition.

SB.CONTROL<26,2>

Specifies the decimal character value for the BACKSPACE key.

The default value is 8. You can change this to the decimal character value for 
the BACKSPACE key as defined in the terminal definition.

SB.CONTROL<26,3>

Specifies whether the in-key test is to be delayed if INKEY is set to 1 in 
SB.LICENCE. This parameter is used to work around an incompatibility with 
Smart ARNET cards, which do not read the SB in-key status correctly.

Valid settings are:

Value Description

0 No, do not delay the in-key test. This is the default setting.

1 Yes, delay the in-key test.

In-Key Test Settings 
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SB.CONTROL<27,1>

Specifies the character used to call a process from any input prompt in any SB 
screen.

The default setting is ’/’. You can specify a different character; however, note 
that if a user types this character in the first position at any input prompt, it 
is interpreted as an SB process call. 

SB.CONTROL<27,2>

Specifies the character used to call Help from any input prompt in any SB 
screen.

The default setting is ’?’. You can specify a different character; however, note 
that if a user types this character in the first position at any input prompt, it 
is interpreted as an SB Help call. 

SB.CONTROL<27,3>

Specifies the character used to delete the contents of a field in any SB screen.

The default setting is ‘\’. You can specify a different character; however, note 
that if a user types this character in the first position at any input prompt, it 
is interpreted as an SB delete call.

SB.CONTROL<28,1>

Specifies the name of the SB+ host machine, which is the server on which SB+ 
is running. The host name is included in form names; this makes each form 
name unique even if similar forms have the same root name on different 
servers.

The default value is null, which means an SB+ host machine is not included 
in form names. You can specify an SB+ server name.

SB.CONTROL<28,2>

Specifies the GUI checksum method.
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Valid settings are:

SB.CONTROL<28,3>

Indicates whether to disable use of the previous GUI menus if the current 
menu has no action bar.

Valid settings are:

SB.CONTROL<28,4>

Applicable to GUI only. Indicates the size of the host input buffer in bytes. 
This buffer sets the block size for UT.SBZ file transfers.

The default setting is 300. This setting should match the size to which the 
input buffer has been set on the server on which SB+ is running. If the size of 
the input buffer on the SB+ server is later reset, you can change this 
parameter to the same value.

Value Description

0 Use SH.ENCRYPT, UNIQUE checksum method.

1 SH.ENCRYPT, STANDARD checksum method.

2 Use the operating system’s checksum method. This is the 
default setting.

GUI Checksum Method Settings 

Value Description

N No, enable the previous GUI menus if the current menu has 
no action bar.

Y Yes, disable the previous GUI menus if the current menu 
has no action bar. This is the default setting.

Disable Previous GUI Menus Settings 
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SB.CONTROL<28,5>

Applicable only if you are using SBClient. Specifies the size of the file transfer 
packet sent to SBClient in UT.SBZ.

The default setting is null, which means you are not sending file transfer 
packets to SBClient. You can change this setting to the appropriate size, if 
applicable.

SB.CONTROL<28,6>

Currently not in use.

SB.CONTROL<28,7>

Indicates the minimum version of SBClient required to support GUI mode.

The version is a three-digit number, formatted for use in SB.LICENCE. In SB+ 
version 5.5, the default setting is 550, which specifies SBClient 5.5.0 as the 
minimum version.

SB.CONTROL<28,8>

Specifies whether to use the extended validation feature in the screen/form 
painter. Extended validation checks the screen or form for the following 
potential problems:

■ The USER_DATA attribute for function key buttons contains the 
process name instead of the button number. (The button works, but 
it is treated as an independent/user-defined button, not as a function 
key button.)

■ Function keys have a process, but no description, or 
 GUI/character descriptions differ, 
or GUI/character help strings differ, 
or GUI/character bitmap paths differ.

■ Independent buttons are missing a process or description.
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■ Internal sequence problems: 
– Sequence numbers are missing or duplicated. 
– Sequence numbers do not point to correct SCREEN field/label. 
– Related fields and labels have different sequence numbers.

■ Object attributes are missing or duplicated.

■ Internal child list/number of children of form is incorrect.

■ Index (field 2) does not point to the correct object.

■ Fonts are missing.

■ Character fields overlap (causing object naming problems at run 
time).

Valid settings are:

SB.CONTROL<29>

Indicates the flavor of UNIX running on the SB+ server.

The default setting is null. The value is then set automatically during 
installation of SB+ when the installation program detects the manufacturer of 
the UNIX operating system. For Windows clients, the setting is Windows, 
indicating that this parameter is not applicable.

SB.CONTROL<30,1>

Specifies the action bar display style.

Value Description

0 No, do not use extended validation feature in screen/form 
painter. This is the default setting.

1 Yes, use extended validation feature in screen/form painter.

Extended Checking Feature Settings 
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Valid settings are:

SB.CONTROL<30,2>

Specifies the number of the effect used for the Action bar highlight in the 
terminal definition. 

Valid settings are:

SB.CONTROL<30,3>

Sets the line number on which the action bar is to be displayed on the screen.

Value Description

0 Use compact spacing in the display of action bar items. This 
is the default setting.

n (integer 1 or greater) Use even spacing between action bar items. The value 
specifies the minimum number of characters to leave at the 
end of the action bar line.

GUI Checksum Method 

Value Description

1 Half intensity. This is the default setting.

2 Reverse video.

3 Underline.

4 Blink.

Action Bar Highlight Settings 
C-36 SB+ Server Administration Manual



E:\SVN\SB55\doc_set\sbplus\administration\C.fm
5/13/14 
Valid settings are:

SB.CONTROL<30,4>

Specifies the Load Function Keys (LFK) style used in GUI mode.

Valid settings are:

Value Description

0 Display the action bar on line 1 of the screen. This is the 
default setting.

1 Display the action bar on line 2 of the screen.

Action Bar Display Line Settings 

Value Description

0 Use standard (old) LFK style. The LFK process loads an 
alternate function key set onto the current menu, and all 
function key buttons on the current form are de-emphasized. 
To re-enable the original function key buttons, the alternate 
function key set must be cleared (by loading function keys). 
The original function key buttons are then re-emphasized.

If the original function key buttons include F1 and/or F3, 
these buttons are emphasized/de-emphasized depending on 
the availability of help, regardless of the action of the LFK 
process.

This is the default setting.

1 Use new LFK style. The LFK process behaves as it does in 
character mode: the function key buttons on the current form 
are replaced with new function key buttons; the original 
function key buttons are removed. 

This functionality can be switched on by setting the Use new 
LFK Style Buttons flag in the GUI Display Defaults 
subscreen to Y. (To access this flag, enter /SB.PARMS, press F8 
to open the Display Defaults subscreen, and then press F5 to 
open the GUI Display Default subscreen). If this flag is not 
set, you can use the new functionality in any form by 
appending a parameter to the LFK process call. For example: 
LFK,functionkeyset,1.

Load Function Key Settings 
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SB.CONTROL<30,5>

Specifies whether to adjust the form width and depth to accommodate a 
toolbar in cases in which the toolbar being attached to a form is larger than 
the form.

Valid settings are:

SB.CONTROL<30,6>

Specifies whether to use flat style buttons on fixed toolbars in GUI screens.

Valid settings are:

SB.CONTROL<30,7>

Specifies whether to use the sbpluslistviewclass object to display selection 
boxes in GUI mode. This object defines the look and feel of selection boxes, 
with fields displayed in a columnar format.

Value Description

0 No, do not adjust the form width and depth to 
accommodate the toolbar. Wrap the toolbar into as many 
rows and columns as required to fit on the form. This is the 
default setting. 

1 Yes, adjust the form width and depth to accommodate the 
toolbar.

Accommodate Toolbar Settings 

Value Description

0 No, use older raised-style buttons on fixed toolbars.

1 Yes, use new flat style buttons on fixed toolbars. This is the 
default setting.

Toolbar Button Style Settings 
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Valid settings are:

SB.CONTROL<30,8>

Specifies whether F1 and F3 buttons on the toolbar are to be emphasized to 
indicate availability of help on the current input field in GUI mode 
(SB.GUI.INP).

Valid settings are:

SB.CONTROL<30,9>

Specifies whether to automatically convert second-level help to HTML 
format in GUI mode.

Value Description

0 No, do not use sbpluslistviewclass for selection boxes. 
Use the old listview style from SB version 5.4 and earlier 
instead.

1 Yes, use sbpluslistviewclass for selection boxes. This is 
the default setting.

sbpluslistviewclass Settings 

Value Description

0 No, do not emphasize F1 and F3 keys to indicate 
availability of help on the current input field in GUI 
mode. This is the default setting.

1 Yes, emphasize F1 and F3 keys to indicate availability of 
help on the current input field in GUI mode.

F1 and F3 Availability Settings 
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Valid settings are:

SB.CONTROL<30,10>

Specifies the name of the process called by default to execute the action of a 
double-click in GUI mode.

The default setting is DCLICK.DEFAULT. You can redefine the action this 
process performs, or change the setting to a custom process name. If you 
enter a process name that does not currently exist, SB+ issues a warning, and 
you can create the process later.

SB.CONTROL<30,11>

If an output process is associated with a screen, this parameter specifies 
whether OK, Prev, and Next buttons are to be added to the screen when the 
output process is run in GUI mode.

Valid settings are:

Value Description

0 No, do not convert second-level help to HTML format.

1 Yes, convert second-level help to HTML format. With this 
setting, second-level help text is automatically wrapped 
with HTML tags and displayed in HTML format. This is the 
default setting.

Convert Second-Level Help to HTML Settings 

Value Description

0 No, do not display OK, Prev, and Next buttons on the 
screen. This is the default setting.

1 Yes, display OK, Prev, and Next buttons on the screen.

Button Settings for Output Process Screens 
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SB.CONTROL<30,12>

Specifies whether to finish downloading all data to ListView selections in 
GUI mode before passing control to the user.

Valid settings are:

SB.CONTROL<30,13>

Specifies whether to display a page indicator (such as 1/1 or 1/2) on the 
status line in GUI screens containing multivalued grids.

Valid settings are:

Value Description

0 No, do not download all data before passing control to user. 
This is the default setting.

With this setting, the user can begin working in the 
ListView selection after the first page of data has been 
downloaded.

This setting offers better speed in the download process, 
but the user assumes the risk of working with incomplete 
data.

1 Yes, download all data before passing control to user.

This setting results in slower speed, but the user does not 
take the chance of working with incomplete data.

Download Data to ListView Settings 

Value Description

0 No, do not display a page indicator. 

1 Yes, display a page indicator. This is the default setting.

Remove OK, Prev, and Next Settings 
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SB.CONTROL<30,14>

Specifies whether to dynamically refresh the contents of combo boxes when 
the cursor is placed in the field containing the combo box and during a screen 
refresh.

Valid settings are:

SB.CONTROL<30,15>

Specifies whether to enable a feature of the DIFF printing option that allows 
printing of reports with page breaks.

Valid settings are:

Value Description

0 Do not refresh the contents of combo boxes.

null or 1 Refresh validation list expression (V:() / X:). 

2 Refreshes the following:

■ Validation list expression (V:() / X:)

■ ‘V:filename itemname’ and ‘F:filename’

3 Refreshes the following:

■ Validation list expression (V:() / X:)

■ ‘V:filename itemname’ and ‘F:filename’

■ Table expression (E:...;ZT...), which allows only items that 
are in the table

This is the default setting.

Refresh Combo Box Settings 

Value Description

0 No, disable DIFF feature for printing reports with page 
breaks.

1 Yes, enable DIFF feature for printing reports with page 
breaks. This is the default setting.

DIFF Printing Option Settings 
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SB.CONTROL<30,16>

Currently not in use.

SB.CONTROL<30,17>

Currently not in use.

SB.CONTROL<30,18>

Sets the option for displaying the user’s name in the locked record message.

Valid settings are:

SB.CONTROL<30,19>

This flag specifies whether to prompt for a file name when saving selection 
criteria.

Valid settings are:

Value Description

0 Display the short name from DMSECURITY for the user 
who has locked the record.

1 Display the first name and last name of the user who has 
locked the record. This is the default setting.

Locked Record Message Settings 

Value Description

0 No, do not prompt for a file name. Always write to the 
DMCRITERIA file when saving selection criteria. This is 
the default setting.

This option prevents the possibility of a user entering a 
data file name and overwriting the contents of the file.

1 Yes, prompt for the file name when saving selection criteria.

File Name Prompt Settings 
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SB.CONTROL<30,20>

Controls whether headers are displayed on screen if they exceed more than 
50 percent of the available number of lines on the screen.

Valid settings are:

SB.CONTROL<30,21>

If the user’s GUI menu navigation method is EN (System Builder Explorer 
(SBX) with no MainWin), this parameter specifies whether the tree view 
expands to the process level.

Valid settings are:

SB.CONTROL<30,22>

This parameter specifies whether to translate field descriptions even when 
the Link Char and GUI Field Positions flag is set to No.

Value Description

0 No, do not allow header to be displayed on screen if it 
exceeds 50 percent of the available number of lines on the 
screen. This is the default setting.

1 Yes, allow header to be displayed on screen if it exceeds 50 
percent of the available number of lines on the screen.

Long Heading Display Settings 

Value Description

0 No, the tree view does not expand to the process level. This 
is the default setting.

1 Yes, the tree view expands to the process level. This style 
was used in older versions of SB+ Server.

Tree View Expansion Settings 
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Valid settings are:

SB.CONTROL<31,1>

Specifies whether to display the user ID when the user types it in the logon 
screen. 

Valid settings are:

SB.CONTROL<31,2>

Specifies whether to display asterisks when the user types a password in the 
logon screen.

Value Description

0 No, do not translate field descriptions when the Link Char 
and GUI Field Positions flag is set to No. This is the default 
setting.

1 Yes, translate field descriptions even when the Link Char 
and GUI Field Positions flag is set to No.

Translate Field Descriptions Settings 

Value Description

0 No, do not display user ID in the logon screen. This is the 
default setting.

1 Yes, display user ID in the logon screen.

User ID in Logon Screen Settings 
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Valid settings are:

SB.CONTROL<31,3>

Specifies whether to use a simple encryption technique when SB+ encrypts 
data (for example, when it stores a password), as an alternative to the 
standard complex encryption technique used by SB+.

Valid settings are:

SB.CONTROL<31,4>

Specifies whether to use the alternative SYSID security method to allow users 
to run processes that are called by restricted menu options.

Value Description

0 No, do not display asterisks when typing a password in the 
logon screen. This is the default setting 

1 Yes, display asterisks when typing a password in the logon 
screen.

2 Display random characters when typing a password in the 
logon screen.

Password Display Settings 

Value Description

0 No, use the standard complex encryption technique. This is 
the default setting

1 Yes, use the simple encryption technique.

Alternative Encryption Technique Settings 
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Valid settings are:

SB.CONTROL<31,5>

Specifies whether to enable use of a user-provided security log routine. This 
feature allows you to create a security log routine to be called by the SB+ logon 
process.

Valid settings are:

SB.CONTROL<31,6>

Specifies whether to allow users who are not members of a security group to 
log to an account that is listed as restricted in the security group record.

Value Description

0 Do not use the alternative SYSID security method. If a 
menu is restricted, the processes called by its menu options 
are also restricted.

1 Use the alternative SYSID security method. If a menu is 
restricted, the processes called by its menu options are not 
restricted. This is the default setting.

Alternative SYSID Security Settings 

Value Description

0 No, do not use a user-provided security log routine. This is 
the default setting.

1 Yes, use a user-provided security log routine. With this 
setting, SB+ reads the VALIDATE.LOG item in 
DMSECURITY at logon to SB+. Attribute 1 of this item 
contains the maximum number of attempts a user is 
allowed at logon. Attribute 2 contains the name of a 
cataloged BASIC program to be called as part of the logon 
process.

User-Provided Security Logging Settings 
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Valid settings are:

SB.CONTROL<31,7>

Allow use of ESC key to escape from GUI dialog boxes that have only one 
button.

Valid settings are:

SB.CONTROL<32>

Specifies the frame style used in screens in character mode.

Valid settings are:

Value Description

0 No, do not allow users who are not members of the group 
to log to restricted accounts. This is the default setting.

1 Yes, allow users who are not members of the group to log 
to restricted accounts.

Restricted Account Access Settings 

Value Description

0 No, do not allow use of ESC key in GUI dialog boxes with 
one button. This is the default setting.

1 Yes, allow use of ESC key in GUI dialog boxes with one 
button.

ESC Key in One-Button Dialog Box Settings 

Value Description

1 Use single line for frame borders. This is the default setting.

2 Use double line for frame borders.

3 Use no line at frame borders.

Frame Style Settings 
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SB.CONTROL<33>

Specifies the shadow style used in screens in character mode.

Valid settings are:

SB.CONTROL<34,1>

Applicable to UniVerse only. Specifies whether to force creation of D/I types.

Valid settings are:

SB.CONTROL<34,1>

Applicable to UniData only. Specifies whether to force creation of I type 
instead of V type.

Value Description

1 Use single shadow. This is the default setting.

2 Use opaque shadow.

3 Use no shadow.

Shadow Style Settings 

Value Description

0 No, do not force creation of D/I types. This is the default 
setting.

1 Yes, force creation of D/I types.

Force-Create D/I Types Settings 
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Valid settings are:

SB.CONTROL<34,2>

Currently not in use.

SB.CONTROL<34,3>

Currently not in use.

SB.CONTROL<34,4>

Applicable to UniData only. Indicates whether you are using UDT:Print. This 
parameter is set during installation of SB+ when you are prompted to 
indicate whether you are using USAM.

Valid settings are:

Value Description

0 No, do not force creation of I type instead of V type. This is 
the default setting.

1 Yes, force creation of I type instead of V type.

Force-Create I Type Settings 

Value Description

0 No, not using UDT:Print.

1 Yes, using UDT:Print.

UDT:Print Settings 
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SB.CONTROL<34,5>

Applicable to UniData only. Smart refresh does not currently work on 
UniData due to problems with building unique cursor sequences. On other 
platforms, unique cursor sequences are built by using CHAR(0) to pad out 
the sequence. This cannot be done on UniData because it interprets CHAR(0) 
as an end-of-string marker.

This parameter indicates whether the site is using a version of UniData that 
does not have the CHAR(0) problem. 

Valid settings are:

SB.CONTROL<34,6>

Specifies whether SB+ passes control to Windows when a print job is routed 
to the AUX (auxiliary) printer, allowing Windows to automatically determine 
the number of rows to be printed.

Valid settings are:

Value Description

0 No, this version of UniData cannot handle CHAR(0). It uses 
CHAR(14) or CHAR(250) instead.

1 Yes, this version of UniData can handle CHAR(0).

CHAR(0) Settings 

Value Description

0 No, do not pass control to Windows. This is the default 
setting.

1 Yes, pass control to Windows, allowing it to automatically 
determine the number of rows to be printed.

Windows for AUX Printer Settings 
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SB.CONTROL<34,7>

Enables support for queries at the ECL/TCL prompt on EDA files containing  
dictionary items with V-fields that use an alternative syntax.

Valid settings are:

SB.CONTROL<34,12>

This parameter provides the ability to inhibit users from changing their own 
user security record. The flag does not apply to members of the ROOT group; 
these users always retain the ability to change their own user security 
records.

Valid settings are:

Value Description

Null or 0 Dictionary items in EDA files are constructed using the 
standard syntax. Queries support the standard syntax, 
EXTRACT(<field_name>,0,1,0). This is the default setting.

1 Dictionary items in EDA files are constructed using the 
alternative syntax. Queries support the alternative syntax, 
EXTRACT(@RECORD,0,1,0).

Alternative Syntax Settings 

Value Description

Null or 0 Users can change their own user security record. This is the 
default setting.

1 Users who are not members of the ROOT group are not 
allowed to change their own user security records.

Change Own User Security Settings 
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SB.CONTROL<35,1>

Currently not in use.

SB.CONTROL<35,2>

Specifies the method for storing the names of menus and processes that have 
been restricted by the application developer in the PASS.DEFN variable, 
attributes <3> through <5>.

Note: The list of process names stored in the PASS.DEFN variable, attribute <1> 
always uses storage method 1 as described below.

Valid settings are:

Value Description

null or 0 Use the standard LOCATE() process. This is the default 
setting.

Names are stored in a multivalued list, not sorted in any 
way. LOCATE() is used to find an entry in the list.

Because entries are not sorted, the LOCATE() process can 
be slow if the list is very large.

1 Names are stored in a multivalued list, grouped into 
partitions based on length of name. Entries in each 
partition are sorted by name.

This setting works well if names are of various lengths. It is 
not effective if all names are the same length or differ very 
little.

n (a prime number 
greater than 1)

Names are stored in a multivalued table.

This storage method uses a hashing algorithm to evenly 
distribute names into a predefined hash table of size n.

This setting works well in situations in which all names are 
the same length. For example, all names may start with the 
same prefix and end in a three-digit number (such as 
PROC001, PROC002, PROC003, and so on).

Name Storage Method Settings 
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Tip: If you change the name storage method on an existing system, you will need to 
rebuild all ‘$’ security items. An easy way to do this is to amend the ROOT group by 
changing a character in the description, press F2, and then press ESC. This causes 
all child items to be rebuilt. Otherwise, you can use the /UPDATE.SECURITY 
process in the SB+ (or SB) account.

SB.CONTROL<35,3>

Specifies whether the SH.ACTIVITY.S process is to invoke a user-supplied 
version of the SH.DIARY.MSG.I process.

Valid settings are:

SB.CONTROL<35,4>

Optimize input correlatives used in SB.GEN.DRIV.I. 

Valid settings are:

Value Description

0 No, do not invoke user-supplied version of 
SH.DIARY.MSG.I process. This is the default setting.

1 Yes, invoke user-supplied version of SH.DIARY.MSG.I 
process.

User-Supplied Diary Process Settings 

Value Description

null or 0 Do not optimize input correlatives. This is the default 
setting.

1 Always optimize input correlatives even if they appear in 
fields to be recalculated.

Optimize Input Correlatives Settings 
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SB.CONTROL<35,5>

Specifies whether to suppress the message ID confirmation dialog box when 
sending an SB+ Office message. 

Valid settings are:

SB.CONTROL<36>

Applicable only to UniVerse on Windows platform. Indicates the path of the 
directory in which SB+ is installed. This parameter is set automatically 
during installation of SB+ when you select the path.

SB.CONTROL<37,1>

Specifies whether transaction processing is enabled in the database.

Valid settings are:

Value Description

0 Display the message ID confirmation dialog box. This is the 
default setting.

1 Do not display the message ID confirmation dialog box.

Message ID Confirmation Dialog Box Settings 

Value Description

0 No, transaction processing is not enabled. This is the 
default setting.

1 Yes, transaction processing is enabled.

Transaction Processing Settings 
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SB.CONTROL<37,2>

Specifies whether a warning message is displayed on errors. If the Warn on 
Error flag is set to Y (Yes), SB+ displays a standard (DISP,3) error/warning 
message in the following circumstances:

■ Attempting to start a transaction when a transaction is already 
active.

SB+ displays following message:

WARNING: TRANSACTION ALREADY ACTIVE, ATTEMPT TO START 

SECOND TRANSACTION IGNORED.

■ TRANSACTION START returns false at the system level.

SB+ displays following message:

ERROR: TRANSACTION INITIATION FAILED, STATUS: n

where n is the status returned by the operating environment.

■ TRANSACTION START succeeds, but SB+ cannot reacquire the lock 
on the record.

SB+ displays following message:

ERROR: LOCK LOST FOR RECORD k

where k is the current value of KEY.

■ Attempting to commit or abort a transaction when there is no active 
transaction.

SB+ displays following message:

WARNING: NO TRANSACTION ACTIVE, CANNOT COMMIT

or

WARNING: NO TRANSACTION ACTIVE, CANNOT ABORT

■ Attempting to write a record with a NULL key.

SB+ displays following message:

ERROR: KEY IS NULL, CANNNOT COMMIT TRANSACTION

■ TRANSACTION COMMIT returns false at the system level.

SB+ displays following message:

ERROR: TRANSACTION COMMIT FAILED, STATUS: n

where n is the status returned by the operating environment.
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Valid settings are:

SB.CONTROL<37,3>

Specifies whether processing is to continue after a failed commit. If the 
Commit Fail Process field contains a valid process name or an SB+ expression 
that resolves to a process name or a paragraph statement within the "P:()" 
format, SB+  automatically executes the process if the commit fails.

Note: This parameter applies only to situations in which the TRANSACTION 
COMMIT statement fails. If RTN.FLAG is already set or KEY is NULL, no attempt 
is made to perform a TRANSACTION COMMIT and the Commit Fail process is not 
executed.

Valid settings are:

SB.CONTROL<38>

Specifies whether COBOL Direct Connect (CDC) input restrictions are to 
apply. 

Value Description

0 No, a warning message is not displayed on errors. This is 
the default setting.

1 Yes, a warning message is displayed on errors.

Warning Message Settings 

Value Description

0 No, processing does not continue after a failed commit. 
This is the default setting

1 Yes, processing continues after a failed commit.

Processing After Failed Commit Settings 
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Valid settings are:

SB.CONTROL<39,1>

Specifies the number of milliseconds of interruption in data exchange before 
Dynamic Data Exchange (DDE) times out.

Valid settings are:

SB.CONTROL<39,2>

Specifies whether each field should occupy its own column in Report Writer 
DIFF output.

Valid settings are:

Value Description

0 No, CDC input restrictions do not apply. This is the default 
setting.

1 Yes, CDC input restrictions apply.

CDC Input Restriction Settings 

Value Description

n (integer 1 or greater) The number of milliseconds before DDE times out.

The default setting is 10.

DDE Timeout Settings

Value Description

0 No, fields that are close vertically are grouped in one 
column in DIFF output. This is the default setting.

1 Yes, each field occupies its own column in DIFF output.

DIFF Column Settings 
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SB.CONTROL<40,1>

Currently not in use.

SB.CONTROL<40,2>

Currently not in use.

SB.CONTROL<41>

Specifies whether multilanguage support is enabled.

Valid settings are:

SB.CONTROL<42>

Specifies whether subroutines can be used in dictionary files.

Valid settings are:

Value Description

0 No, multilanguage support is not enabled. This is the 
default setting.

1 Yes, multilanguage support is enabled.

Multilanguage Support Settings 

Value Description

0 No, subroutines cannot be used in dictionary files. This is 
the default setting.

1 Yes, subroutines can be used in dictionary files.

Subroutines in Dictionary Settings 
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SB.CONTROL<43,1>

Applicable to UniVerse only. Specifies whether mapping of National 
Language Support (NLS) codes is enabled.

Valid settings are:

SB.CONTROL<43,2>

Applicable to UniVerse only, if mapping of NLS codes is enabled in 
SB.CONTROL<43.1>. When creating new date fields, you can choose to map 
the date to an NLS-specific conversion code. This parameter specifies the 
mapped date conversion code. 

Valid settings are:

Value Description

0 No, mapping of NLS codes is not enabled. This is the 
default setting.

1 Yes, mapping of NLS codes is enabled.

Mapping of NLS Codes Settings 

Value Description

DI Map the date to this NLS-specific conversion code. This is 
the default setting.

Note: In Pick-flavor accounts, if the code DI is used in output 
conversions, UniVerse treats them as input conversions instead. 
Because all SB+ accounts use Pick-flavor accounts, it is best not 
to use the code DI directly in your Basic subroutines. Basic 
subroutines should call LOCALEINFO() to obtain the correct 
conversion code for the user’s current locale.

null Do not map the date to an NLS-specific conversion code.

Mapped Date Conversion Code Settings 
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SB.CONTROL<43,3>

Applicable to UniVerse only, if mapping of NLS codes is enabled in 
SB.CONTROL<43.1>. When creating new time fields, you can choose to map 
the time to an NLS-specific conversion code. This parameter specifies the 
mapped time conversion code. 

Valid settings are:

SB.CONTROL<43,4>

Applicable to UniVerse only, if mapping of NLS codes is enabled in 
SB.CONTROL<43.1>. When creating new monetary fields, you can choose to 
map monetary values to an NLS-specific conversion code. This parameter 
specifies the mapped monetary conversion code. 

Valid settings are:

Value Description

TI Map the time to this NLS-specific conversion code. This is 
the default setting.

null Do not map the time to an NLS-specific conversion code.

Mapped Time Conversion Code Settings 

Value Description

MM Map monetary values to this NLS-specific conversion code. 
This is the default setting.

null Do not map the monetary values to an NLS-specific 
conversion code.

Mapped Monetary Conversion Code Settings 
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SB.CONTROL<44,1>

Specifies the type of auto-accept behavior used in GUI combo boxes.

Valid settings are:

SB.CONTROL<44,2>

Currently not in use.

Value Description

0 Do not use auto-accept behavior in GUI combo boxes. This 
is the default setting.

1 Use auto-accept behavior in GUI combo boxes, with the Tab 
feature.

When a user clicks a combo box, the Process Before is 
executed, the data is processed, the Process After is 
executed, and the cursor advances (tabs) to the next field.

2 Use auto-accept behavior in GUI combo boxes, without the 
Tab feature.

When a user clicks a combo box, the Process Before is 
executed, the data is processed, the Process After is 
executed, and the cursor remains on the current field.

Auto-Accept Behavior in GUI Combo Box Settings 
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SB.CONTROL<44,3>

Specifies the type of auto-accept behavior in GUI radio buttons.

Valid settings are:

Value Description

0 Do not use auto-accept behavior in GUI radio buttons.

1 Use auto-accept behavior in GUI radio buttons, with the 
Tab feature. This is the default setting.

When a user clicks a radio button, the Process Before is 
executed, the data is processed, the Process After is 
executed, and the cursor advances (tabs) to the next field.

2 Use auto-accept behavior in GUI radio buttons, without the 
Tab feature.

When a user clicks a radio button, the Process Before is 
executed, the data is processed, the Process After is 
executed, and the cursor remains on the current field.

Auto-Accept Behavior in GUI Radio Button Settings 
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SB.CONTROL<44,4>

Specifies the type of auto-accept behavior used in GUI toggles. 

Valid settings are:

SB.CONTROL<45,1>

The SB.CONTROL flag specifies whether the PD.P process is enabled to 
generate RedBack code.

Valid settings are:

Note that in SB+ versions 5.3.3 and later, you must set three flags to enable 
the ability to generate RedBack code:

■ SB.CONTROL <45.1>, as detailed above

Value Description

0 Do not use auto-accept behavior in GUI toggles.

1 Use auto-accept behavior in GUI toggles, with the Tab 
feature. This is the default setting.

When a user clicks a toggle, the Process Before is executed, 
the data is processed, the Process After is executed, and the 
cursor advances (tabs) to the next field.

2 Use auto-accept behavior in GUI toggles, without the Tab 
feature.

When a user clicks a toggle, the Process Before is executed, 
the data is processed, the Process After is executed, and the 
cursor remains on the current field.

Auto-Accept Behavior in GUI Toggle Settings 

Value Description

0 No, do not enable PD.P to generate RedBack code. This is 
the default setting.

1 Yes, enable PD.P to generate RedBack code.

Generate RedBack Code Settings 
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■ WWLIB <1>, stored in the VOC file

■ WW.SB.PROCESS<1>, stored in the VOC file
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Appendix D: Edit Keys
This appendix contains a list of edit key numbers and their 
corresponding key names.
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About Edit Keys
The edit keys perform functions to process the information entered in 
screens. In SB+, the response to pressing edit keys can be defined at a system 
level in the following SB+ control parameters:

■ SB.CONTROL<15.8>

■ SB.CONTROL<15.12>

For further information on defining the response of edit keys in these control 
parameters, see Appendix C, “Appendix C: SB+ Control Parameters.”
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Edit Key Numbers and Names
This list contains the edit key number and a description of the function 
performed by the key.

Key Number Description

1 Cursor Back

2 Cursor Forward

3 Cursor Up

4 Cursor Down

5 Start Line

6 End Line

7 Insert Toggle

8 Delete Char

9 Erase From Cursor to end of line

10 Next Word

11 Previous Word

12 Extend Length / Search again

13 Quit Process

14 ESC Key

15 User Macro Lead Char

16 Insert Line

17 Delete Line

18 Page Up

19 Page Down

20 Top of Text

Edit Key Numbers and Descriptions 
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21 Bottom of Text

22 TAB (Next Controlling Multivalue)

23 Invoke Text Editor

24 Invoke Intuitive Help

25 BACKTAB

26 Reserved for future use

27 Reserved for future use

28 Reserved for future use

29 Mouse Lead in characters

30 Reserved for future use

31 Function key 1 (F1)

32 Function key 2 (F2)

33 Function Key 3 (F3)

34 Function Key 4 (F4)

35 Function Key 5 (F5)

36 Function Key 6 (F6)

37 Function Key 7 (F7)

38 Function Key 8 (F8)

39 Function Key 9 (F9)

40 Function Key 10 (F10)

41 SHIFT - F1

42 SHIFT - F2

43 SHIFT - F3

44 SHIFT - F4

Key Number Description

Edit Key Numbers and Descriptions (Continued)
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45 SHIFT - F5

46 SHIFT - F6

47 SHIFT - F7

47 SHIFT - F8

49 SHIFT - F9

50 SHIFT - F10

51 Action Bar 1

52 Action Bar 2

53 Action Bar 3

54 Action Bar 4

55 Action Bar 5

56 Action Bar 6

57 Action Bar 7

58 Action Bar 8

59 Action Bar 9

60 Action Bar 10

61 Action Bar 11

62 Action Bar 12

63 Action Bar 13

64 Action Bar 14

65 Action Bar 15

66 GUI 1

67 GUI 2

69 GUI 3

Key Number Description

Edit Key Numbers and Descriptions (Continued)
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69 GUI 4

70 GUI 5

71 GUI 6

72 GUI 7

73 GUI 8

74 GUI 9

75 GUI 10

76 GUI SHIFT - F1

77 GUI SHIFT - F2

78 GUI SHIFT - F3

79 GUI SHIFT - F4

80 GUI SHIFT - F5

81 GUI SHIFT - F6

82 GUI SHIFT - F7

83 GUI SHIFT - F8

84 GUI SHIFT - F9

85 GUI SHIFT - F10

86 GUI Action 1

87 GUI Action 2

88 GUI Action 3

89 GUI Action 4

90 GUI Action 5

91 GUI Action 6

92 GUI Action 7

Key Number Description

Edit Key Numbers and Descriptions (Continued)
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93 GUI Action 8

94 GUI Action 9

95 GUI Action 10

96 GUI Action 11

97 GUI Action 12

98 GUI Action 13

99 GUI Action 14

100 GUI Action 15

Key Number Description

Edit Key Numbers and Descriptions (Continued)
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